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Using Remark Quick Stats 
Chapter 1 

1.1 Overview 

Remark Quick Stats is an analysis/reporting package that can be used to tabulate 
surveys and grade tests. The software provides several standard reports. Reports can be 
customized to include user defined titles, colors, fonts and graphics. When you install 
Remark Classic OMR, Remark Quick Stats is automatically installed. 

Note: Remark Quick Stats is designed to work with other Remark products. 
In order to access Remark Quick Stats reports, you must first create a form 
template file (or utilize an existing form template file) in the Remark Classic 
OMR Template Editor that matches your expected data. Data cannot be 
imported into Remark Quick Stats without this form template file. 

The following topics are covered in this chapter: 

• System requirements (Section 1.2) 

• The Remark Quick Stats interface (Section 1.3) 

• Running reports (Section 1.4) 

1.2 System Requirements 

The following are the minimum system requirements necessary to run Remark Quick 
Stats. 

• Personal computer with 1 GHz or faster processor  
• Windows 32-bit and 64-bit operating systems: XP SP3, Vista SP2, Windows 7 

SP1, Windows 8 (Note: SP stands for “Service Pack”) 
o Remark Quick Stats runs on Windows Server 2003 SP2 and Windows 2008 

SP2, but please note the software is not a client/server application and is 
not supported in a virtual or server-based environment 

• 1 GB RAM  
• 1 GB free fixed disk space  
• CD-ROM drive (for installation purposes)  
• Screen/monitor resolution of 1024x768 or higher and at least 32-bit color  
• Mouse or other pointing device  
• Windows-supported printer (optional) 
• Microsoft Outlook 2007 or greater can be used for email functionality; if not 

present an internal Remark Classic OMR email client (using your SMTP server) 
may be used. (optional) 
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1.3 The Remark Quick Stats Interface 

1.3.1 Remark Quick Stats Views 
Remark Quick Stats consists of two views: Reports and Data. The Reports view displays 
reports for viewing, printing or saving. The Data view displays a copy of the data that is 
being used to display the corresponding reports.  

A Task Pane appears on left side of the window with the options available to you at any 
given time. In the Reports view, a list of available reports appears in the Task Pane. In 
the Data view a list of available options, such as exporting and sorting appears in the 
Task Pane. Both views contain a Back button to return to the previous list. Click a link 
with the mouse to activate an option. Most options found in the Task Pane can also be 
found in a corresponding menu or toolbar button. 

1.3.2 Menu Items 
The following sections provide menu options for Remark Quick Stats. Please see later 
sections of this user's guide for complete descriptions of features. 

1.3.2.a File Menu 
Use the items in the File menu to perform operations on files. The operations include 
creating, editing, opening, closing, saving, displaying, and printing files.  

 
Reports View: 
 

Toolbar 
Button 

Menu Pull-Down 
Item 

Description 

 Open  
(Ctrl + O) 

Opens an existing report file for viewing or 
printing. This option includes the 
corresponding data and answer key files so 
that you can further manipulate reports. 

 Save  
(Ctrl + S) 

Saves the current report to a new or existing 
file. Clicking the Save button creates a report 
file or saves the report to the current file if 
one has already been established.  

 Save As… 
(F2) 

Saves an existing report file under a new 
name or allows you to change the path to 
which the file saves.  

 
Export 
(Alt + F + E) 

Exports the current report to one of several 
report formats: PDF, TIF, RTF, HTML, XLS or 
TXT. 

 Email 
(Alt + F + M) 

Emails the current report, textual or numeric 
data with or without results, or the internally 
created RQS (Remark Quick Stats) file.  

 
Print  
(Alt + F + P) 

Prints the current report. 
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Toolbar 
Button 

Menu Pull-Down 
Item 

Description 

 Printer Setup Allows you to choose a printer and set its 
printing parameters. 

 Exit  
(Alt + F4) 

Exits Remark Quick Stats. 

1.3.2.b Edit Menu 
Use the items in the Edit menu to perform common Windows functions, including copy 
and find operations. You may also filter and sort data via the Edit menu. 

 

Toolbar 
Button 

Menu Pull-Down 
Item 

Description 

 
Copy  
(Ctrl + C) 

Allows for easy duplication and movement of 
information. You can copy an entire page of a 
report once it is run and paste it in to a 
different document (e.g., Microsoft Word, 
Excel or PowerPoint). 

 
Find  
(Ctrl + F) 

Displays a window asking for the search text. 
Remark Quick Stats searches forward from 
the cursor position for the text requested. 

 Find Next  
(F3) 
 

Searches for the next instance of the previous 
search. If Find has not yet been chosen, or 
could not locate the previous search, Find 
Next disables. 

 
Filter Allows you to analyze your data based on 

specific criteria. This feature is useful for 
viewing results based on particular subsets of 
data. 

 
Sort  
(Data View Only) 

Allows the sorting of data in ascending or 
descending patterns, based on particular 
questions. 

1.3.2.c View Menu 
The View menu allows you to choose which toolbars you would like displayed and allows 
you to customize the current view.  

 
Reports View: 
 

Toolbar 
Button 

Menu Pull-Down 
Item 

Description 

 
Full Screen  
(F11) 

Displays a report full screen, allowing you to 
see more of the report. Press the button or 
F11 again to return to normal viewing. 
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Toolbar 
Button 

Menu Pull-Down 
Item 

Description 

 
Ruler Displays a ruler across the top of the report so 

that you can see the size of the report. 

 Status Bar Displays the status of the current operation 
being performed at the bottom of the screen. 

 
Table of Contents Displays a table of contents to the left of the 

report to assist with report navigation. 

 Toolbars Allows you to decide whether to view the 
standard toolbars (Data Viewer, Report and 
Task Pane). 

 Theme Allows you to choose a theme for the 
software, which defines whether to display 
large or small icons on the toolbar. 

 

Data View: 
 

Toolbar 
Button 

Menu Pull-Down 
Item 

Description 

 
Textual Data Displays a copy of your data in text format. 

 
Numeric Data Displays a copy of the data showing the 

numeric values that are used to calculate 
statistics. 

 Status Bar Displays the status of the current operation 
being performed at the bottom of the screen. 

 Toolbars Allows you to decide whether to view the 
standard and data toolbars (Data Viewer, 
Report and Task Pane). 

 Theme Allows you to choose a theme for the 
software, which defines whether to display 
large or small icons on the toolbar. 
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1.3.2.d Tools Menu 
The items available in the Tools menu allow you to configure report options, 
import/export options and re-run reports. 

 

Toolbar 
Button 

Menu Pull-Down 
Item 

Description 

 

 

Grade 
Wizard/Survey 
Wizard 
(Ctrl + W) 

Depending on whether you are grading or 
tabulating data, this menu displays the option 
to run the Grade Wizard or Survey Wizard. 

 
Report Batch 
Wizard 
(Ctrl + Q) 

Displays the Report Batch Wizard, which 
allows you to display, print and/or export 
multiple reports at one time, as well as auto 
filter your data set based on specific criteria. 

 Report Properties 
(Reports View 
only) 
(Ctrl + H) 

Displays the individual properties for each 
report. Use these properties to customize the 
look of each report. 

 Import Preferences 
(F9) 

Allows you to import general reporting 
preferences from another installation of 
Remark Quick Stats. 

 Export Preferences 
(F10) 

Allows you to export your general reporting 
preferences so that they may be imported on 
another system running Remark Quick Stats. 

 Screen Capture 
(Ctrl + T) 

Allows you to take a screen capture of any 
section of the report by dragging the mouse 
around the desired area. The screen capture 
is placed on the Windows clipboard for pasting 
into other applications. 

 Preferences 
(Ctrl + R) 

Displays the general reporting preferences for 
software customization. 

1.3.2.e Help Menu 
When you have questions about the use of Remark Quick Stats, or about a specific 
menu or command, look under the Help menu. 

Note: Help is context-sensitive. Press F1 while any Remark Quick Stats 
window is active and help text appropriate to that window displays. 
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1.4 Running Reports 

Once you have used one of the grade or survey features to analyze your data (covered 
in the next two chapters), Remark Quick Stats opens. To view the corresponding 
reports, click the Display Reports link in the Task Pane. Then click the link 
representing the report you wish to view. Some reports display another window allowing 
you to select specific criteria for the report. 

Tip: Some reports are more memory intensive than others. When viewing 
the list of available reports, a red exclamation point next to the report name 
indicates the more memory intensive reports. You should ensure that your 
system meets the system requirements outlined earlier in this chapter 
before running these reports. It is also useful to close other applications 
before running the more memory intensive reports. 

If you always run a specific report, you may select a default report by clicking 
Tools|Preferences|Default Reports. You may choose one default report for survey 
tabulation and one default report for grading operations. You may still access other 
reports while using Remark Quick Stats; this feature is simply a shortcut to running your 
favorite report. 

Please review the next two chapters for information about grading tests and tabulating 
surveys, and the reports that can be run for each operation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tool Menu Pull-
Down Item 

Function 

 Contents Displays the contents of the Remark Classic OMR help file 
(including Remark Quick Stats). 

 About Remark 
Quick Stats… 

Displays the About Remark Classic OMR window, showing 
information about Gravic, Inc. as well as the serial number 
and current version of the software that is running. 
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Grading Tests 
Chapter 2 

Remark Quick Stats offers two formats for grading tests: Easy Grade and the Grade 
Wizard. Easy Grade uses default settings to grade a test with minimal user interaction. 
The Grade Wizard allows you to customize the grading process. All grading takes place 
after you create a form template in the Remark Classic OMR Template Editor and 
process filled in forms in the Remark Classic OMR Data Center. 

2.1 Using Easy Grade 

Easy Grade is a quick way to grade a test using pre-determined constraints. When you 
use Easy Grade, Remark Quick Stats uses the first row of data in the data grid as an 
answer key and grades the data based on the software’s default grading options set in 
the Remark Quick Stats Preferences. In addition, it uses parameters set in the form 
template to control grading, such as whether to grade a question, how many points to 
award and whether to display a question’s data as an analysis respondent ID on the 
reports (e.g., a name to identify each graded test). 

When using Easy Grade, you can allow multiple correct responses. If a question does not 
allow multiple responses in the form template, and it has multiple answers specified for 
the question in the answer key line, Remark Quick Stats treats this case as an OR 
operation, meaning it gives credit to students having either of the specified answers. If a 
question does allow multiple responses in the form template, and it has multiple answers 
specified for the question in the answer key line, Remark Quick Stats treats this case as 
an AND operation, meaning it only gives credit to students having both the specified 
answers.  

If a question is left blank in the answer key, the question is not graded. If you are using 
subjective items on your answer sheet, the maximum number of points awarded is set 
by the value in your answer key. 

 

To use Easy Grade 
1 Create or choose a form template for your exam in the Remark Classic OMR 

Template Editor. Be sure to set up grading parameters, such as which questions to 
grade, points to award and Analysis Respondent ID regions. If you are unsure of how 
to set up form template regions, consult the Remark Classic OMR User's Guide 
installed with your software. When setting up form templates, do not worry about 
assigning an answer key; this step is performed during form processing.  

2 In the Remark Classic OMR Data Center, scan exams using the Read Wizard or open 
an existing data file. Be sure to scan the answer key as the first row of data. The 
answer key should hold all of the correct answers to each question you wish to grade 
in the software. The Easy Grade function automatically assumes the first record in 
the data set is the answer key and bases the grading operation on this data. 

Note: When using Easy Grade, if a subjective question is left blank or 
contains non-numeric data, it is excluded from the grade operation (marked 
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as not graded / not subjective). Otherwise, if the subjective question 
contains a numeric value, that value is used as the total possible subjective 
points for the question. 

3 After scanning the exams, select the Tools menu, then click Analysis and then 

Easy Grade, or click . Easy Grade is also available from the Analysis tab 
of the Task Pane. 

The data is graded and the Remark Quick Stats window appears. This window contains 
a Task Pane on the left allowing you to display reports. Refer to Section 2.4 for 
information about the reports and statistics calculated. 

2.2 Using the Grade Wizard 

Remark Quick Stats provides a Grade Wizard to allow you to customize the grading 
process. The Grade Wizard allows you to specify which data sets to include in the grade 
operation, an answer key, subjective and ID fields, test points, grade scales, scaled 
scores learning objectives, benchmark scores, report headers and which questions to 
include or exclude. In addition, you may save a grading answer key containing all of 
your grading parameters for repeated use. The Grade Wizard is also useful if you wish to 
use generic form templates but apply different answer keys for various tests. For 
example, you can have a generic 50 question answer sheet, but set up different answer 
keys using the Grade Wizard based on the subject being tested (e.g., one answer key 
for US History, one for World History, one for Geography, etc.). 

Note: The Grade Wizard can also be accessed outside of Remark Classic 
OMR by clicking Start|Programs|Remark Classic OMR 4|Remark Classic OMR 
Grade Wizard. For details about using the Grade Wizard independently, 
please go to section 2.3. 

The following table summarizes the options available when using the Grade Wizard: 

 

Option Description 

Answer Key An answer key can be obtained by selecting a grid row, 
scanning a key, importing a textual key or typing in an 
answer key. 

Question Properties Various question properties can be changed without 
affecting the form template, including whether to grade a 
question, question text, question point values, correct 
answers, respondent identifiers and data types. 

Learning Objectives Learning objectives, sometimes called subtests, test a 
student's knowledge on a particular subset of questions on 
the exam. You may create learning objectives and then 
assign specific questions to each objective. Remark Quick 
Stats provides scores on the entire test as well as scores for 
individual learning objectives. You may also assign 
benchmark values to the learning objectives to measure 
student proficiency. 
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Option Description 

Grade Scales You may assign a grade scale to both the overall test as 
well as the learning objectives, if you are using learning 
objectives. The software has pre-defined grade scales, or 
you can create your own. 

Scaled Scores A scaled score converts a student's score on a test to a 
common scale that allows for a comparison among 
students. A scaled score allows you to use an external data 
file to translate a student's score on a test from a standard 
raw, percent score or percentile into another scale, as 
defined in the translation file. 

Multiple Answer Key 
Scoring 

You may score tests that utilize multiple answer keys. 
There are two options for scoring multiple test versions: 
Standard and Advanced. With the Standard Answer keys 
option, you can enter each key and then have the software 
match the data to the appropriate answer key. Because the 
original question is not known, item based reports are run 
on each key separately. With the Advanced Answer Keys 
option, you can map each answer key to the original test, 
moving the questions to their proper order on each test 
version. When using Advanced Answer Keys, the software 
understands how an answer relates back to the original 
answer key so combined item based reports are available. 

Benchmark Values You may assign a benchmark value to an entire test, 
individual questions or learning objectives. The benchmark 
value is the score you want your students to achieve in 
order to be considered proficient. Select reports show what 
the benchmark score is and how the students compare to 
that benchmark. 

 

To use the Grade Wizard (setting up an answer key) 
When performing the following Grade Wizard steps, please refer to the previous table for 
any terms that are unfamiliar to you. 
 
1 Create or choose a form template for your exam in the Remark Classic OMR 

Template Editor. You may set up grading parameters, such as which questions to 
grade, points to award and Analysis Respondent ID regions; these options can be 
modified during answer key setup. If you are unsure of how to setup form template 
regions, consult the Remark Classic OMR User's Guide included with your software. 
When setting up form templates, do not worry about assigning an answer key; this 
step is performed during form processing/answer key setup.  

2 In the Remark Classic OMR Data Center, scan exams using the Read Wizard or 
open an existing data file. You may choose to scan the answer key as the first row of 
data or set up an answer key in the Grade Wizard.  

3 After processing the exams, select the Tools menu, then click Analysis and then 

Grade Wizard, or click . The Grade Wizard is also available from the 
Analysis tab of the Task Pane. 



Remark Quick Stats User's Guide 

10 
 

4 [Optional] You may grade multiple data sets by opening the data sets in the Data 
Center first. When you start the Grade Wizard, the Possible Data Sets window 
appears. Select the data set(s) that you wish to include in the grade operation. Only 
data sets that come from the active form template display in this window. In this 
window you may optionally add a Data 
Group name to identify each data set. 
Using a group name allows you to filter 
data. For example, you could enter a 
teacher name in the Data Group 
column and then compare data among 
teachers. The Data Group option 
appears when you filter data, use the 
Report Batch Wizard and on select 
reports, such as the Comparative and 
Demographic Grade, 
Crosstabulation and Response 
reports. 

The following sections describe each of the options within the Grade Wizard. 

2.2.1 The Getting Started Window 
The Getting Started window appears first, which allows you to set up basic parameters 
for the test grading process.  

 

1 Click the Browse… button if you have already created an answer key file (.AKY) that 
you would like to use. If you would like to create a new answer key file, continue 
with the remaining items on this screen. You may save as many answer keys as 
desired, but note that if the corresponding form template changes, you need to 
create a new answer key. You may have one form template with multiple answer 
keys that customize the grading process. For example, you can have a generic 50 
question answer sheet, but set up different answer keys using the Grade Wizard 
based on the subject being tested (e.g., one answer key for US History, one for 
World History, one for Geography, etc.). 

Note: The remaining instructions are provided in the context of creating a 
new answer key file. If you are using an 
existing answer key file, you can use the 
same screens and instructions to make 
modifications.   

2 If the test contains learning objectives, mark 
the checkbox for This test contains one or 
more learning objectives. Learning 
objectives allow you to create subsets of 
questions on which to base the grade operation 
in addition to the test as a whole. For example, 
if your state/province sets forth specific 
learning standards/objectives, you can assign 
test questions to the standard/objective so that 
they can be measured separately. 

3 If you are using scaled scores, mark the checkbox for Calculate a scaled score for 
each student. Scaled scores allow you to look up the students’ total score, percent 
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score or percentile in a database and return a translated score to the Remark Quick 
Stats reports. 

4 If you are using more than one answer key for the test, mark the checkbox for 
Construct Multiple Answer Keys for a Single Test. Then select whether to use 
Standard or Advanced answer keys. “Standard answer keys” allows you to enter 
multiple answer keys without reordering the questions. “Advanced answer keys” 
allows you to specify the order of the questions for each version of the test in 
relation to the original key. You need copies of the test questions in order to use 
Advanced Multiple Answer Keys. Answer keys are covered in more depth in Section 
2.2.7. 

Note: When using “standard” multiple answer keys, you may not define 
learning objectives. It your test contains both multiple answer keys (using 
the standard method) and learning objectives, we suggest you perform two 
separate grade operations: One with standard answer keys and one with 
learning objectives. 

5 If desired, mark the checkbox for Define Benchmark Value for Overall Test. 
Then enter the desired benchmark percent score in the box titled Benchmark 
percent. This score is the score students are expected to achieve on the overall test 
in order to be considered proficient. Students' comparison scores to the defined 
benchmark appear on select reports. 

6 Click the Next>> button to continue. 

2.2.2 The Answer Key Window 
The Answer Key window appears next, which allows you to enter an answer key. The 
following options are available for selecting an answer key: 

 

Option Description 

Grid Row Choose your answer key from a grid row in the active data grid 
in the Data Center. This option is useful if you scanned your 
answer key as the first item in your data grid, followed by the 
student tests. NOTE: You will be able to save your Grade 
Wizard settings to an answer key (AKY) file. If you use a grid 
row from the data set, and that data set also includes student 
tests, the next time you use a saved answer key you should 
remove the answer key row(s) from the data file. When reusing 
saved answer keys, the answer key(s) that you originally 
processed as part of the data file is embedded into the AKY file. 
Therefore, if the answer key(s) is still in the data file as well, it 
will be treated as a student test. 

Read Wizard You may launch the Read Wizard to scan an answer key. 

Generic Key A Generic answer key file (*.gaky) can be created in the 
Remark Classic OMR Grade Wizard utility that runs outside of 
Remark Classic OMR. This type of key does not save any 
information for ungraded questions, allowing a generic answer 
key to be applied to any form type with enough graded 
questions and answer choices. See Section 2.3 for more 
details. 



Remark Quick Stats User's Guide 

12 
 

Option Description 

Text Key A text key is a tab or CRLF (carriage return/line feed) delimited 
text file containing the numeric indices of the correct answers 
for the graded questions. The question text can optionally be 
appended to each correct answer (delimited by a pipe 
character (|)).  
A text based answer key should be a tab delimited ASCII file 
with a TXT file extension that contains the correct answers for 
the questions on a test. The correct answers should be written 
using their numeric equivalents. For example, if the possible 
answers for a question are: A, B, C, D and the correct answer 
is D, then the numeric index for the correct answer is 4 since D 
is the fourth answer choice. If there are 5 graded questions on 
a test with the possible answers being (A-D) and the correct 
answers are A, B, D, A, C respectively, then the first line of the 
text file would contain their numeric indices tab delimited like 
this: 
 
1              2              4              1              3  
 
If more than one answer is correct, then delimit the correct 
answers using a comma (,) if one of the correct answers must 
be selected for the response to be considered correct, or use 
an ampersand (&) if the respondent must select all of the 
correct answers for the response to be considered correct. If 
the second question in the example listed above considered 
either B or D to be correct and the fifth question required both 
A and C to be selected, then the text answer key would look 
like this: 
 
1              2,4              4              1              1&3  
 
If you have multiple versions of a test, you create a new record 
in the text key for each test version and also define the test 
version identifier as the first piece of data for each record. For 
example, a test with three versions might look like this:  
 
A             1              2              4              1              3  
B             4              3              1              1              2  
C             2              1              3              1              4  
 
Note: Questions that use multiple correct answers where only 
one of the correct answers should be selected for the response 
to be considered correct are NOT supported when importing 
keys with multiple test versions. Any commas found between 
correct answers are treated as ampersands when using 
multiple test versions. 
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1 Use the drop-down list in the Answer key source box to choose the type of answer 
key you are using. Then click the Get Key… button to enter or import the answer 
key information into the answer key grid (if using a grid row, specify the row in the 
Grid row box). If manually entering the 
answer key, type the values into the Correct 
Answer column of the grid. 

Note: If you are using standard answer 
keys for multiple test version grading, the 
Answer Key window does not appear. You 
are be prompted to enter all of your 
answer key information in the Multiple 
Keys step later in the Grade Wizard. 

2 If desired, you can mark whether to grade 
questions as objective or subjective by 
clicking in the corresponding boxes. By 
default, the Grade Wizard uses the grade 
settings defined in the form template, but you may make changes in the Grade 
Wizard. Note that you can also change the grading status of questions in the next 
window. 

3 Click the Next>> button to continue.  

2.2.3 The Question Properties Window 
The Question Properties window appears next, which allows you to modify the 
properties for your test questions. The Grade Wizard initially uses any values that were 
defined in the form template’s properties. You may make modifications to these settings 
here, which does not affect your form template. The following options are available: 

 

Option Description 

Question text Enter or modify question text to be used on the 
reports. You can use the keyboard shortcut for Paste - 
Ctrl + V - to paste information from the Windows 
clipboard, or right click for Paste options. 

Question identifies the 
student 

Mark this checkbox to include the information obtained 
from this question as a respondent identifier on select 
reports. For example, if you are collecting a student 
name or ID number, this information can appear on the 
reports to link the report back to the student. The 
question must not be set to include in the grade 
operation in order to designate it as a respondent 
identifier. 

Grade this question Mark this checkbox to include the question in the grade 
operation.  

Correct answer(s) Use this drop-down list to select the correct answer(s) 
for the question. Drop the list down multiple times to 
select more than one correct answer. 
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Option Description 

Student must select all 
correct responses for the 
response to be considered 
correct 

If multiple answers are allowed, mark this checkbox if 
all selected answers must be chosen in order for the 
question to be considered correct. Otherwise, only one 
correct answer has to be chosen in order for the 
question to be considered correct. NOTE: If you are 
using Standard Multiple Answer Keys and have 
questions that allow more than one correct response, 
mark this checkbox for all questions on all keys if you 
want the student to select all correct responses. The 
Question Properties window only displays the first 
answer key; however, you can still select questions 
that you know on other keys have multiple responses 
and mark this checkbox. 

Objective Question Mark this option to designate the question as an 
objective question. Multiple choice and True/False 
questions are examples of objective questions. 
Objective questions have three sets of point values: 
Correct, Incorrect and No Response. Use these three 
designations to indicate the number of points to be 
awarded for correct, incorrect and unanswered 
questions (decimals and negative values are allowed). 

Define Benchmark Value Mark this checkbox and enter a benchmark percent 
score to define a benchmark value indicating the 
percentage of students that should answer this 
question correctly in order for the class to be 
considered proficient. Benchmark values can only be 
applied to objective questions. 

Subjective Question If the question contains a subjective score, mark this 
checkbox. A subjective question contains a point value 
assigned to a test question by an instructor. Essay 
questions and short answer questions are examples of 
subjective questions. The instructor rates the question 
and then enters the number of points earned on the 
test form. Remark Quick Stats processes the points 
earned. You must have a numeric field for the 
subjective points on your form in order to use this 
value on the reports. 

Maximum points If using a subjective score, enter the maximum number 
of points possible for the question. If you have entered 
this number on the Answer Key step of the wizard, any 
changes made here override that value. Please note 
that any points entered for the processed tests that 
exceed the maximum points are automatically treated 
as extra credit. 
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Option Description 

Extra Credit  Mark this checkbox to designate the question as extra 
credit. Any points earned on this question are added to 
the total test score. The number added is based on the 
points assigned in the Objective Question area of this 
window. 

Data Type Select the data type for the question: Textual (e.g., for 
A, B, C, D questions) or Numeric (e.g., for 1, 2, 3, 4 
questions). 

 
1 Select a question in the left Task Pane and 

then make the appropriate changes to the 
desired items. You may select multiple 
questions by clicking a question and holding 
down the Ctrl key on the keyboard, or by 
clicking a question, holding down the Shift 
key and then clicking another question to 
select a range of questions. Note that 
depending on the type of questions 
selected, some options may not be available 
to you (e.g., multi-selecting a grid region 
and a multiple region may not give you the 
same options). 

2 Click the Next>> button to continue. 

2.2.4 The Learning Objectives Window 
If you are using learning objectives, the Learning Objectives window appears next, 
which allows you to specify learning objectives (you must have selected the Use 
Learning Objectives option on the first screen of the Grade Wizard). Learning 
objectives test a student's knowledge on a particular subset of questions on the exam. 
For example, if you are testing specific standards that your students need to learn, you 
can enter the names of the standards in the Grade Wizard and then map the 
corresponding questions to each standard. Remark Quick Stats shows you how the 
students scored on each standard so that you can quickly gauge whether students are 
learning the concepts.  

1 To create a learning objective, type the name 
of the learning objective in the Name box 
and then click the Add Objective button. 
Alternatively, you may import a list of 
objectives from a spreadsheet or database 
file. Click the Import button to import the 
names of the learning objectives. The 
learning objectives are listed in the Learning 
objectives box. 

2 The graded questions on the test are listed in 
the Available questions box. Select a 
learning objective on the right, then select a 
question (or questions) in the Available 
Questions box and then click the Add Questions to the selected learning 
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objective button ( ). The selected questions are moved to the Learning 
objectives box, beneath the selected learning objective. You may use the Remove 
questions from the selected learning objectives arrow ( ) to remove any 
unwanted questions assigned to a particular learning objective. Each question can be 
assigned to more than one learning objective. 

Tip: You can double click questions to add them quickly to a learning 
objective. You can also select multiple questions by holding down the 
Control key as you click questions, or by clicking a question, holding down 
the Shift key and then clicking another question to select the range of 
questions. 

3 If desired, assign a benchmark score to the learning objectives by selecting a 
learning objective and then marking the checkbox for Define Benchmark Value. 
Enter the percent score students should achieve on the learning objective in the 
Percent score box. Select reports show you which students have met and not met 
the benchmark. 

4 Click the Next>> button to continue. 

2.2.5 The Overall Grade Scale Window 
The Overall Grade Scale window appears next, which allows you to enter a grade scale 
for the test. Remark Quick Stats has built-in grade scales or you may create your own. 

1 If you have created a scale previously or wish to use one of the pre-loaded grade 
scales, you may select it from the Scales drop-down list.  

2 Optionally, you may create a new grade scale 
by clicking the New button and then 
entering a grade scale in the Grade Scale 
grid. Enter the Grade on the left (e.g., A, B, 
C, D, F) and the corresponding Percent 
Minimum Value and Total Minimum 
Value to the right. You may save the grade 
scale by clicking the Save… button. 

3 If you are using learning objectives and 
would like to assign a separate grade scale to 
these objectives, click the Learning 
objectives grade scale link in the left Task 
Pane. Repeat the instructions provided in 
Steps 1 and 2 to select or create a grade scale. Note that the grade scale defined 
here applies to all learning objectives defined (there are no separate scales per 
learning objective). 

4 Click the Next>> button to continue. 

2.2.6 The Scaled Scores and Learning Objectives Scaled Scores 
Window 
A scaled score converts a student's score on a test to a common scale that allows for a 
numeric comparison among students. Scaled scores are considered an advanced feature 
targeted to specific use cases where a specific test grade is needed from an external 
grading system. A scaled score allows you to use a database to translate a student's 
score on a test from a standard raw or percent score into another scale, as defined in 
the translation file (database). To use a scaled score, you can look up the overall score, 
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objective score, subjective score or defined learning objective scores. Two values can be 
selected to perform a two dimensional look up. The value taken from Remark is looked 
up in your translation (scaled score) table, and the appropriate scaled score is returned. 
When looking up the scaled score, it looks for a record in the table where the lookup 
value (percent score, total score or percentile) is contained within the defined range of 
values.  

The database file containing your scaled scores can be one of: Access, Excel, SQL 
Server, Oracle, Paradox, dBase or an ODBC connection. Within this database you define 
a minimum score field and maximum score field, which can be exact numbers or a range 
of scores. Each score in the database has a corresponding scaled score field, which is 
what is returned to Remark Quick Stats. You can optionally include a scaled grade field, 
which replaces the Remark-calculated grade on select reports. You can define the 
minimum and maximum fields to be the same field in the database, in which case the 
lookup value would have to exactly match the value in the field for the scaled score to 
be returned. If the scaled score cannot be found, then the reports display a dash (-). 

There is also a precision option that allows you to round the lookup score to a user 
defined number of decimal places before performing the database lookup. If rounding is 
used, Remark Quick Stats rounds up or down to whole numbers using traditional 
rounding methods. For example, if the score is 69.5, it is rounded to 70, which is the 
value looked up in the database. 

The following reports display the scaled scores: Student Statistics Report, Student Grade 
Report, Comparative Grade Report, Demographic Grade Report and Student Response 
Report. Each report has a property (Tools|Report Properties) that can be set as to 
whether or not to display a scaled score (the property is on by default). The heading for 
scaled score in the report is taken directly from the column header name in your lookup 
database. It is recommended that you keep this name short in order for the best 
appearance on the reports. 

Scaled scores can be defined in the Grade Wizard and set as defaults in the Remark 
Quick Stats Preferences so that they can be used with an Easy Grade operation. The 
following instructions apply to both the Overall Scaled Score and Learning Objectives 
Scaled Score windows. 

Note: When using the Grade Wizard, the scaled score only displays if the 
option is on AND the Scaled Score lookup is defined. When using Easy 
Grade, the default Scaled Score in the Remark Quick Stats Preferences is 
used as long as it applies to the active form template. If you do not want to 
use Scaled Scoring during Easy Grade operations, do not set a default 
Scaled Score in the Remark Quick Stats Preferences. 

 
1 If you have created a scaled score previously, 

you may select it from the Scaled scores 
drop-down list.  

2 Optionally, you may create a new scaled score 
by typing a name in the Scaled score name 
box. 

3 In the Scaled score based on area, choose 
the score type to look up: Total Score, 
Percent Score or Percentile. This score is 
the type of score that is used to look up a 
corresponding score in the external file. 
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4 Optionally, if you wish to round the scores, mark the checkbox for Round to: and 
put in the number of decimal places desired. If this option is used, the lookup score 
is rounded first, then the lookup takes place based on the rounded score. 

5 Using the Primary Lookup criteria drop-down list, choose the specific score you 
wish to look up: Overall Score, Objective Score, Subjective Score or any 
learning objectives you have defined.  This property tells Remark Quick Stats the 
actual score or scores to look up when finding the scaled score. Note: If you are 
basing the look up on the Percentile, you may only look up the Overall Score and/or 
learning objective scores. 

6 [Optional] If you would like to create a two dimensional look up, choose a secondary 
look up criteria from the Secondary lookup criteria drop-down list. For example, 
you may want to look up both an objective and subjective score to generate an 
overall scaled score. 

7 Click the Database… button to choose (or modify) the connection to an external 
database file. 

8 In the Database Selection area, use the Type drop-down list to select the type of 
database to which you want to connect this region (e.g., Access, Excel, etc.). 

9 Click the Browse… button to locate and select the database file. 
10 Select a file and then click the Open button (or double click the file name). 

If using an ODBC connection, perform the Steps 11-13 (you need to obtain specific 
information from your database administrator to complete these steps). Otherwise, skip 
to Step 14. 

 

11 OPTIONAL: Select your database type from the DSN drop-down list. 
12 OPTIONAL: Select the appropriate checkbox to indicate whether your database is 

Directory or DSN based: Directory based or DSN based. 
13 OPTIONAL: If your database utilizes password protection, use the Username and 

Password boxes to enter your login information. If the database is not password 
protected, you may skip this step. 
 

14 In the Lookup & Return section, click the Connect to Database button to link the 
database to the region (note that Remark Quick Stats tries to establish the 
connection for you for non-password protected databases). 

15 Use the Scaled score table drop-down list to select the table in the database 
containing the fields with the scaled scores (note that Remark Quick Stats chooses 
the first table/sheet in the file by default). 

16 Then choose the Primary minimum score, Primary maximum score, Scaled 
score and optionally Scaled Score grade fields from the external database. The 
optional Scaled score grade field replaces Remark-generated grades with the 
scaled grade from the database on select reports that show a grade (e.g., A, B, C…). 
These fields contain the values to look up and replace. The items available depend on 
your choice of lookup items: Overall Score, Objective Score, Subjective Score, 
Objective and Subjective Score or Learning Objectives. 
Here are some guidelines you can using when selecting the lookup and replace 
fields: 
• To look up a one dimensional overall, objective or subjective score where there is 

a one to one relationship (e.g., a score of 85 equals a scaled score of 95), choose 
the same field for the Primary minimum and Primary maximum score fields. 
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• To look up a one dimensional overall, objective or subjective score that uses a 
range of scores (e.g., a score of 85 to 90 equals a scaled score of 95), select 
different fields for the Primary minimum and 
Primary maximum score fields. 

• To look up a two dimensional score of objective 
and subjective score where there is a one to one 
relationship (e.g., an objective score of 85 and a 
subjective score of 10 equals a scaled score of 
110), choose the same field for the Primary 
minimum and Primary maximum score 
fields. Then choose the same field for the 
Secondary minimum and Secondary 
maximum score fields (but different from the 
objective fields). For example, the Primary 
minimum and Primary maximum score fields 
would be your objective scores, and the 
Secondary minimum and Secondary 
maximum score fields would be your 
subjective scores. 

• To look up a two dimensional score of objective 
and subjective scores where there is a range of 
scores (e.g., an objective score of 85-90 and a subjective score of 5-10 equals a 
scaled score of 110), choose different Primary minimum and Primary 
maximum score fields. Then choose different Secondary minimum and 
Secondary maximum score fields. For example, the Primary minimum and 
Primary maximum score fields would be your range of objective scores, and the 
Secondary minimum and Secondary maximum score fields would be your 
range of subjective scores. 

17 Choose the field in the database that contains the corresponding scaled score using 
the Scaled score field drop-down list. 

18 [Optional] Choose the field in the data that contains the corresponding scaled score 
grade in using the Scaled score grade field drop-down list. On reports that show a 
grade, this value displays when scaled scoring is in use. You may use the Clear 
button to remove this option if you change your mind. 

19 Click the OK button to save the database settings. 
20 When you return to the overall scaled score window, you will see the details of your 

database connection listed. If you need to make modifications, click the Database… 
button. 

21 Optionally, if you would like to use a scaled score for defined learning objectives, 
click the Learning objective scaled score link in the left window pane and repeat 
the above steps to define the scaled score. Please note that the learning objectives 
scaled score applies to all learning objectives defined. 

22 Click the Next>> button to continue. 

Note: Default scaled scores for the overall test and learning objectives can 
be defined and saved in the Remark Quick Stats Preferences under 
Tools|Preferences|Overall Scaled Score and Learning Objectives 
Scaled Score. Once created and saved in the preferences, scaled scores 
can be accessed in the Grade Wizard. 
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2.2.7 The Multiple Answer Keys Window 
If you are using multiple answer keys, the Multiple Answer Key window appears next 
(you must have selected one of the multiple answer key options on the first screen of 
the Grade Wizard). This window varies depending on whether you are using Standard or 
Advanced answer keys. Please note that all test versions must have the same number of 
questions defined and all objective questions must have the same point values and 
answer choices in order to use multiple answer keys. If you are allowing multiple 
responses and using Standard multiple answer keys, all of the multiple response 
questions must be consistent when it comes to whether one correct answer is allowed or 
all correct answers must be selected in order for the question to be considered correct. 
If you have a mix of questions where one or all answers must be chosen, you must use 
Advanced multiple answer keys. 

Note: When using Standard multiple answer keys, item based reports are available, 
but are run on each separate answer key. The Point Biserial calculation is 
unavailable. If you want a combined item report and/or the Point Biserial calculation 
you must use Advanced multiple answer keys. 

 

Answer Key Type Instructions 

Standard 1 Use the drop-down list for Question containing key 
identifier to select a question from the test that contains 
the value identifying the answer key.  

2 Click the New button to enter an answer key.  
3 Enter or select the answer that identifies the first key in 

the Answer representing the key version list box.  
4 Use the drop-down list in the Answer key source box to 

choose a grid row as the source for the answer key. If not 
using a grid row, manually enter the key information in 
the grid.  

5 If using a grid row for the answer key, click the Get 
Key… button to enter the answer key information into 
the answer key grid (if using a grid row, specify the row 
in the Grid row box).  

6 Click the New button to start the process again for 
additional answer keys. 
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Answer Key Type Instructions 

Advanced 1 The original answer key is visible. Use the drop-down list 
for Question containing key identifier to select a 
question from the test that contains the value identifying 
the first answer key.  

2 Enter or select the answer that identifies the first answer 
key in the Answer representing the key version list 
box.  

3 To add more answer keys, click the New button.  
4 Enter or select the answer that identifies the first key in 

the Answer representing the key version list box.  
5 A duplicate of the original key appears in the Key 2 

column. Then rearrange the questions in the Key 2 
column so that they relate back to the original answer 
key (Key 1). When mapping questions, look at the 
question on the original answer key and then put it in its 
proper place on subsequent answer keys. You must have 
the actual test questions in order to do this mapping.  

 
Here is an example to follow: 
Test One 
1. What is the first day of the week? 
2. What is the first month in the year? 
3. How many hours are there in a day? 
4. How many minutes are there in an hour? 
5. How many seconds are there in a minute? 
 
Test Two 
1. What is the first month in the year? 
2. How many seconds are there in a minute? 
3. What is the first day of the week? 
4. How many hours are there in a day? 
5. How many minutes are there in an hour? 
 
Answer Key Setup 
The fields in the Grade Wizard should look like this: 
Test One   Test Two 
Q1    Q2 
Q2    Q5 
Q3    Q1 
Q4    Q3 
Q5             Q4 

 
6 Click the Next>> button to continue. 
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Note: You can import Advanced Multiple Answer Keys using a tab delimited text file. In 
this file, you set up the Test version (optionally) and then the question order. If you are 
using non-graded questions (e.g., demographics) you must include them in the text file. 
Here is an example: 

Suppose you have two versions of a test. There is an answer key identifier, a student 
ID, student name, teacher name and five test questions. Your advanced multiple answer 
key import file might look like this: 

 

 

A  1 2 3  4 5 6 7 8 

B  1 2 3  8 7 4 6 5 

 

 

In this example, A and B represent the answer key version identifier. 1, 2, and 3 
represent the demographic questions (student ID, student name and teacher name). 4-8 
on the first line represents version A of the test, where the questions are in normal 
order. 8-5 on the second line represents the “B” version of the test where the questions 
are scrambled. This line is telling us that the first question on answer key B is question 
eight on answer Key A. Similarly, the second graded question on answer key B is 
question seven on answer key A. 

2.2.8 The Custom Header Window 
In the Custom Header window, optionally define a header for the resulting reports. 
Custom report headers are explained in detail in Section 4.2. Custom headers allow you 
to customize titles and add graphics to your report headings. By creating a custom 
header within the Grade Wizard, it is be saved with the answer key file generated by the 
Grade Wizard (if you save the answer key file), which means you do not have to 
recreate the custom report header any time you grade data using this answer key file. 
You can even utilize data values to make reports more meaningful (e.g., add the 
teacher’s name to the header). Custom headers defined in the Grade Wizard override 
any custom headers set in individual report properties. 

Note: If you would like to independently save the report header as its own 
file, click the Save button once you have defined the header. You can then 
utilize the report header when setting up other answer keys. 

1 Click the Custom Report Header checkbox. 
2 Click the Edit… button to create a new report header or the Load… button to open a 

previously saved report header. 

When the Report Header Layout window appears, you will see a representation of the 
report. There are nine fields that can be customized. The active field is highlighted in 
yellow. Click in a field to select and customize it. You can use the Page Width setting 
on the report to zoom in and out for better viewing. 
 

 

 

 

Answer Key Identifier 

Demographic Questions Graded Questions (Scrambled) 
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To customize fields 
1 Choose the number of columns for your report header under the Columns section: 

One, Two or Three. The number of columns determines how many fields you can 
customize (between three and nine). 

2 Click one of the yellow fields to customize.  
3 Determine whether you want to insert text or an image in your first field. Choose the 

radio button for Text or Image. 
4 If inserting text, enter a label for the 

field in the Label box. This label is 
free text. 

5 If desired, move to the Value drop-
down list and select a value to insert. 
The default choices are Image, Date, 
Date/Time and Page Number. In 
addition, you may select a region 
from the form template that you used 
to generate this report. This feature is 
designed for reports that generate 
individual pages per respondent (e.g., 
Student Grade Report, Response Report by Respondent). The data from the selected 
region appear in the report header that you define.  

6 In the Alignment section, choose an alignment for your item: Left, Center or 
Right. The inserted item is aligned accordingly within the space allotted on the 
report. 

7 If inserting an image, click the 
Browse… button to locate an image 
to include on the report (e.g., a 
company logo). The following image 
types are supported: .bmp (Bitmap), 
.gif (GIF), .jpg (JPEG), .wmf 
(Windows Meta File), .ico (Icon), .cur 
(Cursor).  

Tip: If you need to align your 
image left, center or right, choose 
the appropriate field in the desired 
position before inserting the 
image. 

8 Repeat the steps above to insert any additional custom header information. 

Tip: If you need to reset the entire custom header back to its original state, 
click the Reset button. If you want remove an image, click in its field and 
click the Clear button. If you want to remove a text field, click in its field, 
delete the Label and change the Value to the first blank entry in the drop-
down list. 

9 Once your header is complete, click the OK button to return to the Grade Wizard 
window. 

10 If you wish to save the custom header you just created, click the Save button and 
enter a file name and location for the header. You can open it back up in this same 
screen of the Grade Wizard on future grading operations. 

11 Click the Next>> button to continue. 
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2.2.9 The Review Selections Window 
1 In the Review Selections window, review your information for accuracy. Every 

question is listed, allowing you to make changes if needed. You may use this window 
to make changes to answer choices, graded questions, learning objectives, 
respondent identifiers and point allocations.  

2 Once you are satisfied with the information, click the Finish button. If you have 
started a new answer key file or made changes to an existing answer key file, you 
are prompted to save the file. Alternatively, you can use the arrow next to the 
Finish button to choose one of the following options: 
• Save and Execute: Prompts you to save the answer key file and then executes 

the grade operation. 

• Save: Saves the answer key file but does not execute the grade operation. 

• Execute: Executes the grade operation without saving the answer key file. 

• Save Generic: Saves the selected settings as a generic answer key file that can 
be applied to other similar form templates. 

Once the Finish button is selected, if you would like to save the answer key file, 
continue with Step 3. You are prompted to save the answer key if you have not saved it 
already or have made changes. 

3 If desired, save the answer key file by clicking Yes when prompted. If you click No, 
the answer key file is not saved but the Grade Wizard closes and the test is still 
graded. If you click Cancel, you are returned to the Grade Wizard. If you plan to 
re-use the test form, it can save you time by saving the answer key file. 

4 If you select Yes to save the answer key file, in the Save Answer Key window, 
enter a name for the answer key file, choose a location to which to save the file and 
then click the Save button. 

Note: You can save your answer key as a generic answer key file (.GAKY) 
by changing the type in the Save as type box. This type of answer key 
does not save any information for ungraded questions, allowing a generic 
answer key to be applied to any form type (template) with enough graded 
questions and answer choices. 

The Remark Quick Stats window appears. This window contains a Task Pane on the 
left allowing you to display reports. Refer to Section 2.4 for information about the 
reports and statistics calculated. 

2.3 The Grade Wizard Utility 

The Grade Wizard may be accessed outside of Remark Classic OMR so that you can set 
up answer keys ahead of time. One advantage of using the Grade Wizard utility is that 
you can set up generic answer keys (*.gaky files). This type of answer key does not 
save any information for ungraded questions, allowing a generic answer key to be 
applied to any form type (template) with enough graded questions and answer choices. 

In addition, you can create a text answer key outside of Remark Classic OMR, which is a 
tab or CRLF (carriage return/line feed) delimited text file containing the numeric indices 
of the correct answers for the graded questions. The question text can optionally be 
appended to each correct answer (delimited by a pipe character (|)). You can then apply 
this text answer key to any appropriate form template. 
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Tip: Before continuing, we suggest that you read the previous section that 
explains all of the available options in the Grade Wizard in detail. Those 
options are not repeated here, as this section is meant to explain generic 
answer keys. 

 

To setup a generic answer key using the Grade Wizard Utility 
If you wish to use generic answer keys, you must first set one up. Once set up, the 
answer keys can be applied to various form templates. 

 

1 Select the Windows Start menu, click Programs, then Remark Classic OMR 4, 
then Remark Classic OMR Grade Wizard. 

2 You have two choices at this point: you can create an answer key for an existing 
form template file (RCO/RST), or you can open an existing answer key file (AKY, 
GAKY) and make modifications to it. Existing answer keys are covered in the 
previous section. Using the Grade Wizard Utility with an existing answer key is 
essentially the same as what was already covered. Therefore, we will focus on 
creating generic answer keys from this point forward. 

3 Click the Browse… button and choose the form template to which you would like to 
apply this answer key. 

4 In the Getting Started window, choose the options you would like to apply to this 
answer key: specify learning objectives, scaled scores and benchmark scores. 

Note: Multiple answer keys are not supported when creating generic answer 
keys. On the last step you may choose to save the file as a regular answer 
key (.AKY); this is the only file type that you can save from the Grade 
Wizard utility and allow for multiple test versions. 

5 Click the Next>> button to continue. 
6 In the Answer Key window, type in the appropriate answers for the questions you 

wish to include in the grade operation. Remember, we are creating a generic answer 
key first, which we can later apply to other form templates. 

7 Click the Next>> button to continue. 
8 If desired, in the Question Properties window, make any other changes desired to 

the questions in the form template. The changes you make here do not affect the 
actual form template. 

9 Click the Next>> button to continue. 
10 If desired, in the Learning Objectives window, add any learning objectives you 

wish to apply to this generic answer key. You may type in the learning objective 
names or import them from an existing file. 

11 Click the Next>> button to continue. 
12 If desired, in the Overall Grade Scale window, choose or create a grade scale to 

apply to this answer key. You may also click the Learning objectives grade scale 
link in the left Task Pane to adjust the grade scale used for all learning objectives 
defined. 

13 Click the Next>> button to continue. 
14 If desired, in the Overall Scaled Scores window, select or define a scaled score. 

Scaled scores are described in detail in Section 2.2.6. 
15 Click the Next>> button to continue. 
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16 If desired, in the Custom Report Header window, define a report header to be 
used for each resulting report when this answer key is used. 

17 Click the Next>> button to continue. 
18 Review the information you have entered in the Review Selections window. Click 

the Save button to save the answer key file. In the Save as type drop-down list, 
choose Generic Answer Key (.gaky). Provide a name for the file in the File name 
box. Be sure to note where the answer key is saved so that you may refer to it later. 

Note: You can also save the answer key as an .AKY file, but .AKY files are 
stricter in terms of which form templates can utilize them. They also allow 
for multiple test versions. 

19 Click the Save button. The generic answer key is now saved. You may now apply 
this answer key to other form templates. 

 

To use a generic answer key file in the Grade Wizard 
Once you have created a generic answer key, you can apply it to multiple form 
templates as long as they have enough graded questions and answer choices. You can 
process forms and then apply the generic answer key to the data, as described below. 

 

1 In the Remark Classic OMR Data Center, open a form template and process forms 
as you normally would. Alternatively, open an existing data file. 

2 Select the Tools menu, click 
Analysis and then click Grade 

Wizard, or click . 
3 Click the Next>> button to 

continue. 
4 In the Answer Key window, use the 

drop-down list for Answer key 
source to choose a generic answer 
key file and click the Get Key… 
button. (Alternatively, you can load a 
previously saved answer key file on 
the first step of the wizard by clicking 
the Load… button.) If the answer 
key can be applied to this form 
template, you receive a message that the answer key was applied successfully. You 
may click the Finish button to grade the data, or navigate through the Grade 
Wizard screens to make any desired changes. 

The Remark Quick Stats window appears. This window contains a Task Pane on the 
left allowing you to display reports. Refer to Section 2.4 for information about the 
reports and statistics calculated. 
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To apply a generic answer key file to other form templates using the Grade 
Wizard utility 
You can use the Grade Wizard utility (as described previously) to select a form template 
and then apply the generic answer key to it to make new answer keys. 

 

1 Select the Windows Start menu, click Programs, then Remark Classic OMR 4, 
then Remark Classic OMR Grade Wizard. 

2 Click the Browse… button and choose the form template to which you would like to 
apply this answer key. You do not need to make any adjustment in the Getting 
Started window because once the generic answer key is selected in the next step, 
all associated options are applied. 

3 Click the Next>> button to continue. 
4 In the Answer Key window, use the drop-down list for Answer key source to 

choose a generic answer key file. If the answer key can be applied to this form 
template, you receive a message that the answer key was applied successfully.  

5 Click the Save button to apply and save this generic answer key to this form template. 
We suggest saving the file as an Answer Key (.aky) file. 

You may now utilize the answer key file within the Grade Wizard in Remark Classic OMR 
to grade a data set. 

2.4 Available Grading Reports 

Once you have used Easy Grade or the Grade Wizard to analyze your data, you have 
several reports available to you. Some reports present different information and some 
reports present similar information but in different ways.  

Each report has a set of properties that controls what is displayed in the report. Report 
properties can be accessed by selecting the Tools menu and then clicking Report 

Properties, or by clicking on the toolbar. The following sections provide a 
short description of each report followed by descriptions of the available report 
properties. If you see options here that are not displayed when you run a report, look at 
your settings in the Report Properties. You can hide and show sections of reports in 
these properties. By default, some sections are hidden.  

2.4.1 Report 101 - Student Statistics Report 
The Student Statistics report provides the scores for all students in the class. Students 
are listed down the left side of the report, and then the grade, objective and subjective 
(if applicable) scores are listed for each student. If a scaled score is defined, it is also 
displayed. If a benchmark score was defined, the benchmark difference graph is also 
displayed. If learning objectives are defined, separate tables show the student 
information for the overall test and the learning objectives.  

Note: If you have a student identifier on your form and therefore in your 
data set (e.g., a student name or ID number) and want it displayed on this 
report, mark it as an Analysis Respondent ID in the form template 
(Advanced Properties) or by using the Grade Wizard (Question Properties). 

The following options are available for the Student Statistics Report: 
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Option Description 

Student Lists the student identified on the test. If you are using 
Analysis Respondent IDs, this information appears in the 
Student column (e.g., Name, ID number, etc.). If you have 
not designated any question as an Analysis Respondent ID, 
sequential numbers are assigned. 

Grade Displays the grade the student achieved based on the 
grade scale you chose in the Grade Wizard or set as your 
default Grade Scale in the Remark Quick Stats Preferences 
(Tools|Preferences|Overall Grade Scale). 

Scaled Score Displays the scaled score for each student, as retrieved 
from an external database file. Scores can be scaled based 
on Total Score, Percent Score or Percentile. This column 
only displays if a Scaled Score was set up in the Grade 
Wizard or is set as a default scaled score in the Remark 
Quick Stats Preferences (Tools|Preferences|Overall Scaled 
Score). 

Total Displays the total score achieved by each student. The first 
number is the number of points the student received; the 
second number is the total number of possible points on 
the test. 

Percent Displays the percent score achieved by each student. 

Benchmark Difference If a benchmark score was defined in the Grade Wizard, 
displays the difference between the student's score and the 
established benchmark, as well as a bar chart showing the 
relationship between the defined benchmark and the 
student's score. The vertical blue line depicts the 
benchmark. If students' bar charts are green, they scored 
higher than the benchmark. If students' bar charts are red, 
they scored lower than the benchmark. The bar charts can 
be customized in the report's properties (Tools|Report 
Properties). 

Z Score Displays the Z Score, which indicates how many standard 
deviations a score is above or below the mean (symbolized 
by + and -). 

T Score Displays the T Score, which is a converted Z score used to 
convert scores that are negative, fractional or both. The T 
score can be expressed as 10z + 50. 

ETS Score Displays the ETS Score, which is a converted Z score used 
to convert scores that are negative, fractional or both. It is 
used by the Educational Testing Service and can be 
expressed as 100z + 500. 

Deviation IQ Displays the Deviation IQ, which is a converted Z score 
used to convert scores that are negative, fractional or both. 
The Deviation IQ can be expressed as 15z + 100. 
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Option Description 

Percentile Displays the percentile, which is the percentage of scores 
that are lower than the listed score. For example, a test 
score that is greater than 50% of the scores of people 
taking the test is said to be at the 50th percentile. 

[Objective] Total Displays the total number of objective points obtained on 
the test, followed by the total number of possible objective 
points for the test. This section is displayed when you have 
included subjective questions on the test to differentiate 
the objective and subjective scores. 

[Objective] Correct Displays the number of correct questions for the objective 
portion of the test.  

[Objective] Incorrect  Displays the number of incorrect questions for the 
objective portion of the test. 

[Objective] Missing Displays the number of missing (e.g., non-valid data) 
questions for the objective portion of the test. 

Subjective Total Displays the number of subjective points earned on the 
test, followed by the total number of possible subjective 
points for the test. This section only displays if there is a 
subjective question (or questions) on the test. 

  

The following table summarizes the Student Statistics Report Properties (accessible by 
clicking Tools|Report Properties): 
 

Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 
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Report 
Section 

Report 
Property 

Description 

Report Format Sort Students Sets whether to sort the students by: 
Respondent ID, Percent Score, Total Score, 
Percentile or Grade. 

 Sort Order Sets whether to sort the students (based on 
criteria above) in ascending or descending 
order. 

 Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks student grade percentages. 
(See Chapter 4 Preferences and Properties for 
more details.) 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Summary 
Information 

Display Total 
Score 

Sets whether to show the total score earned for 
each student. 

 Display Percent 
Score 

Sets whether to show the percent score earned 
for each student. 

 Display Scaled 
Score 

Sets whether to show the scaled score earned 
for each student, if applicable. 

 Display Grade Sets whether to show the grade earned for 
each student. 

 Display Z Score Sets whether to show the Z Score earned for 
each student. 

 Display T Score Sets whether to show the T Score earned for 
each student. 

 Display ETS 
Score 

Sets whether to show the ETS Score earned for 
each student. 

 Display 
Deviation IQ 

Sets whether to show the Deviation IQ for each 
student. 
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Report 
Section 

Report 
Property 

Description 

 Display 
Percentile 

Sets whether to show the Percentile for each 
student. 

 Display Missing  Sets whether to show the number of missing 
responses on the test for each student. Missing 
data is any data that is not valid. 

 Display Incorrect Sets whether to show the number of incorrect 
responses on the test for each student. 

 Display Correct Sets whether to show the number of correct 
responses on the test for each student. 

 Display 
Benchmark 
Difference 

Sets whether to show the Benchmark 
Difference between the current score and the 
expected benchmark score, if benchmarks are 
used. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.2 Report 102 - Comparative Grade Report 
The Comparative Grade Report allows you to see test scores broken down by specific 
criteria. You can select questions from the data on which to base the report. For 
example, this report is especially useful for comparing demographic groups. If your 
students mark a category such as ethnicity on their test answer sheet, you can view the 
data by ethnic group. The following options are available for the Comparative Grade 
Report: 

 

Option Description 

Legend Displays the criteria used to generate the report. 

Benchmark Displays the target benchmark score, if one was entered in 
the Grade Wizard or Remark Quick Stats Preferences. 

Report Criteria Displays the questions selected to generate the report. 
Taking the report down to the student level is optional 
(check this setting under Tools|Report Properties). 

Students Displays the number of students that fall into each selected 
category.  

Grade Displays the grade achieved at each level of the report 
(e.g., for each question that was selected to generate the 
report). 
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Option Description 

Scaled Score Displays the scaled score achieved at each level of the 
report, if applicable. 

Percent Displays the percent score achieved at each level of the 
report (e.g., for each question that was selected to 
generate the report). 

Benchmark Difference Displays the difference between the defined benchmark 
and the score achieved by the students in the selected 
category. 

 

The following table summarizes the Comparative Grade Report Properties (accessible by 
clicking Tools|Report Properties): 
 

Report 
Section 

Report 
Property 

Description 

Report Header Display Legend Sets whether to display the report legend at 
the top of each page. The legend shows the 
criteria that were used to generate the report. 

 Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks student grade percentages. 
(See Chapter 4 Preferences and Properties for 
more details.) 

 Display Group 
Labels 

Sets whether to display the group label for 
each criterion selected on the report. The 
Group Label appears above each criterion and 
helps explain what is being displayed. You 
typically want to display either the Legend or 
the Group Labels. 
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Report 
Section 

Report 
Property 

Description 

 Background 
Color 

Sets the color to be used in the background of 
each table on the report. 

 Row Borders Sets whether to display borders around each 
row of information. 

 Display Students Sets whether to display the actual student 
identifiers of those that fall into each selected 
category. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Header Font Size Sets the font size used in the header row 
section of the table within the report (Students, 
Grade, Percent, etc.). 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Group Color 
Code 

Student Color  Sets the text color for the students listed on 
the report (if applicable). 

 Objectives Color Sets the text color for the learning objectives 
listed on the report (if applicable). 

 Group 3 Color Sets the text color for the third group of 
criteria listed on the report. 

 Group 2 Color Sets the text color for the second group of 
criteria listed on the report 

 Group 1 Color Sets the text color for the first group of criteria 
listed on the report. 

Summary 
Information 

Display 
Respondents 

Sets whether to display the Students column of 
the report, which shows the number of 
students falling into each category. 

 Display Grade Sets whether to display the Grade column of 
the report. 

 Display Scaled 
Score  

Sets whether to display the Scaled Score 
column of the report, if a scaled score was set 
up in the Grade Wizard or as a default scaled 
score in the Remark Quick Stats Preferences. 
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Report 
Section 

Report 
Property 

Description 

 Display Percent Sets whether to display the Percent column of 
the report. 

 Display 
Benchmark 
Difference 

Sets whether to display the Benchmark 
Difference column of the report, if benchmarks 
were applied using the Grade Wizard or 
Remark Quick Stats Preferences. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

 

To run a Comparative Grade Report 
1 In the Remark Quick Stats Task Pane, select the 

link for 102 - Comparative Grade Report. 
2 In the Group Selection window, select up to 

three question(s) you wish to include in the 
report. Double click questions or use the Add 

button , to move the questions to the 
selected window. 

Note: You may select multiple questions by 
holding down the Ctrl key and clicking the 
questions or you may choose a range of 
questions by selecting the first question, then 
holding down the Shift key and selecting the 
last question. 

3 Click the OK button to run the report. 

2.4.3 Report 103 - Class Frequency Distribution Report  
The Class Frequency Distribution report displays the breakdown of scores for an entire 
class. It also shows the mean score, the defined target benchmark and the benchmark 
difference, if applicable. If you have defined learning objectives in the Grade Wizard, a 
breakdown of scores on each learning objective is also displayed. 

The table across the top of the report shows the Grades along with their corresponding 
Percent Scores and Raw Scores, and the Frequency of each grade. The Percent 
column shows the percentage of time that grade appears for the group of scores. The 
chart shows the Grade across the X-axis (bottom) and the Frequency of that grade 
along the Y-axis (left side).  

The following table summarizes the Class Frequency Distribution Report Properties 
(accessible by clicking Tools|Report Properties): 
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Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Graph  Graph Size Sets the size of the graph displayed on the 
report: Small, Medium or Large. 

 Display Graph Sets whether to display a graph of the 
frequency information. 

 Reverse Graph Sets whether to display the graph with the 
grade scale reversed. For example, if the grade 
scale is A, B, C, D, F, when Reverse Graph is 
on, the graph would display the order of F, D, 
C, B, A. 

 Graph Properties Sets the graph properties, including type of 
graph, titles, colors, fonts, etc. (See Chapter 4 
Preferences and Properties for further details.) 

Report Format Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks benchmark performance. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Objective Page 
Break 

Sets whether to place a page break after the 
information for each learning objective is 
displayed. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 
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Report 
Section 

Report 
Property 

Description 

 Display Table Sets whether to display the table containing 
the grade scale, scores, frequencies and 
percents. When the table is off, only the graph, 
mean and benchmark information displays. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.4 Report 104 - Test Statistics Report  
The Test Statistics Report displays descriptive statistics about the overall test as well as 
each learning objective, if applicable. If there are subjective questions on the test, a 
breakdown of statistics for the overall test, objective items and subjective items is 
displayed. You may show or hide groups of statistics in the report properties 
(Tools|Report Properties). The following statistics are available: 

 

Group Name Statistic Description 

Score Data Number of Graded 
Items 

Displays the number of items on the test that 
were graded. 

 Total Points Possible Displays the total number of points on the 
test. 

 Maximum Score Displays the highest score from the graded 
tests. 

 Minimum Score Displays the lowest score from the graded 
tests. 

Statistics Mean Score Displays the average score of all of the 
graded tests. 

 Mean Percent Score Displays the average percent score of all of 
the graded tests. 
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Group Name Statistic Description 

 Benchmark Score Displays the benchmark percent score 
entered in the Grade Wizard, if applicable. 
This is the score you want your students to 
achieve to be considered proficient. You may 
compare it to the Mean Percent Score to see 
how students are measuring up to the 
benchmark. 

 Range of Scores The range is the distance between the 
highest and lowest score. 

 Standard Deviation A measure of the dispersion of a set of data 
from its mean. The more spread apart the 
data is, the higher the deviation. It is 
calculated by taking the square root of the 
variance. 

 Variance The amount that each score deviates from 
the mean squared (by multiplying it by 
itself). 

Percentiles Percentile (25 and 
75) 

Percentiles are values that divide a sample of 
data into one hundred groups containing (as 
far as possible) equal numbers of 
observations. For example, 25% of the data 
values lie below the 25th percentile. 

 Median Score The median of the scores from the graded 
tests. 

 Inter Quartile Range The difference between the 75th percentile 
and the 25th percentile. 

Confidence 
Intervals  

Confidence Interval 
(1, 5, 95 and 99%) 

A confidence interval gives an estimated 
range of values that is likely to include an 
unknown population parameter, the 
estimated range being calculated from a 
given set of sample data. If independent 
samples are taken repeatedly from the same 
population, and a confidence interval 
calculated for each sample, then a certain 
percentage (confidence level) of the intervals 
includes the unknown population parameter. 
Remark Classic OMR calculates Confidence 
Intervals of 1%, 5%, 95% and 99%. 

Test Reliability Kuder-Richardson 
Formula 20 
 

This formula measures test reliability and is 
an overall measure of internal consistency. A 
higher value indicates a stronger relationship 
between items on the test. 

 Kuder-Richardson 
Formula 21 

This formula measures test reliability and is 
an overall measure of internal consistency. A 
higher value indicates a stronger relationship 
between items on the test. 
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Group Name Statistic Description 

 Coefficient 
(Cronbach) Alpha 

A coefficient that describes how well a group 
of items focuses on a single idea or construct. 

 

The following table summarizes the Test Statistics Report Properties (accessible by 
clicking Tools|Report Properties): 

 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Display 
Statistics 

Test Reliability  Sets whether to display the Test Reliability 
section of the report, which includes the Kuder-
Richardson and Coefficient Alpha statistics. 

 Confidence 
Intervals  

Sets whether to display the Confidence Interval 
section of the report, which includes 1, 5, 95 
and 99% confidence intervals. 
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Report 
Section 

Report 
Property 

Description 

 Percentiles Sets whether to display the Percentiles section 
of the report, which includes 25th and 75th 
percentile, interquartile range and median 
score. 

 Statistics Sets whether to display the Statistics section of 
the report, which includes mean score, mean 
percent score, benchmark score, range of 
scores, standard deviation and variance. 

 Score Data Sets whether to display the Score Data section 
of the report, which includes number of graded 
items, total points possible, maximum score 
and minimum score. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.5 Report 105 – Student Response Report 
The Student Response Report provides a class view of all test responses by student and 
by question. The students are listed down the left side of the report. The questions are 
listed across the top of the report. Each student’s answer to each graded question is 
listed within a colored box: green for correct responses and red for incorrect responses. 
A white empty box means the student left the question blank or the response is invalid 
(e.g., multiple responses were entered when not allowed). To the far right of the report 
total score, percent score, grade and scaled score (if applicable) are listed. At the 
bottom of the report the percentage of students who answered the question correctly is 
listed, as well as averages for the total score, percent score, and grade. This report 
provides visual insight to both student and question performance. The colors used in the 
report can be customized in the report’s properties. 

The following table summarizes the Student Response Report Properties (accessible by 
clicking Tools|Report Properties): 

 

Report 
Section 

Report 
Property 

Description 

Report Header Display Legend  Sets whether to show the report’s legend. The 
legend explains what the colors on the report 
mean and is visible at the top of the report 
when set to show. 

 Custom Report 
Title 

Sets the title of the report. 
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Report 
Section 

Report 
Property 

Description 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Question Header Sets how to display the questions across the 
top of the report: Auto Number, Question 
Name (default) or Item Number. If you have 
long question names, you may wish to use 
Auto Number or Item Number. 

 Page Breaks 
Between Groups 

Sets whether to place a page break after the 
information for each group is displayed. 

 Color Subjective 
Questions 

Sets whether to apply the 
correct/incorrect/blank color to subjective 
questions. 

 Sort Students Sets whether to sort the students by: 
Respondent ID, Percent Score, Total Score, 
Percentile or Grade. 

 Sort Order Sets whether to sort the students (based on 
criteria above) in ascending or descending 
order. 

 Shade Statistics Sets whether to apply gray shading to the last 
few columns of statistics within the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Header Font Size Sets of the size of the font used in the header 
column and row of the report (the students and 
questions). 

 Font Sets the font type used in the report. 

 Correct Border 
Style 

Sets the color for the border around each 
correct response: Transparent, Solid (default), 
Dash, Dot, Dash-Dot, Dash-Dot-Dot. 
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Report 
Section 

Report 
Property 

Description 

 Correct Text 
Color 

Sets the color for the text depicting each 
correct response (black by default). 

 Correct Color Sets the color for the background of each 
correct response (green by default). 

 Incorrect Border 
Color 

Sets the color for the border around each 
incorrect response: Transparent, Solid 
(default), Dash, Dot, Dash-Dot, Dash-Dot-Dot. 

 Incorrect Text 
Color 

Sets the color for the text depicting each 
incorrect response (black by default). 

 Incorrect Color Sets the color for the background of each 
incorrect response (red by default). 

 Unanswered 
Border Style 

Sets the color for the border around each 
unanswered or invalid response: Transparent, 
Solid (default), Dash, Dot, Dash-Dot, Dash-
Dot-Dot. 

 Unanswered 
Color 

Sets the color for the background of each 
unanswered or invalid response (white by 
default). 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Summary 
Statistics 

Display Answer 
Key  

Sets whether to display the answer key labels 
across the top of the report (on the line above 
the student responses). 

 Display Percent 
Correct  

Sets whether to display the Percent Correct 
row below the student responses. The Percent 
Correct row shows the percentage of students 
who answered the question correctly. For 
subjective questions and the summary 
statistics at the end of the report, the Percent 
Correct line shows the average. 

 Display Total 
Score 

Sets whether to display the Total Score column 
at the end of the report. 

 Display Percent 
Score 

Sets whether to display the Percent Score 
column at the end of the report. 

 Display Grade Sets whether to display the Grade column at 
the end of the report. 

 Display Scaled 
Score 

Sets whether to display the Scaled Score 
column at the end of the report, if applicable. 
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Report 
Section 

Report 
Property 

Description 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.6 Report 106 - Condensed Test Report 
The Condensed Test report provides a summary of basic tests statistics. The header 
optionally contains statistical information about the test results as a whole. The body of 
the report shows each question, its response frequency, distractor information, group 
responses and the point biserial calculation. The following statistics are available: 

 

Statistic Meaning 

Total Possible 
Points 

Displays the total number of points possible on the test (objective 
and subjective, if applicable). 

Total Students Displays the total number of students who submitted responses to 
the test. 

Standard 
Deviation 

A measure of the dispersion of a set of data from its mean. The 
more spread apart the data is, the higher the deviation. It is 
calculated by taking the square root of the variance. 

Median Score The middle of a distribution: half the values are above the median 
and half are below the median. 

Mean Score Displays the average score of all of the graded tests. 

Reliability 
Coefficient 
(KR20) 

This formula measures test reliability and is an overall measure of 
internal consistency. A higher value indicates a stronger 
relationship between items on the test. 

Maximum Score Displays the highest score from the graded tests. 

Minimum Score Displays the lowest score from the graded tests. 

Range of Scores The range is the distance between the highest and lowest score. 

No. Displays the item number from the test. 

Question Displays the question text for the question as defined in the form 
template. 

Correct Answer Displays the correct answer for each question, as obtained from 
the answer key. 

Response 
Frequencies 

Displays the percentage or total number of times a particular 
answer choice was chosen by students for this particular question 
(e.g., the percentage or total number of times the answer choice 
appears in the data set). 
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Statistic Meaning 

Non-Distractor Displays the answer choices that were not selected at all by the 
students (have a frequency of 0). 

Correct Group 
Responses 

The Total% column displays the percentage of students who 
answered the question correctly. The Upper 27% column displays 
the percent correct for the individual question based on the 
students who scored in the upper 27% for the test as a whole. 
The Lower 27% column displays the percent correct for the 
individual question based on the students who scored in the lower 
27% for the test as a whole. 

Point Biserial A measurement of the discrimination of an item. It indicates the 
relationship between a response for a given item and the overall 
test score of the respondent. The point biserial tells you if a 
question was a good discriminator between the better students 
and the poorer students. Point biserial ranges from -1 to 1. A 
positive value indicates that the students who did well on the test 
answered the question correctly. NOTE: Point biserial is not 
available when using Standard multiple answer keys. 

 

The following table summarizes the Condensed Test Report Properties (accessible by 
clicking Tools|Report Properties): 

 

Report 
Section 

Report 
Property 

Description 

Report Header Display Legend  Sets whether to show the report’s legend. The 
legend explains what the colors on the report 
mean and is visible at the top of the report 
when set to show. 

 Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 
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Report 
Section 

Report 
Property 

Description 

Report Format Display Question 
Number 

Sets whether to display the No. column in the 
report, showing the question number. 

 Display Question 
Name 

Sets whether to display the Question Name 
column of the report, showing the question 
name from the form template. 

 Display Correct 
Answers 

Sets whether to display the Correct Answer 
column of the report. 

 Display Non 
Distractors 

Sets whether to display the Non Distractors 
section of the report, showing the answer 
choices that were not chosen by students. 

 Display Correct 
Group 

Sets whether to display the Correct Group 
section of the report. 

 Display Point 
Biserial 

Sets whether to display the Point Biserial 
column of the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Suspect 
Distractor Color 

Sets the color to shade distractors that are 
chosen more times than the correct response.  

 Response Type Sets the display for the responses listed in the 
Response Frequencies row: Labels, Values, 
Indices. Labels refer to the labels entered in 
the form template Labels grid, Values refer to 
the values entered in the form template Values 
grid and Indices refers to the numeric index of 
the answer choice (e.g., if the answers are A-E, 
A is the first in the index and E is the last in the 
index). 

 Response 
Frequency Type 

Sets the display type for the response 
frequencies: Percents (default) or Totals. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 
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Report 
Section 

Report 
Property 

Description 

Test Stats 
Options 

Display Test 
Stats 

Sets whether to display the test stats section in 
the header of the report (Total Possible Points 
through Range of Scores). 

 Repeat Test 
Stats 

Sets whether to repeat the Test Stats section 
of the report on every report page. Set Repeat 
Test Stats to First Page Only to have the Test 
Stats section only display on the first page of 
the report. Set Repeat Test Stats to Every Page 
to have the Test Stats section display on the 
every page of the report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.7 Report 107 – Demographic Grade Report 
The Demographic Grade Report allows you to see test scores broken down by specific 
criteria. You can select questions from the data on which to base the report. For 
example, this report is especially useful for comparing demographic groups. If your 
students mark a category such as ethnicity on their test answer sheet, you can view the 
data by ethnic group. This report is very similar to the Comparative Grade Report, but is 
displayed in table format as opposed to hierarchical format. The following options are 
available for the Demographic Grade Report: 

 

Option Description 

Overall/Objective If you are using Learning Objectives, the first table in the 
report has a heading called Overall and subsequent tables 
list the objective name as the table heading. 

Benchmark Displays the target benchmark score, if one was entered in 
the Grade Wizard or Remark Quick Stats Preferences. 

Report Criteria Displays the form template questions selected to generate 
the report. For example, if your report is broken down by 
gender you would have a column called Gender and then 
see the options (e.g., Male, Female) listed below. 

Students Displays the number of students that fall into each selected 
category.  

Grade Displays the grade achieved at each level of the report 
(e.g., for each question that was selected to generate the 
report). 
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Option Description 

Scaled Score Displays the scaled score achieved at each level of the 
report, if applicable. 

Percent Displays the percent score achieved at each level of the 
report (e.g., for each question that was selected to 
generate the report). 

Benchmark Difference Displays the difference between the defined benchmark 
and the score achieved by the students in the selected 
category. 

 
The following table summarizes the Demographic Grade Report Properties (accessible by 
clicking Tools|Report Properties): 
 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks student grade percentages. 
(See Chapter 4 Preferences and Properties for 
more details.) 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Header Font Size Sets the font size used in the header row 
section of the table within the report (Students, 
Grade, Percent, etc.). 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 
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Report 
Section 

Report 
Property 

Description 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Summary 
Information 

Display 
Respondents 

Sets whether to display the Students column of 
the report, which shows the number of 
students falling into each category. 

 Display Grade Sets whether to display the Grade column of 
the report. 

 Display Scaled 
Score  

Sets whether to display the Scaled Score 
column of the report, if a scaled score was set 
up in the Grade Wizard or as a default scaled 
score in the Remark Quick Stats Preferences. 

 Display Percent Sets whether to display the Percent column of 
the report. 

 Display 
Benchmark 
Difference 

Sets whether to display the Benchmark 
Difference column of the report, if benchmarks 
were applied using the Grade Wizard or 
Remark Quick Stats Preferences. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

 

To run a Demographic Grade Report 
1 In the Remark Quick Stats Task Pane, select 

the link for 107 - Demographic Grade 
Report. 

2 In the Group Selection window, select up 
to three question(s) you wish to include in 
the report. Double click questions or use the 

Add button , to move the questions to 
the selected window. 

Note: You may select multiple questions 
by holding down the Ctrl key and clicking 
the questions or you may choose a range 
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of questions by selecting the first question, then holding down the Shift key 
and selecting the last question. 

3 Click the OK button to run the report. 

2.4.8 Report 111 – Class Learning Objectives Report 
The Class Learning Objectives report provides the average score for the overall test and 
each learning objective defined in the Grade Wizard. Objectives are listed down the left 
side of the report, and then the grade, total score and percent score are listed for each 
learning objective. If a scaled score is defined, it can also be displayed. If one or more 
subjective questions are included, the subjective total score is displayed. If a benchmark 
score was defined, the benchmark difference graph can be displayed. You can also 
optionally show correct, incorrect and missing responses. 

The following options are available for the Class Learning Objectives Report: 

 

Option Description 

Learning Objective  Lists the learning objectives defined in the Grade Wizard.  

Grade Displays the average class grade achieved based on the 
grade scale you chose in the Grade Wizard or set as your 
default Grade Scale in the Remark Quick Stats Preferences 
(Tools|Preferences|Overall Grade Scale). 

Scaled Score Displays the average scaled score achieved, as retrieved 
from an external database file. Scores can be scaled based 
on Total Score, Percent Score or Percentile. This column 
only displays if a Scaled Score was set up in the Grade 
Wizard or is set as a default scaled score in the Remark 
Quick Stats Preferences (Tools|Preferences|Overall Scaled 
Score). 

Total Displays the average total score achieved for the overall 
test and each learning objective. The first number is the 
average number of points the achieved; the second 
number is the total number of possible points on the test. 

Percent Displays the average percent score achieved for the class. 

Benchmark Difference If a benchmark score was defined in the Grade Wizard, 
displays the difference between the average score and the 
established benchmark, as well as a bar chart showing the 
relationship between the defined benchmark and the 
average score. The vertical blue line depicts the 
benchmark. If the bar charts are green, the average score 
was higher than the benchmark. If the bar charts are red, 
the average score is lower than the benchmark. The bar 
charts can be customized in the report's properties 
(Tools|Report Properties). 
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Option Description 

[Objective] Total Displays the average total score achieved for each learning 
objective for the objective questions on the test. The first 
number is the average number of objective points 
achieved; the second number is the total number of 
possible objective points for each learning objective. 

[Objective] Correct Displays the average number of questions answered 
correctly for the objective portion of the test.  

[Objective] Incorrect  Displays the average number of questions answered 
incorrectly for the objective portion of the test. 

[Objective] Missing Displays the average number of missing (e.g., non-valid 
data) questions for the objective portion of the test. 

Subjective Total Displays the average subjective score for the overall test 
and each learning objective. The first number is the 
average number of subjective points achieved; the second 
number is the total number of possible subjective points. 

 

The following table summarizes the Class Learning Objectives Report Properties 
(accessible by clicking Tools|Report Properties): 
 

Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Display Overall Sets whether to display the overall test results. 
When using the default sort options, this line 
appears first in the report, followed by analysis 
of the individual learning objectives. 

 Sort Objectives Sets whether to sort the learning objectives by 
Name or by Total Possible Points. 
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Report 
Section 

Report 
Property 

Description 

 Sort Order Sets whether to sort the learning objectives 
(based on criteria above) in ascending or 
descending order. 

 Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks grade percentages and 
benchmark difference. (See Chapter 4 
Preferences and Properties for more details.) 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Summary 
Information 

Display Total 
Score 

Sets whether to show the average total score 
earned for each learning objective. 

 Display Percent 
Score 

Sets whether to show the average percent 
score earned for the overall test and each 
learning objective. 

 Display Scaled 
Score 

Sets whether to show the average scaled score 
earned for the overall test and each learning 
objective, if applicable. 

 Display Grade Sets whether to show the average grade 
earned for each learning objective. 

 Display Missing  Sets whether to show the average number of 
missing objective responses for the overall test 
and each learning objective. Missing data is 
any data that is not valid. 

 Display Incorrect Sets whether to show the average number of 
incorrect objective responses for the overall 
test and each learning objective. 

 Display Correct Sets whether to show the average number of 
correct objective responses for the overall test 
and each learning objective. 
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Report 
Section 

Report 
Property 

Description 

 Display 
Benchmark 
Difference 

Sets whether to show the Benchmark 
Difference between the average score and the 
expected benchmark score for the overall test 
and each learning objective, if benchmarks are 
used. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.9 Report 201 - Detailed Item Analysis Report 
The Detailed Item Analysis report provides an in-depth look at individual question 
statistics. Each question displays in a separate table. The question text (or question 
name if no question text was defined in the form template or Grade Wizard) is displayed 
at the top of each table. A graph of the frequency appears to the right of the table. You 
may customize the graph by modifying the report properties (Tools|Report Properties). 
The following statistics are available: 

 

Statistic Meaning 

Response Displays the labels (answer choices) designated in the question’s 
properties. 

Frequency  Displays the number of times a particular answer choice was 
chosen by students for this particular question (e.g., the number of 
times the answer choice appears in the data set). 

Percent Displays the corresponding percentage of the frequency. 

Point Biserial A measurement of the discrimination of an item. It indicates the 
relationship between a response for a given item and the overall 
test score of the respondent. The point biserial tells you if a 
question was a good discriminator between the better students and 
the poorer students. Point biserial ranges from -1 to 1. A positive 
value indicates that the students who did well on the test answered 
the question correctly. NOTE: Point biserial is not available when 
using Standard multiple answer keys. 

Missing If you have chosen not to exclude missing values in the Remark 
Quick Stats preferences (Tools|Preferences) there is a line 
designated for the number of missing responses. Missing values are 
anything that is not valid data, such as a blank or multiple (BLANK 
or MULT) response. 
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Statistic Meaning 

Total Displays the total number of valid responses and corresponding 
percentages. If you are including missing values, the total number 
missing is included in the total. 

Objectives Displays any learning objectives defined that utilize the question. 
 

The following table summarizes the Detailed Item Analysis Report Properties (accessible 
by clicking Tools|Report Properties): 

 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Long Responses Sets whether to wrap or truncate (cut off) long 
responses (answer choices). 

 Sort Responses Sets whether to sort the responses (answer 
choices) by frequency on a per question basis. 
If the responses are sorted, you can quickly 
see the most and least chosen responses. 

 Display Point 
Biserial 

Sets whether to display the Point Biserial 
column of the report. 

 Display 
Frequency 

Sets whether to display the Frequency column 
of the report. 

 Display Percent Sets whether to display the Percent column of 
the report. 

 Display Learning 
Objectives 

Sets whether to display each learning objective 
defined in the Grade Wizard on the report in its 
own section. 
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Report 
Section 

Report 
Property 

Description 

 Table Header Sets what to display above each table to 
identify it: Auto Number (sequential numbers), 
Question Name, Question Text, Item Number 
(item number as it appears in the order of the 
test). 

 Question Page 
Break 

Sets whether to place a page break after the 
information for each question is displayed. 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Graph Graph Position Sets the position of the graph: Within Table or 
Beneath Table. 

 Graph Size Sets the size of the graph displayed on the 
report: Small, Medium or Large. 

 Display Graph Sets whether to display a graph of the percent 
information. 

 Graph Properties Sets the graph properties, including type of 
graph, titles, colors, fonts, etc. (See Chapter 4 
Preferences and Properties for further details.) 

NA Format 
Options 

Italicize NA Sets whether to italicize the NA (not applicable) 
answer choices reported. NA answer choices 
are set up in the form template. 

 NA Color Sets the color for the NA (not applicable) 
answer choices. NA answer choices are set up 
in the form template. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 
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Report 
Section 

Report 
Property 

Description 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.10 Report 203 - Item Analysis Graph Report 
The Item Analysis Graph Report contains similar graphs to those displayed in the 
Detailed Item Analysis and limited information pertaining to each graph. This report is a 
simplified version of the Detailed Item Analysis and provides a good way to view or 
export just the graph information. You may optionally show the Responses and 
Frequency Percents that are used to generate the graphs. The corresponding data for 
each graph can be shown or hidden by adjusting the report properties (Tools|Report 
Properties). You can also control how many graphs are displayed per page, as well as 
customize the graphs in the report properties. The following table summarizes the Item 
Analysis Graph Report Properties (accessible by clicking Tools|Report Properties): 

 

Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Long Responses Sets whether to wrap or truncate (cut off) long 
responses (answer choices). 

 Sort Responses Sets whether to sort the responses (answer 
choices) by frequency on a per question basis. 
If the responses are sorted, you can quickly 
see the most and least popular responses 
chosen. 

 Display Answer 
Items 

Sets whether to display charts with the answer 
item information to the right of each graph. 
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Report 
Section 

Report 
Property 

Description 

 Display Columns Sets the number of columns in which to display 
the graphs. Two columns are recommended 
when you are also displaying the answer items. 
If you are not displaying answer items, you 
may be able to fit more columns on a page. 

 Graph Header Sets whether to show a header over each 
graph, which can consist of: Auto Number, 
Question Name, Question Text or Item 
Number. Note that if using long question text, 
the report extends to more pages in order to 
accommodate all of the text. 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Graph Graph Properties Sets the graph properties, including type of 
graph, titles, colors, fonts, etc. (See Chapter 4 
Preferences and Properties for further details.) 

NA Format 
Options 

Italicize NA Sets whether to italicize the NA (not applicable) 
answer choices reported. NA answer choices 
are set up in the form template. 

 NA Color Sets the color for the NA (not applicable) 
answer choices. NA answer choices are set up 
in the form template. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 
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2.4.11 Report 204 - Condensed Item Analysis Report 
The Condensed Item Analysis report displays the same information from the Detailed 
Item Analysis report but in a condensed fashion. The question text (or question name if 
no question text was defined) is displayed at the top of each table. A bar chart is 
displayed to the right of the table containing the statistics. The bar chart displays the 
correct response(s) in green and the incorrect response(s) in red. If an incorrect 
response is chosen more than the correct response(s), its bar chart is yellow. The 
following options are available: 

 

Statistic Meaning 

Question Displays the question text (or question name if no question text 
was defined) as defined in the form template or Grade Wizard. 

Response Displays the labels (answer choices) designated in the question’s 
properties. 

Frequency  Displays the number of times a particular answer choice was 
chosen by students for this particular question (e.g., the number 
of times the answer choice appears in the data set). 

Percent Displays the corresponding percentage of the total. 

Bar Chart Displays a bar chart of the frequency. The correct responses’ bar 
chart is green and the incorrect responses’ bar chart is red. 

Missing If there are missing values in your data set the total and 
corresponding percent are displayed for each question. Displaying 
missing values is controlled in the Remark Quick Stats 
Preferences (Tools|Preferences). 

 

The following table summarizes the Condensed Item Analysis Report Properties 
(accessible by clicking Tools|Report Properties): 

 
Report 
Section 

Report 
Property 

Description 

Report Header Display Legend  Sets whether to show the report’s legend. The 
legend explains what the colors on the report 
mean and is visible at the top of the report 
when set to show.  

 Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 
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Report 
Section 

Report 
Property 

Description 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks frequency percentages. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Table Header Sets what to display above each table to 
identify it: Auto Number (sequential numbers), 
Question Name, Question Text, Item Number 
(item number as it appears in the order of the 
test). 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Display 
Frequency 

Sets whether to display the frequency column 
on the report. 

 Display Mean Sets whether to display the question mean on 
the report. This setting applies to survey 
operations only. 

 Long Responses Sets whether to wrap or truncate (cut off) long 
responses (answer choices). 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

NA Format 
Options 

Italicize NA Sets whether to italicize the NA (not applicable) 
answer choices reported. NA answer choices 
are set up in the form template. 
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Report 
Section 

Report 
Property 

Description 

 NA Color Sets the color for the NA (not applicable) 
answer choices. NA answer choices are set up 
in the form template. 

 NA Bar Color Sets the color for the NA bar chart of the 
frequency. NA answer choices are set up in the 
form template. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.12 Report 207 - Test Item Statistics Report 
The Test Item Statistics report displays descriptive statistics for each question on the 
test. The following table summarizes these statistics: 

 

Statistic Description 

Question Displays the question text (if defined) or question name if no 
question text was defined for the question in the template or 
the Grade Wizard. You may also choose to auto number the 
items sequentially or display the item number of the question 
from the test. 

Points Displays the number of correct points assigned to the 
question. 

Graded Displays the number of tests where this question was graded. 

Correct Displays the number of students who answered the question 
correctly 

Incorrect Displays the number of students who answered the question 
incorrectly. 

No Response Displays the number of students who left the question 
unanswered (blank). 

Point Biserial A measurement of the discrimination of an item. It indicates 
the relationship between a response for a given item and the 
overall test score of the respondent. The point biserial tells 
you if a question was a good discriminator between the better 
students and the poorer students. Point biserial ranges from -
1 to 1. A positive value indicates that the students who did 
well on the test answered the question correctly. NOTE: Point 
biserial is not available when using Standard multiple answer 
keys. 
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Statistic Description 

Benchmark Displays the target benchmark score for each question, if one 
was entered in the Grade Wizard or Remark Quick Stats 
Preferences. 

Percent Correct Displays the percentage of students who answered the 
question correctly. 

Benchmark Difference If a benchmark score was defined in the Grade Wizard or 
Remark Quick Stats Preferences, the Benchmark Difference 
displays the difference between the student's score and the 
established benchmark, as well as a bar chart showing the 
relationship between the defined benchmark and the 
student's score. The vertical blue line depicts the benchmark. 
If students' bar charts are green, they have scored higher 
than the benchmark. If students' bar charts are red, they 
have scored lower than the benchmark. The bar charts can 
be customized in the report's properties (Tools|Report 
Properties). 

 

The following table summarizes the Test Item Statistics Report Properties (accessible by 
clicking Tools|Report Properties): 

 

Report Section Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Sort Questions Sets whether to sort the questions by: 
Question Name, P-Value or Point Biserial. 

 Sort Order Sets whether to sort the questions (based on 
criteria above) in ascending or descending 
order. 
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Report Section Report 
Property 

Description 

 Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks frequency percentages. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Correct 
Points 

Sets whether to display the Points column of 
the report. The Points column represents the 
possible points earned when the question is 
answered correctly. 

 Display Number 
Graded 

Sets whether to display the Graded column of 
the report. The Graded column represents the 
number of graded questions on the test. 

 Display Number 
Correct 

Sets whether to display the Correct column of 
the report. The Correct column represents the 
number of students who answered the question 
correctly on the test. 

 Display Number 
Incorrect 

Sets whether to display the Incorrect column of 
the report. The Incorrect column represents 
the number of students who answered the 
question incorrectly on the test. 

 Display Number 
Missing 

Sets whether to display the No Response 
column of the report. The No Response column 
represents the number of students who 
answered did not answer the question on the 
test. 

 Display Point 
Biserial 

Sets whether to display the Point Biserial 
column of the report.  

 Display 
Benchmark 

Sets whether to display the Benchmark column 
of the report.  

 Display Percent 
Correct 

Sets whether to display the Percent Correct 
column of the report.  

 Display 
Benchmark 
Difference 

Sets whether to display the Benchmark 
Difference column of the report.  

 Row Shading Sets whether to shade every other row in the 
chart. 

 Item Label Sets what to display in the Question column to 
identify each question listed on the report: 
Auto Number (sequential numbers), Question 
Name, Question Text, Item Number (item 
number as it appears in the order of the test). 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 
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Report Section Report 
Property 

Description 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

2.4.13 Report 208 - Crosstabulation Report 
The Crosstabulation report generates a table displaying the number of cases falling into 
each combination of the categories of two or more categorical variables. Crosstabulation 
is a method of examining the relationships among variables that are at the nominal or 
ordinal level. The categories of one variable are listed in the rows and of a second 
variable in the columns. You choose specific questions from your data to use in the 
crosstabulation. The frequencies displayed in the Crosstabulation report can be totals or 
percents. The correct answer for each question is marked with an asterisk. Please note 
that questions that allow more than one response cannot be used for crosstabulations.  

The following table summarizes the Crosstabulation Report Properties (accessible by 
clicking Tools|Report Properties): 

 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 
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Report 
Section 

Report 
Property 

Description 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Remove Empty Sets whether to remove columns/rows that 
contain empty responses. 

 Table Title Sets the title for each crosstabulation table. 

 Bold Table 
Headers 

Sets whether to put the table header in bold 
formatted font. 

 Percentages Sets whether to display the frequencies for 
each crosstabulation in raw numbers or 
percentages.  

 Page Break Sets whether to insert a page break after each 
crosstabulation table. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

 

To run a Crosstabulation Report 
1 In the Remark Quick Stats Task Pane, select the link for Crosstabulation Report. 
2 In the Crosstabulation Question Selection window, select the question(s) you 

wish to include in the report. Place the row question to be analyzed in the Rows box 
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and the column question to be analyzed in the 

Columns box. Use the Add button , to move 
the questions to the selected window. 

Note: You may select multiple questions by 
holding down the Ctrl key and clicking the 
questions or you may choose a range of 
questions by selecting the first question, then 
holding down the Shift key and selecting the 
last question. 

3 Click the OK button to run the report. 

2.4.14 Report 301 - Student Grade 
Report 
The Student Grade Report provides a detailed grade report for each student included in 
the grade operation. You may print these reports and give them to your students, 
parents or other stakeholders. The report provides a summary of the students’ answers 
and grade information from the test. If a benchmark score was defined using the Grade 
Wizard, you may include a bar chart depicting the student's score along with the 
benchmark. If learning objectives were defined using the Grade Wizard, you will see 
scores for each learning objective in addition to the overall test. Incorrect responses are 
highlighted in yellow. If subjective questions are included, they are highlighted in orange 
whenever full credit is not awarded. If extra credit questions are included, they are 
highlighted in blue. The colors can be customized in the report’s properties (Tools|Report 
Properties). If the forms were scanned with an OMR/Image scanner and you captured 
form images during scanning, images of the students’ tests appear with each report. 

You can customize the report header to include the following class information on each 
student report: highest score, lowest score, median score, mean score, number of tests 
graded (Tools|Report Properties|Header Layout). The following options can be included 
in the reports: 

 

Option Meaning 

Student Displays information to identify the student. If questions 
are set as Analysis Respondent IDs in the form template 
or Grade Wizard, the information appears here (e.g., 
Name, ID Number, etc.). If there is no Analysis 
Respondent ID, the grade reports reflect a sequential 
number. 

Grade Displays the student's letter grade. 

Scaled Score Displays the scaled score, if a scaled score was set up in 
the Grade Wizard or in the Remark Quick Stats 
Preferences. 

Total Score Displays the total raw score (includes objective score, 
subjective score and extra credit). 

Percent Score Displays the corresponding percent score (includes 
objective score, subjective score and extra credit). 
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Option Meaning 

Bar Chart Displays a bar chart of the student's score as compared to 
the established benchmark, if one was defined. 

Benchmark Displays the benchmark score for the test, if one was 
defined in the Grade Wizard or in the Remark Quick Stats 
Preferences. 

Question Displays the question name for each question that was 
graded. 

Response Displays the response that the student chose for each 
question. If a response is incorrect, it is highlighted in 
yellow. You may select whether you want to show the 
correct response for any responses that are incorrect (you 
may set this property as well as the incorrect response 
color under Tools|Report Properties). 

Correct Answer Displays the correct answer for any question that is 
incorrect (optional). 

 

The following table summarizes the Student Grade Report Properties (accessible by 
clicking Tools|Report Properties): 

 

Report 
Section 

Report 
Property 

Description 

Report Header Display Legend  Sets whether to show the report’s legend. The 
legend explains what the colors on the report 
mean and is visible at the top of the report 
when set to show. 

 Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 
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Report 
Section 

Report 
Property 

Description 

Report Format Sort Students Sets whether to sort the students by: 
Respondent ID, Percent Score, Total Score, 
Percentile or Grade. 

 Sort Order Sets whether to sort the students (based on 
criteria above) in ascending or descending 
order. 

 Page Break Sets whether to insert a page break after each 
student grade report. 

 Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks frequency percentages. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Grade Sets whether to display the students’ grade on 
the report. 

 Display Scaled 
Score 

Sets whether to display the students’ scaled 
score, if one was set up using the Grade 
Wizard or in the Remark Quick Stats 
Preferences. 

 Display Total 
Score 

Sets whether to display the students’ total 
score on the report. 

 Display Percent 
Score 

Sets whether to display the students’ percent 
score on the report. 

 Display 
Benchmark 

Sets whether to display the benchmark score 
for the test if one was set up in the Grade 
Wizard or Remark Quick Stats Preferences. 

 Display Learning 
Objectives 

Sets whether to display the score obtained for 
each learning objective defined in the Grade 
Wizard. 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Font Sets the font type used in the report. 

 Data Font Size Sets of the size of the font used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 
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Report 
Section 

Report 
Property 

Description 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Image Format  
(This section 
applies when 
using an 
OMR/Image 
scanner only.) 

Quality Sets the quality of the images displayed for 
each student's test: Low, Medium or High. Note 
that displaying in high quality may add 
significantly to the amount of time it takes to 
run the report.  

 Image 
Orientation 

Sets the orientation of the test images that are 
displayed on the report. This property applies 
to Remark Classic OMR generated reports only. 

 Display Page 
Images 

Sets whether to display images of each 
student's test on the report: None or All. You 
may also type a value here to represent how 
many images you want displayed (applies to a 
multi-page test only).  

 Display Columns Sets the number of columns in which to display 
the images of each student's test. The more 
columns you have, the smaller the test images 
are displayed.  

 Page Break 
Before Images 

Sets whether to insert a page break before the 
image portion of each student’s report. 

 Image Width Sets the image width relative to the size of the 
report. A smaller percentage shrinks the image 
and a larger percentage enlarges the image. 
(Note: Printed images are typically better 
quality than what you see within the software.) 

Item Format Display Correct 
Answers 

Sets whether to display the correct answer for 
any question that is marked as incorrect. 

 Display 
Responses 

Sets whether to display the student's 
responses on the report. 

 Incorrect Item 
Text Color 

Sets the text color for responses that are 
incorrect. You may use this feature to help the 
incorrect responses stand out on the report. 

 Incorrect Item 
Highlight Color 

Sets the highlight color for the responses that 
are incorrect. Highlighting the incorrect 
responses helps the student easily identify 
which questions are incorrect. 
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Report 
Section 

Report 
Property 

Description 

 Subjective Item 
Highlight Color 

Sets the highlight color for the subjective 
answer points when the maximum point value 
is not achieved (e.g., a student earns 15 out of 
20 points). If you do not want partial credit 
responses to be highlighted, choose white for 
the highlight color. 

 Extra Credit 
Item Text Color 

Sets the text color for responses that are 
designated as extra credit. You may use this 
feature to help the extra credit responses stand 
out on the report. 

 Extra Credit 
Item Highlight 
Color 

Sets the highlight color for the responses that 
are designated as extra credit. Highlighting the 
extra credit responses helps to easily identify 
which questions are extra credit. 

 Show Questions Sets which question types to display: All, 
Correct only or Incorrect only. 

 Display Columns Sets the number of columns in which to display 
the responses. The more columns you have, 
the less that fits across a page. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

Report 
Behavior 

Display Prompt When this property is set to Show, the 
Respondent Selection window appears so that 
you can select which students you want 
included in the report. If this property is set to 
Hide, all students listed in the data set being 
graded are included in the report. This report is 
memory intensive, particularly if showing the 
images, so you may wish to run it in batches 
using this property if you have a large number 
of students. 

 

To run the Student Grade Report 
1 In the Remark Quick Stats Task Pane, select the link for Student Grade Report. 

If you have the Display Prompt setting on Show, the Respondent Select window 
appears. If the Display Prompt setting is on Hide, you simply see the report. 

2 [Optional] In the Respondent Selection window, select the student(s) you wish to 
include in the report. The Respondent Selection window appears if you have the 
Display Prompt property set to Show in the report properties (Tools|Report 
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Properties). Double click students or use the Add button , to move the students 
to the selected window. 

Note: You may select multiple students by holding down the Ctrl key and 
clicking the students or you may choose a range of students by selecting the 
first student, then holding down the Shift key and selecting the last student. 

3 [Optional] Click the OK button to run the report. A grade report appears for each 
selected student. 

Tip: If you are displaying the test images with the Student Grade Report, 
they look better when printed then they look on the screen. For better 
image quality, you can change the Image Quality property in the report 
properties (Tools|Report Properties). Note that the report may take longer 
to run if you use a high image quality. 

2.4.15 Report 401 - Response Report by Item 
The Response Report by Item displays all answers given to a question or questions on 
the form. By default, any questions that are not graded or tabulated in the form 
template or Grade Wizard can be included on the Response Report by Item. You can 
choose from all questions, regardless of whether they are graded or tabulated, by 
adjusting the report properties (Tools|Report Properties). This report is useful for 
displaying data from Input regions so that you can see how your respondents responded 
to write-in questions. For Input regions, you will see the text you entered into the data 
grid. The Response Report by Item will be grouped by question (i.e. you will see the 
question and then the respondents' responses). You may choose whether to include an 
Analysis Respondent ID with the responses in the report properties (Tools|Report 
Properties). If there are no Analysis Respondent ID questions designated in the form 
template or Grade Wizard, the responses are sequentially numbered. The following table 
summarizes the Response Report by Item Properties (accessible by clicking Tools|Report 
Properties): 

 

Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  
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Report 
Section 

Report 
Property 

Description 

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format  Sort Items Sets whether to sort the responses by 
Respondent ID or Response on a per question 
basis. You may also leave the responses 
unsorted (default). 

 Sort Order Sets whether to sort the responses (based on 
criteria above) in ascending or descending 
order. 

 Display All 
Questions  

Sets whether to include both graded/tabulated 
and non-graded/tabulated questions in the list 
of available questions for the report. This 
report is typically run with non-
graded/tabulated questions, such as comment 
areas on a survey. However, you may wish to 
also use graded or tabulated questions in the 
report. Setting this property to Yes shows all 
questions from the form template. 

 Respondent ID Sets whether to show questions identified as 
Analysis Respondent IDs in the report. Use of 
this feature links the response back to a 
respondent. If you use this feature but do not 
have any questions designated as Analysis 
Respondent IDs, each response is displayed 
with a sequential number. 

 Page Break Sets whether to insert a page break after each 
item. 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Image Quality Sets the quality of the images displayed for 
each item: Low, Medium or High. Note that 
displaying in high quality may add significantly 
to the amount of time it takes to run the 
report. (Applies to Remark Office OMR only.) 

 Question 
Identifier Label 

Sets the text to be used to identify each 
question on the report (e.g., Question: Do you 
have any additional comments?). 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Page Size  Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 
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Report 
Section 

Report 
Property 

Description 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

To run a Response Report by Item 
1 In the Remark Quick Stats Task Pane, select 

the link for Response Report by Item. 
2 In the Response Report Question 

Selection window, select the question(s) you 
wish to include in the report. Double click 

questions or use the Add button , to 
move the questions to the selected window.  

Note: You may select multiple questions 
by holding down the Ctrl key and clicking 
the questions or you may choose a range 
of questions by selecting the first question, 
then holding down the Shift key and selecting the last question. 

3 Click the OK button to run the report. Responses for the selected questions appear, 
grouped by question. 

2.4.16 Report 402 - Response Report by Respondent 
The Response Report by Respondent displays respondents' answers to the questions on 
the form. By default, any questions that are not graded or tabulated on the form can be 
included on the Response Report by Respondent. You can choose from all questions, 
regardless of whether they are graded or tabulated, by adjusting the report properties 
(Tools|Report Properties). This report is useful for displaying data from Input regions so 
that you can see how your respondents responded to write-in questions. For Input 
regions, you will see the text you entered into the data grid. The Response Report by 
Respondent will be grouped by respondent (i.e. you will see the respondent listed first 
and then that respondent's responses for all selected questions). You may choose 
whether to include an Analysis Respondent ID with the responses in the report 
properties (Tools|Report Properties). If there are no Analysis Respondent ID questions in 
the form template or Grade Wizard file, the responses are sequentially numbered. The 
following table summarizes the Response Report by Respondent Properties (accessible 
by clicking Tools|Report Properties): 
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Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Sort Items Sets whether to sort the responses by 
Respondent ID or Response on a per question 
basis. You may also leave the responses 
unsorted (default). 

 Sort Order Sets whether to sort the responses (based on 
criteria above) in ascending or descending 
order. 

 Display All 
Questions  

Sets whether to include both graded/tabulated 
and non-graded/tabulated questions in the list 
of available questions for the report. This 
report is typically run with non-
graded/tabulated questions, such as comment 
areas on a survey. However, you may wish to 
also use graded or tabulated questions in the 
report. Setting this property to Yes shows all 
questions from the form template. 

 Respondent ID Sets whether to show questions identified as 
Analysis Respondent IDs in the report. Use of 
this feature links the response back to a 
respondent. If you use this feature but do not 
have any questions designated as Analysis 
Respondent IDs, each response is displayed 
with a sequential number. 

 Page Break Sets whether to insert a page break after each 
item. 

 Row Shading Sets whether to shade every other row in the 
chart. 
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Report 
Section 

Report 
Property 

Description 

 Image Quality Sets the quality of the images displayed for 
each item: Low, Medium or High. Note that 
displaying in high quality may add significantly 
to the amount of time it takes to run the 
report. This property applies to Remark Classic 
OMR generated reports only. (Applies to 
Remark Office OMR only.) 

 Respondent 
Identifier Label 

Sets the text to be used to identify each 
respondent on the report (e.g., Respondent: 
John Doe). 

 Data Font Size Sets of the size of the font used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Font Sets the font type used in the report. 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

 

To run a Response Report by Respondent 
1 In the Remark Quick Stats Task Pane, select 

the link for Response Report by 
Respondent. 

2 In the Response Report Question Selection 
window, select the question(s) you wish to 
include in the report. Double click questions or 

use the Add button , to move the 
questions to the selected window. 

Note: You may select multiple questions by 
holding down the Ctrl key and clicking the 
questions or you may choose a range of 
questions by selecting the first question, then 
holding down the Shift key and selecting the last question. 

3 Click the OK button to run the report. Responses for the selected questions appear, 
grouped by respondent. 
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Tabulating Surveys 
Chapter 3 

The Remark Classic OMR software offers two formats for tabulating surveys: Easy 
Survey and the Survey Wizard. Easy Survey provides a quick overview of your results. 
The Survey Wizard allows you to customize the survey tabulation process. 

3.1 Using Easy Survey  

Easy Survey is a quick way to tabulate a survey style form using pre-determined 
constraints. When you use Easy Survey, Remark Quick Stats uses the parameters set in 
the form template to control tabulation, such as whether to tabulate a question, the 
question text to use to make reports more meaningful and whether to display a 
question’s data as an analysis respondent ID on the reports (e.g., a name to identify 
each tabulated survey response). 

 

To use Easy Survey 
1 Create or identify a form template for your form in the Remark Classic OMR 

Template Editor. Be sure to set up survey parameters, such as which questions to 
include in the survey tabulation and Analysis Respondent ID regions. If you are 
unsure of how to set up form template regions, consult the Remark Classic OMR 
User's Guide included with your software.  

2 In the Remark Classic OMR Data Center, scan forms using the Read Wizard or 
open an existing data file.  

3 After processing the forms, select the Tools menu, then click Analysis and then 

Easy Survey, or click . Alternatively, choose the Easy Survey link in the 
Analysis section of the Task Pane. 

The Remark Quick Stats window appears. This window contains a Task Pane on the 
left allowing you to display reports. Refer to Section 3.3 for information about the 
reports and statistics calculated. 

3.2 Using the Survey Wizard 

Remark Quick Stats provides a Survey Wizard to allow you to customize the survey 
tabulation process. The Survey Wizard allows you to specify multiple data sets to include 
in the survey operation, add meta data to use for filtering reports, specify subsets of 
questions to analyze separately in a group, add question weights for grouped questions, 
set benchmarks, apply custom report headers and determine which questions to include 
or exclude. In addition, you may save an analysis definition containing all of your 
tabulation parameters for repeated use.  
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To use the Survey Wizard 
1 Create or identify a form template for your form in the Remark Classic OMR 

Template Editor.  
2 In the Remark Classic OMR Data Center, scan forms using the Read Wizard or 

open an existing data file.  
3 After processing the forms, select the Tools menu, then click Analysis and then 

Survey Wizard, or click . Alternatively, choose the Survey Wizard link in 
the Analysis section of the Task Pane. 

4 [Optional] You may tabulate multiple 
data sets by opening the data sets 
first. When you start the Survey 
Wizard, the Possible Data Sets 
window appears. Select the data set(s) 
you wish to include in the tabulation 
operation. Only data sets that come 
from the same form template appear in 
this window. In this window you may 
optionally add a Data Group name to 
identify each data set. Using a group 
name allows you to filter data. For example, you could enter a year in the Data 
Group column and then compare data across years. The Data Group option 
appears when you filter data, use the Report Batch Wizard and on select reports, 
such as the Comparative Item report, Crosstabulation and Response reports. 

3.2.1 The Getting Started Window 
The Getting Started window appears first, which allows you to select an existing 
analysis definition file. When you finish the Survey Wizard, you are offered options for 
saving the definition as a Survey Definition File 
(.SDF). By default, these files are stored in a 
folder called Analysis Definitions within your 
Remark Classic OMR 4 installation folder. The 
Browse button at the beginning of the wizard 
allows you to locate and utilize saved survey 
definition files. 
 
1 Click the Browse… button if you have 

already created a survey definition file that 
you would like to use. If you would like to 
create a new survey definition file, continue 
to the next section. 

Note: The remaining instructions are 
provided in the context of creating a new survey definition file. If you are 
using an existing survey definition file, you can use the same screens and 
instructions to make modifications.   

2 Click the Next>> button to continue. 
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3.2.2 The Question Properties Window 
The Question Properties window appears next, which allows you to modify the 
properties for your form questions. The Survey Wizard initially uses any values that were 
defined in the form template. You may make modifications to these settings here, which 
do not affect your form template. The following options are available: 

 

Option Description 

Question text Enter of modify question text to be used on the 
reports. You can use the keyboard shortcut for Paste - 
Ctrl + V - to paste information from the Windows 
clipboard, or right click for Paste options. 

Identifies the respondent Mark this checkbox to include the information 
obtained from this question as a respondent identifier 
on select reports. For example, if you are collecting 
some sort of identification number, this information 
can appear on the reports to link the report back to 
the respondent. The question must not be set to be 
included in the analysis operation in order to 
designate it as a respondent identifier. 

Include in Analysis Mark this checkbox to include the question in the 
analysis operation.  

Data Type Select the data type for the question: Textual or 
Numeric. 

Answer Values If desired, adjust the values associated with each 
answer choice. These values are used to calculate 
statistics in Remark Quick Stats (e.g., the calculation 
of a question mean). 

Numeric Range If desired, enter the minimum and maximum values 
for numeric questions that do not have any response 
choices, such as those that are not multiple choice or 
list OMR regions. This feature allows you to define a 
range for use in graphing these questions on the 
Question Mean Report and the Comparative Item 
Report in Remark Quick Stats. For example, if you are 
using a Grid OMR region, entering a minimum and 
maximum value allows you to see your responses 
graphically. 

Define Benchmark Value Mark this checkbox and enter a benchmark to define a 
benchmark value you wish to achieve for the question. 
Actual responses are compared against this 
benchmark value on select reports. The benchmark 
value is calculated using the values assigned to each 
answer choice during form template set up. 
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Option Description 

Not Applicable Answer If your question has a “Not Applicable” answer choice 
and you do not want the NA responses to be included 
in the Remark Quick Stats statistics (e.g., means), 
choose the appropriate label from the NA Label drop-
down list. This list is automatically populated with the 
labels you defined in the Labels grid when you created 
the form template. Only one option can be selected as 
NA. In the Remark Quick Stats preferences you can 
choose whether to include or exclude the NA 
responses. 

 

1 Select a question in the left Task Pane and 
then make the appropriate changes to the 
desired items. You may select multiple 
questions by clicking a question and 
holding down the Ctrl key on the 
keyboard, or by clicking a question, 
holding down the Shift key and then 
clicking another question to select a range 
of questions. Note that depending on the 
type of questions selected, some options 
may not be available to you (e.g., multi-
selecting a barcode region and an OMR 
region may not afford you the same 
options). 

2 Click the Next>> button to continue. 

3.2.3 The Analysis Groups Window 
The Analysis Groups window appears next. Analysis groups allow you to create subsets 
of questions, view the responses and view a mean for the entire group. For example, 
suppose you are administering a customer satisfaction survey. On the survey you might 
have questions related to staff, product and overall satisfaction. You could group the like 
questions together in Analysis Groups to see overall scores on each section of questions 
(one group for staff, one group for product and one group for overall satisfaction). The 
Analysis Groups Report displays in Remark Quick Stats when you have created Analysis 
Groups in the Survey Wizard. 

 

1 In the Analysis Groups window, create groups of questions to be analyzed together 
in addition to the overall form questions. To create an analysis group, type the name 
of the group in the Name box and then click the Add Group button. Alternatively, 
you may import a list of group names from a spreadsheet or database file. Click the 
Import button to import the names of the desired groups. The group names are 
listed in the Analysis groups box. 

2 The tabulated questions on the form are listed in the Available Questions box. 
Select an analysis group on the right, then select a question (or questions) in the 
Available Questions box and then click the Add Questions to the selected 
analysis group button. The selected questions are moved to the Analysis groups 
box, beneath the selected analysis group. You may use the Remove questions 
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from the selected analysis group arrow to remove any unwanted questions 
assigned to a particular analysis group.  

Tip: You can double click questions to 
add them quickly to an analysis group. 
You can also select multiple questions by 
holding down the Control key as you 
click questions, or by clicking a question, 
holding down the Shift key and then 
clicking another question to select the 
range of questions. 

3 If desired, assign a benchmark value to the 
analysis group by marking the checkbox for 
Define Benchmark Value. Enter the 
benchmark value you wish to achieve on 
this group of questions in the Benchmark 
value box. For example, if your answer choices are weighted as 1-5, with 3.5 being 
acceptable, your Benchmark Value is 3.5. 

4 Click the Next>> button to continue. 

3.2.4 The Group Weights Window 
If analysis groups are defined the Group Weights window appears next. In this 
window, you can optionally assign different weights to questions within a group. This 
feature is useful if certain questions within the group are more important to you than 
others. When displaying the results, Remark Quick Stats factors in the weights.  
 

1 To assign weights, select an analysis 
group from the Analysis Group drop-
down list. The questions within that group 
appear in the Question column. A default 
weight of 1.00 appears in the Weight 
column. Adjust the weights for questions 
as appropriate. If you do not wish to 
weight your questions, skip this step (all 
questions carry a weight of 1.00). 

2 Click the Next>> button to continue. 

3.2.5 The Custom Header Window 
In the Custom Header window, optionally define a header for the resulting reports. 
Custom report headers are explained in detail in Section 4.2. Custom headers allow you 
to customize titles and add graphics to your report headings. By creating a custom 
header within the Survey Wizard, it is saved with the survey definition file generated by 
the Survey Wizard (if you save the survey definition file), which means you do not have 
to recreate the custom report header any time you tabulate data using this survey 
definition file. Custom headers defined in the Survey Wizard override any custom 
headers set in individual report properties. 

Note: If you would like to independently save the Report Header as its own 
file, click the Save button once you have defined the header. You can then 
use the custom header again when setting up other Analysis Definition Files. 

3 Click the Custom Report Header checkbox. 
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4 Click the Edit button to create a new report header or the Load button to open a 
previously saved report header. 

When the Report Header Layout window appears, you will see a representation of the 
report. There are nine fields that can be customized. The active field is highlighted in 
yellow. Click in a field to select and customize it. You can use the Page Width setting 
on the report to zoom in and out for better viewing. 
 

To customize fields 
1 Choose the number of columns for your report header under the Columns section: 

One, Two or Three. The number of columns determines how many fields you can 
customize (between three and nine). 

2 Click one of the fields to customize.  
3 Determine whether you want to insert text or an image in your first field. Choose the 

radio button for Text or Image. 
4 If inserting text, enter a label for the 

field in the Label box. This label is 
free text. 

5 If desired, move to the Value drop-
down list and select a value to insert. 
The default choices are Image, Date, 
Date/Time and Page Number. In 
addition, you may select a region 
from the form template that you used 
to generate this report. This feature is 
designed for reports that generate individual pages per respondent (e.g., the 
Response Report by Respondent). The data from the selected region appears in the 
report header that you define.  

6 In the Alignment section, choose an alignment for your item: Left, Center or 
Right. The inserted item is aligned accordingly within the space allotted on the 
report. 

7 If inserting an image, click the 
Browse… to locate an image to 
include on the report (e.g. a company 
logo). The following image types are 
supported: .bmp (Bitmap), .gif (GIF), 
.jpg (JPEG), .wmf (Windows Meta 
File), .ico (Icon), .cur (Cursor).  

Tip: If you need to align your 
image left, center or right, choose 
the appropriate field in the desired 
position before inserting the 
image. 

8 Repeat the steps above to insert any additional custom header information. 

Tip: If you need to reset the entire custom header back to its original state, 
click the Reset button. If you want remove an image, click in its field and 
click the Clear button. If you want to remove a text field, click in its field, 
delete the Label and change the Value to the first blank entry in the drop-
down list. 



Remark Quick Stats User's Guide 

80 
 

9 Once your header is complete, click the OK button to return to the Survey Wizard 
window. 

10 If you wish to save the custom header you just created, click the Save button and 
enter a file name and location for the header. You can load it in this same screen of 
the Survey Wizard on future survey tabulation operations. 

11 Click the Next>> button to continue. 

3.5.6 The Review Selections Window 
In the Review Selections window, review your information for accuracy. You may also 
use this window to make changes to tabulated questions, respondent identifiers and 
analysis groups. 
 
1 Once you are satisfied with the 

information, click the Finish button. If 
you have started a new survey definition 
file or made changes to an existing survey 
definition file, you are prompted to save 
the file. Alternatively, you can use the 
arrow next to the Finish button to choose 
one of the following options: 
• Save and Execute: Prompts you to 

save the survey definition file and then 
executes the survey operation. 

• Save: Saves the survey definition file 
but does not execute the survey 
operation. 

• Execute: Executes the survey operation without saving the survey definition file. 

Once the Finish button is selected, if you have not saved the definition file continue to 
step 2. 

2 If desired, save the definition file by clicking Yes when prompted. If you click No, 
the survey definition file is not saved but the Survey Wizard closes and the data is 
still tabulated. If you click Cancel, you are returned to the Survey Wizard. If you 
plan to re-use the form, it can save you time by saving the survey definition file. 

3 If you select Yes to save the survey definition file, in the Save Survey Definition 
window, enter a name for the survey definition file, choose a location to which to 
save the file and then click the Save button. 

The Remark Quick Stats window appears. This window contains a Task Pane on the 
left allowing you to display reports. Refer to Section 3.3 for information about the 
reports and statistics calculated. 

3.3 Survey Tabulation Reports 

Once you have used Easy Survey or the Survey Wizard to analyze your data, you have 
several reports available to you. Some reports present the same information in different 
ways.  

Each report has a set of properties that controls what is displayed in the report. Report 
properties are accessed by selecting the Tools menu and then clicking Report 
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Properties, or by clicking . The following sections provide a short 
description of each report as well as which items can be displayed. If you see options 
here that are not displayed when you run a report, look at your settings in the Report 
Properties. You can hide and show sections of reports in these properties. By default, 
some sections are hidden.  

3.3.1 Report 202 - Detailed Item Analysis Report  
The Detailed Item Analysis report provides an in-depth look at individual question 
statistics. Each question displays in a separate table. The question text (or question 
name if no question text was defined in the form template or Survey Wizard) is 
displayed above each table, along with the mean for the question. A graph of the 
frequency appears to the right of the table. You may customize the graph by modifying 
the report properties (Tools|Report Properties). The following statistics are available: 

 

Statistic Meaning 

Response Displays the labels (answer choices) designated in the form 
template. 

Value Displays the corresponding value for each response, as defined 
in either the form template or the Survey Wizard. Values are 
used to calculate statistics, such as means. 

Frequency  Displays the number of times a particular answer choice was 
chosen by respondents for this particular question (e.g., the 
number of times the answer choice appears in the data set). 

Percent Displays the corresponding percentage of the frequency. 

Cumulative 
Percent 

Displays the sum of the percents from the first response up to 
and including the current response. 

Valid Percent Displays the percent not including missing items. 

Cumulative Valid 
Percent 

Displays the sum of the valid percents from the first response up 
to and including the current response. 

Total Valid Displays the total number of valid responses and corresponding 
percentages (not including missing data). 

Missing Displays the total number of missing responses (e.g., non-valid 
responses such as blanks, mults, recognition errors). Showing 
and hiding missing responses is controlled in the Remark Quick 
Stats Preferences (Tools|Preferences). 

Total  Displays the total number of responses and corresponding 
percent. 

 

The following table summarizes the Detailed Item Analysis Report Properties (accessible 
by clicking Tools|Report Properties): 
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Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Long Responses Sets whether to wrap or truncate (cut off) long 
responses (answer choices). 

 Sort Responses Sets whether to sort the responses by 
frequency on a per question basis. If the 
responses are sorted, you can quickly see the 
most and least popular responses chosen. 

 Display Value Sets whether to display the Value column of 
the report. Values are the numbers assigned 
during form template creation and are used for 
statistical calculations. 

 Display 
Frequency 

Sets whether to display the Frequency column 
of the report. The frequency is the number of 
times the answer choice was chosen. 

 Display Percent Sets whether to display the Percent column of 
the report. The percent is the frequency 
displayed in percentage format.  

 Display 
Cumulative 
Percent 

Sets whether to display the Cumulative Percent 
column in the report. The cumulative percent is 
the sum of the percents from the first response 
up to and including the current response. 

 Display Valid 
Percent 

Sets whether to display the Valid Percent 
column in the report. The valid percent is the 
percent not including missing items. 

 Display 
Cumulative Valid 
Percent 

Sets whether to display the Cumulative Valid 
Percent column in the report. The cumulative 
valid percent is the sum of the valid percents 
from the first response up to and including the 
current response. 
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Report 
Section 

Report 
Property 

Description 

 Table Header Sets what to display above each table to 
identify it: Auto Number (sequential numbers), 
Question Name, Question Text, Item Number 
(item number as it appears in the order of the 
form). 

 Question Page 
Break 

Sets whether to place a page break after the 
information for each question is displayed. 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Page Size  Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Graph Graph Position Sets the position of the graph: Within Table or 
Beneath Table. 

 Graph Size Sets the size of the graph displayed on the 
report: Small, Medium or Large. 

 Display Graph Sets whether to display a graph of the percent 
information. 

 Graph Properties Sets the graph properties, including type of 
graph, titles, colors, fonts, etc. (See Chapter 4 
Preferences and Properties for further details.) 

NA Format 
Options 

Italicize NA Sets whether to italicize the NA (not applicable) 
answer choices reported. NA answer choices 
are set up in the form template. 

 NA Color Sets the color for the NA (not applicable) 
answer choices. NA answer choices are set up 
in the form template. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 
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Report 
Section 

Report 
Property 

Description 

 Right Sets the footer text at the bottom right of the 
report. 

3.3.2 Report 203 - Item Analysis Graph Report 
The Item Analysis Graph Report contains the graphs similar to those displayed in the 
Detailed Item Analysis report and limited information pertaining to each graph. This 
report is a simplified version of the Detailed Item Analysis report and provides a good 
way to view or export just the graph information. You may optionally show the 
Responses and Frequency Percents that are used to generate the graphs. The 
corresponding data for each graph can be shown or hidden by adjusting the report 
properties (Tools|Report Properties). You can also control how many graphs are 
displayed as well as customize the graphs in the report properties. The following table 
summarizes the Item Analysis Graph Report Properties (accessible by clicking 
Tools|Report Properties): 

 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Long Responses Sets whether to wrap or truncate (cut off) long 
responses (answer choices). 

 Sort Responses Sets whether to sort the responses by 
frequency on a per question basis. If the 
responses are sorted, you can quickly see the 
most and least popular responses chosen. 

 Display Answer 
Items 

Sets whether to display charts with the answer 
item information to the right of each graph. 
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Report 
Section 

Report 
Property 

Description 

 Display Columns Sets the number of columns in which to display 
the graphs. Two columns are recommended 
when you are also displaying the answer items. 
If you are not displaying answer items, you 
may be able to fit more columns on a page. 

 Graph Header Sets whether to show a header over each 
graph, which can consist of: Auto Number, 
Question Name, Question Text or Item 
Number. Note that if using long question text, 
the report extends to more pages in order to 
accommodate all of the text. 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Graph Graph Properties Sets the graph properties, including type of 
graph, titles, colors, fonts, etc. (See Chapter 4 
Preferences and Properties for further details.) 

NA Format 
Options 

Italicize NA Sets whether to italicize the NA (not applicable) 
answer choices reported. NA answer choices 
are set up in the form template. 

 NA Color Sets the color for the NA (not applicable) 
answer choices. NA answer choices are set up 
in the form template. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 
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3.3.3 Report 204 - Condensed Item Analysis Report 
The Condensed Item Analysis report displays much of the same information from the 
Detailed Item Analysis report but in a condensed fashion. The question text (or question 
name if no question text was defined in the form template or Survey Wizard) is 
displayed at the top of each table. A bar chart is displayed to the right of the table 
containing the statistics. The following options are available: 

 

Statistic Meaning 

Question Displays the question text (or question name if no question text 
was defined) as defined in the form template or Survey Wizard. 

Response Displays the labels (answer choices) designated in the form 
template. 

Frequency  Displays the number of times a particular answer choice was 
chosen by respondents for this particular question (e.g., the 
number of times the answer choice appears in the data set). 

Percent Displays the corresponding percentage of the total. 

Missing If there are missing values in your data set the total and 
corresponding percent are displayed for each question. Displaying 
missing values is controlled in the Remark Quick Stats 
Preferences (Tools|Preferences). 

Mean Displays the mean calculation for the question based on the 
values defined in the form template. 

 

The following table summarizes the Condensed Item Analysis Report Properties 
(accessible by clicking Tools|Report Properties): 
 
Report 
Section 

Report 
Property 

Description 

Report Header Display Legend Sets whether to show the report’s legend. The 
legend explains what the colors on the report 
mean and is visible at the top of the report 
when set to show. (This option only applies to 
test grading.) 

 Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 
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Report 
Section 

Report 
Property 

Description 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks frequency percentages. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Table Header Sets what to display above each table to 
identify it: Auto Number (sequential numbers), 
Question Name, Question Text, Item Number 
(item number as it appears in the order of the 
form). 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Display 
Frequency 

Sets whether to show or hide the frequency 
column on the report. 

 Display Mean Sets whether to show or hide the mean 
calculation on the report. 

 Long Responses Sets whether to wrap or truncate (cut off) long 
responses (answer choices). 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

NA Format 
Options 

Italicize NA Sets whether to italicize the NA (not applicable) 
answer choices reported. NA answer choices 
are set up in the form template. 

 NA Color Sets the color for the NA (not applicable) 
answer choices. NA answer choices are set up 
in the form template. 

 NA Bar Color Sets the color for the bar chart (value bar) for 
NA (not applicable) answer choices. NA answer 
choices are set up in the form template. 
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Report 
Section 

Report 
Property 

Description 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

3.3.4 Report 205 - Basic Item Analysis Report 
The Basic Item Analysis report provides a very simple item analysis for the survey 
operation. The report shows each question, the mean and the response frequency. This 
report allows you to get a quick overview of response frequencies on a per question 
basis. Responses can be listed by question labels, question values or answer indices. In 
order to display by question label, all questions on the form must use the same labels 
(e.g., Excellent, Good, Fair, Poor). If the labels vary, the numeric indices are used. 
There is limited space to show label names, so you may wish to use the values or 
indices. The following options are available: 

 

Statistic Meaning 

Number Displays a number for each question in ascending order. 

Question Displays each question’s name as defined in the form template. 

Mean Displays the mean calculation for the question based on the 
values defined in the form template. 

Response 
Frequencies  

Displays the number of times each answer choice was chosen for 
this particular question (e.g., the number of times the answer 
choice appears in the data set). Frequencies can be displayed as 
Totals or Percents. 

 

The following table summarizes the Basic Item Analysis Report Properties (accessible by 
clicking Tools|Report Properties): 

 

Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 
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Report 
Section 

Report 
Property 

Description 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Response 
Frequency Type 

Sets the display type for the response 
frequencies: Percents (default) or Totals. 

 Response Type Sets the display for the responses listed in the 
Response Frequencies row: Labels, Values, 
Indices. Labels refer to the labels entered in 
the form template Labels grid, Values refer to 
the values entered in the form template Values 
grid and Indices refers to the numeric index of 
the answer choice (e.g., if the answers are 
Excellent to Poor on a four point scale, 
Excellent is the first in the index and Poor is 
the last in the index). 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Display Columns Sets the number of columns in which to display 
the charts. The default setting is three 
columns. The lower the columns, the more 
spread out the report displays. The higher the 
columns, the more condensed the report 
displays. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 
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Report 
Section 

Report 
Property 

Description 

Summary 
Statistics 

Display Question 
Number 

Sets whether to display a sequential question 
number for each question on the report. 

 Display Question 
Name 

Sets whether to display the question name for 
each question on the report, as it was defined 
in the form template. 

 Display Mean Sets whether to display the mean for each 
question. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

3.3.5 Report 206 - Item Statistics Report 
The Item Statistics report displays descriptive statistics for each question in the survey 
tabulation operation. The following table summarizes these statistics: 

 

Statistic Description 

Item Displays the question name or question text (if question text 
was defined in the form template or Survey Wizard). You 
may also choose to auto number the items sequentially or 
display the item number of the question from the form. 

Sample Size Displays the valid number of respondents who answered the 
specific question. 

Missing & NA Displays the number of responses that are missing (blank, 
mult, etc.) or set as Not Applicable in the form template or 
Survey Wizard. 

Mean The average of the values in the population. 

Variance The mean of the squared deviation of a variable from its 
expected value or mean. The variance is a measure of the 
amount of variation within the values of that variable, taking 
account of all possible values and their probabilities or 
weightings (not just the extremes that give the range). 

Standard Deviation A measure of the dispersion of a set of data from its mean. 
The more spread apart the data is, the higher the deviation. 
It is calculated by taking the square root of the variance. 

Standard Error The standard deviation of the sampling distribution of that 
statistic. Standard errors reflect how much sampling 
fluctuation a statistic will show. 
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Statistic Description 

Minimum  The minimum value in a range. 

Maximum The maximum value in a range. 

Range  The distance between the maximum and minimum value. 

Skewness A measure of the symmetry or lack of it in a set of data as 
evident from the shape of the distribution. A distribution is 
symmetric if the left half of the graph of the distribution is 
the mirror image of the right half. If a distribution is skewed 
to the right (positive skewness) the mean is greater than 
median, which in turn is greater than the mode, in which 
case the skewness coefficient is greater than zero. If a 
distribution is skewed to the left (negative skewness) then 
the relationship is reversed; in which case the coefficient is 
less than zero. If there is no skewness or the distribution is 
symmetric like the bell-shaped normal curve then the mean 
= median = mode. 

Kurtosis Kurtosis is based on the size of a distribution's tails. 
Distributions with relatively large tails are called 
"leptokurtic"; those with small tails are called "platykurtic." A 
distribution with the same kurtosis as the normal distribution 
is called "mesokurtic." 

T-Value A measure on a random sample (or pair of samples) in which 
a mean (or pair of means) appears in the numerator and an 
estimate of the numerator's standard deviation appears in 
the denominator. The latter estimate is based on the 
calculated s square or s squares of the samples. If these 
calculations yield a value of (t) that is sufficiently different 
from zero, the test is considered to be statistically significant.  

Mean Absolute 
Deviation 

A measure of variation, which calculates the average distance 
a data value is from the mean. 

Percentile (25 & 75) Percentiles are values that divide a sample of data into one 
hundred groups containing (as far as possible) equal numbers 
of observations. For example, 25% of the data values lie 
below the 25th percentile. 

Median  The middle of a distribution: half the values are above the 
median and half are below the median. 

Inter Quartile Range The difference between the 75th percentile and the 25th 
percentile. 
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Statistic Description 

Confidence Intervals  A confidence interval gives an estimated range of values that 
is likely to include an unknown population parameter, the 
estimated range being calculated from a given set of sample 
data. If independent samples are taken repeatedly from the 
same population, and a confidence interval calculated for 
each sample, then a certain percentage (confidence level) of 
the intervals includes the unknown population parameter. 
Remark Classic OMR calculates Confidence Intervals of 1%, 
5%, 95% and 99%. 

 
The following table summarizes the Item Statistics Report Properties (accessible by 
clicking Tools|Report Properties): 
 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Row Shading Sets whether to shade every other row in the 
chart. 

 Item Label Sets what to display to identify each question 
on the report: Auto Number (sequential 
numbers), Question Name, Item Number (item 
number as it appears in the order of the test) 
or Question Text. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 
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Report 
Section 

Report 
Property 

Description 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Display 
Statistics 

Confidence 
Intervals  

Sets whether to display the Confidence Interval 
section of the report, which includes 1, 5, 95 
and 99% confidence intervals. 

 Percentiles Sets whether to display the Percentiles section 
of the report, which includes 25th and 75th 
percentile, interquartile range and median 
score. 

 Descriptive 
Statistics 

Sets whether to display the Statistics section of 
the report, which includes skewness, kurtosis, t 
value and mean absolute deviation. 

 Values Sets whether to display the Values section of 
the report, which includes minimum, maximum 
and range. 

 Summary 
Statistics 

Sets whether to display the Summary Statistics 
section of the report, which includes mean, 
variance, standard deviation and standard 
error. 

 Question Sets whether to display the Question section of 
the report, which includes the question name, 
sample size and number missing. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

3.3.6 Report 208 - Crosstabulation Report 
The Crosstabulation report generates a table displaying the number of cases falling into 
each combination of the categories of two or more categorical variables. Crosstabulation 
is a method of examining the relationships among variables that are at the nominal or 
ordinal level. The categories of one variable are listed in the rows and of a second 
variable in the columns. You choose specific questions from your data to use in the 
crosstabulation. The frequencies displayed in the Crosstabulation report can be totals or 
percents. Please note questions that allow more than one response cannot be used for 
crosstabulations. The following table summarizes the Crosstabulation Report Properties 
(accessible by clicking Tools|Report Properties): 
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Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Remove Empty Sets whether to remove columns/rows that 
contain empty responses. 

 Table Title Sets the title for each crosstabulation table. 

 Bold Table 
Headers 

Sets whether to put the table header in bold 
formatted font. 

 Percentages Sets whether to display the frequencies for 
each crosstabulation in raw numbers or 
percentages.  

 Page Break Sets whether to insert a page break after each 
crosstabulation table. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 
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Report 
Section 

Report 
Property 

Description 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

 

To run a Crosstabulation Report 
1 In the Remark Quick Stats Task Pane, 

select the link for Crosstabulation Report. 
2 In the Crosstabulation Question 

Selection window, select the question(s) 
you wish to include in the report. Place the 
row question to be analyzed in the Rows 
box and the column question to be analyzed 
in the Columns box. Use the Add button 

, to move the questions to the selected 
window. 

Note: You may select multiple questions 
by holding down the Ctrl key and 
clicking the questions or you may choose 
a range of questions by selecting the first 
question, then holding down the Shift key and selecting the last question. 

3 Click the OK button to run the report. 

3.3.7 Report 209 - Comparative Item Report 
The Comparative Item Report allows you to see tabulation results broken down by 
specific criteria. You select questions from the data on which to base the report. For 
example, this report is especially useful for comparing demographic groups. If your 
respondents mark a category such as gender on their survey form, you can view the 
data by gender. You may choose up to three questions from the data set on which to 
base the report. The following options are available for the Comparative Item Report: 

 

Option Description 

Legend Displays the criteria used to generate the report. 

Report Criteria Displays the questions selected to generate the report. 
Taking the report down to the student level is optional 
(check this setting under Tools|Report Properties). 

Respondents Displays the number of respondents that fall into each 
selected category.  

Mean Displays the mean response for each item group. 
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Option Description 

Benchmark Displays the benchmark value entered for the question in 
the Survey Wizard, if applicable. This is the expected value 
for the question, based on the values entered for each data 
label in the form template.  

Benchmark Difference If a benchmark value was defined in the Survey Wizard, 
this setting displays the difference between the responses 
and the established benchmark, as well as a bar chart 
showing the relationship between the defined benchmark 
and the responses. The vertical blue line depicts the 
benchmark. If the bar charts are green, responses are 
higher than the benchmark. If bar charts are red, 
responses are lower than the benchmark. The bar charts 
can be customized in the report's properties (Tools|Report 
Properties). 

  

The following table summarizes the Comparative Item Report Properties (accessible by 
clicking Tools|Report Properties): 
 
Report 
Section 

Report 
Property 

Description 

Report Header Display Legend Sets whether to display the report legend at 
the top of each page. The legend shows the 
criteria that were used to generate the report. 

 Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header 
you have defined. This setting allows you to 
define a custom header yet choose not to 
display it without having to completely remove 
it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Table Header Sets what to display above each table to 
identify it: Question Name or Question Text. 
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Report 
Section 

Report 
Property 

Description 

 Display Group 
Labels 

Sets whether to display the group label for 
each criterion selected on the report. The 
Group Label appears above each criterion and 
helps explain what is being displayed. You 
typically want to display either the Legend or 
the Group Labels. 

 Background 
Color 

Sets the background color of the table within 
the report. 

 Row Borders Sets whether to display borders around each 
row of information. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of 
two decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

 Value Bar Layout Sets the look of the Value Bar, which is the 
bar chart that tracks student grade 
percentages. (See Chapter 4 Preferences and 
Properties for more details.) 

Group Color 
Code 

Item Label Sets the text color for each item (question 
from the data set) listed on the report. 

 Group 3 Color Sets the text color for the third group of 
criteria listed on the report. 

 Group 2 Color Sets the text color for the second group of 
criteria listed on the report 

 Group 1 Color Sets the text color for the first group of 
criteria listed on the report. 

Summary 
Information 

Display 
Respondents 

Sets whether to display the Respondents 
column of the report, which shows the number 
of respondents falling into each category. 

 Display Mean Sets whether to display the question mean 
within the report. 
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Report 
Section 

Report 
Property 

Description 

 Display 
Benchmark 
Difference 

Sets whether to display the benchmark 
difference value within the report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of 
the report. 

 Right Sets the footer text at the bottom right of the 
report. 

 

To run a Comparative Item Report 
1 In the Remark Quick Stats Task Pane, select 

the link for Comparative Item Report. 
2 In the Comparative Report Question 

Selection window, select the question(s) you 
wish to include in the report. Double click 

questions or use the Add button , to 
move the questions to the selected window. 

Note: You may select multiple questions by 
holding down the Ctrl key and clicking the 
question or you may choose a range of 
questions by selecting the first question, 
then holding down the Shift key and 
selecting the last question. 

3 Click the OK button to run the report. 

3.3.8 Report 210 - Question Mean Report 
The Question Mean report displays each tabulated question along with its defined 
minimum value, defined maximum value, mean and benchmark difference, if applicable. 
The following options are available for the Question Mean Report: 

 

Option Description 

Question Displays the question text identifying each tabulated 
question, as defined in the form template or Survey 
Wizard. You may optionally show the Question Name, 
Question Order or Question Number (select 
Tools|Properties to change this setting). 

Minimum Displays the minimum response value, as defined in the 
form template. Each answer choice is assigned a value 
when the form template is set up. These values are used to 
calculate statistics, such as means. 



 Tabulating Surveys  

99 
 

Option Description 

Maximum Displays the maximum response value, as defined in the 
form template. Each answer choice is assigned a value 
when the form template is set up. These values are used to 
calculate statistics, such as means. 

Mean Displays the mean (average) response for each question, 
based on the values assigned to the response choices in 
the form template. 

Benchmark Displays the benchmark value entered for the question in 
the Survey Wizard, if applicable. This is the expected value 
for the question, based on the values entered for each 
response choice in the form template.  

Bar chart Displays a bar chart representing the mean calculation. If a 
benchmark value was defined in the Survey Wizard, the 
bar chart displays a blue line at the benchmark. If the 
mean is below the benchmark, the shading within the bar 
is red. If the mean is above the benchmark, the shading 
within the bar is green. The bar chart can be customized in 
report's properties (Tools|Report Properties). 

 
The following table summarizes the Question Mean Report Properties (accessible by 
clicking Tools|Report Properties): 
 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks student grade percentages. 
(See Chapter 4 Preferences and Properties for 
more details.) 
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Report 
Section 

Report 
Property 

Description 

 Question Display Sets what to use to display the questions: 
Question Name, Question Text, Question Order 
or Question Number (item number as it 
appears in the order of the test). 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Page Break Sets whether to insert a page break after each 
analysis group. 

 Font Sets the font type used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Summary 
Information 

Display Minimum Sets whether to display the minimum question 
value as defined in the form template. 

 Display 
Maximum 

Sets whether to display the maximum question 
value as defined in the form template. 

 Display Mean Sets whether to display the mean for the 
question. 

 Display 
Benchmark  

Sets whether to display the benchmark for the 
question. Benchmarks are the expected values 
for the questions and are defined in the Survey 
Wizard. When used, the bar chart is also 
updated with red shading when responses do 
not meet the expected benchmark and green 
shading when responses meet or exceed the 
expected benchmark. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 
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3.3.9 Report 211 - Analysis Group Report 
The Analysis Group report analyzes questions that are placed in groups using the Survey 
Wizard. In the Survey Wizard, you may create groups of questions to be analyzed 
together in addition to the overall form. Analysis groups allow you to create subsets of 
questions, view the responses and view a mean for the entire group. You may also 
optionally assign varying weights to questions 
within an analysis group to emphasize the 
importance of a question in your analysis. This 
type of analysis can be used when you have a 
section of questions on a survey that are all 
related and you would like to see the results 
grouped together. For example, suppose you are 
processing a customer satisfaction survey for a 
car dealership. You might have a group of 
questions about the sales staff, a group of 
questions about the service staff and a group of 
questions about the dealership as a whole. 
These groups of questions can be placed into 
analysis groups so that you can see both individual question performance and 
performance for questions belonging to the same overall classification. Or if you are 
processing course evaluations, you might want to analyze different subsets of questions 
together, such as those pertaining to the instructor, the grading methods, etc. 

The Analysis Group report displays the overall results first, followed by analysis of the 
groups that were defined in the Survey Wizard. You may optionally hide the overall 
results in the report properties (Tools|Report Properties). Within each table, you will see 
the question, mean and a bar chart of the mean. For the analysis groups, you will also 
see an overall mean for the group and the weights assigned to each question. The 
following options are available for the Question Mean Report: 

 

Option Description 

Question Displays the question text identifying each tabulated 
question, as defined in the form template or Survey 
Wizard. You may optionally show the Question Name, 
Question Order or Question Number (select 
Tools|Properties to change this setting). 

Group Benchmark Displays the benchmark value entered for the analysis 
group in the Survey Wizard, if applicable. This is the 
expected mean value for the group, based on the values 
entered for each response choice in the form template. 

Question Benchmark Displays the benchmark value entered for the question in 
the Survey Wizard, if applicable. This is the expected value 
for the question, based on the values entered for each 
response choice in the form template. 

Weight Displays the weight assigned to each question within the 
analysis group. By default, each question has a weight of 
one, but you may change this setting on a per question 
basis in the Survey Wizard. 
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Option Description 

Group Mean Displays the mean (average) response for each analysis 
group, based on the values assigned to the response 
choices in the form template. 

Question Mean Displays the mean (average) response for each question, 
based on the values assigned to the response choices in 
the form template. 

Bar chart Displays a bar chart representing the mean calculation. At 
the top of the report, the bar chart is for the analysis 
group. Within the table, the bar charts are for each 
individual question. If a benchmark value was defined in 
the Survey Wizard, the bar chart displays a blue line at the 
benchmark. If the mean is below the benchmark, the 
shading within the bar is red. If the mean is above the 
benchmark, the shading within the bar is green. The bar 
chart can be customized in report's properties 
(Tools|Report Properties). 

 

The following table summarizes the Analysis Group Report Properties (accessible by 
clicking Tools|Report Properties): 

 

Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Value Bar Layout Sets the look of the Value Bar, which is the bar 
chart that tracks student grade percentages. 
(See Chapter 4 Preferences and Properties for 
more details.) 
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Report 
Section 

Report 
Property 

Description 

 Display Overall Sets whether to display a summary of the 
overall results. This table appears first in the 
report, followed by analysis of the individual 
analysis groups. 

 Display 
Questions 

Sets whether to display each individual 
question within the analysis group. If this 
property is set to Hide, you only see the group 
name, mean and bar chart. 

 Question Display Sets what to use to display the questions: 
Question Name, Question Text, Question Order 
or Question Number (item number as it 
appears in the order of the test). 

 Page Break Sets whether to insert a page break after each 
analysis group. 

 Font Sets the font type used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Decimal Places Sets the number of decimal places to display 
for the statistics in the report (maximum of two 
decimal places). 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

3.3.10 Report 401 - Response Report by Item 
The Response Report by Item displays all answers given to a question or questions on 
the form. By default, any questions that are not graded or tabulated on the form can be 
included on the Response Report by Item. You can choose from all questions, regardless 
of whether they are graded or tabulated, by adjusting the report properties 
(Tools|Report Properties). This report is useful for displaying data from Input regions so 
that you can see how your respondents responded to write-in questions. For Input 
regions, you will see the text you entered into the data grid. The Response Report by 
Item is grouped by question (e.g., you will see the question and then the respondents' 
responses). You may choose whether to include an Analysis Respondent ID with the 
responses in the report properties (Tools|Report Properties). If there are no Analysis 
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Respondent ID questions in the form template or Survey Wizard file, the responses are 
sequentially numbered. The following table summarizes the Responses Report by Item 
Properties (accessible by clicking Tools|Report Properties): 

 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Sort Items Sets whether to sort the responses by 
Respondent ID or Response. (Unsorted is the 
default setting.) 

 Sort Order Sets whether to sort the responses (based on 
criteria above) in ascending or descending 
order. 

 Display All 
Questions  

Sets whether to include both graded/tabulated 
and non-graded/tabulated questions in the list 
of available questions for the report. This 
report is typically run with non-
graded/tabulated questions, such as comment 
areas on a survey. However, you may wish to 
also use graded or tabulated questions in the 
report. Setting this property to Yes shows all 
questions from the form template. 

 Respondent ID Sets whether to show questions identified as 
Analysis Respondent IDs in the report. Use of 
this feature links the response back to a 
respondent. If you use this feature but do not 
have any questions designated as Analysis 
Respondent IDs, each response is displayed 
with a sequential number. 

 Page Break Sets whether to insert a page break after each 
item. 
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Report 
Section 

Report 
Property 

Description 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Image Quality Sets the quality of the images displayed for 
each image clip response: Low, Medium or 
High. Note that displaying in high quality may 
add significantly to the amount of time it takes 
to run the report but yields the clearest results. 
Images in printed reports may clearer than on-
screen. (Applies to Remark Office OMR only.) 

 Question 
Identifier Label 

Sets the text to be used to identify each 
question on the report (e.g., Question: Do you 
have any additional comments?). 

 Data Font Size Sets of the size of the font used in the report. 

 Font Sets the font type used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

 

To run a Response Report by Item 
1 In the Remark Quick Stats Task Pane, 

select the link for Response Report by 
Item. 

2 In the Response Report Question 
Selection window, select the question(s) 
you wish to include in the report. Double 
click questions or use the Add button 

, to move the questions to the 
selected window. 

Note: You may select multiple 
questions by holding down the Ctrl key 
and clicking the questions or you may 
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choose a range of questions by selecting the first question, then holding 
down the Shift key and selecting the last question. 

3 Click the OK button to run the report. Responses for the selected questions appear, 
grouped by question. 

3.3.11 Report 402 - Response Report by Respondent 
The Response Report by Respondent displays respondents' answers to the questions on 
the form. By default, any questions that are not graded or tabulated on the form can be 
included on the Response Report by Respondent. You can choose from all questions, 
regardless of whether they are graded or tabulated, by adjusting the report properties 
(Tools|Report Properties). This report is useful for displaying data from Input regions so 
that you can see how your respondents responded to write-in questions. For Input 
regions, you will see the text you entered into the data grid. The Response Report by 
Respondent is grouped by respondent (e.g., you will see the respondent listed first and 
then that respondent's responses for all selected questions). You may choose whether to 
include an Analysis Respondent ID with the responses in the report properties 
(Tools|Report Properties). If there are no Analysis Respondent ID questions in the form 
template or Survey Wizard file, the responses are sequentially numbered. The following 
table summarizes the Responses Report by Respondent Properties (accessible by clicking 
Tools|Report Properties): 

 
Report 
Section 

Report 
Property 

Description 

Report Header Custom Report 
Title 

Sets the title of the report. 

 Title Text Color Sets the color of the title text. 

 Repeat Header Sets whether to put the report title on every 
report page or the first page only. 

 Header Layout Sets a custom header layout where you can 
insert text, statistics and graphics. (See 
Chapter 4 Preferences and Properties for more 
details.) 

 Display Custom 
Header 

Sets whether to display the custom header you 
have defined. This setting allows you to define 
a custom header yet choose not to display it 
without having to completely remove it.  

 Display Filter Sets whether to display the criteria used to 
filter the report, if you have applied a filter. 

Report Format Sort Items Sets whether to sort the responses by 
Respondent ID. (Unsorted is the default 
setting.) 

 Sort Order Sets whether to sort the responses (based on 
criteria above) in ascending or descending 
order. 
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Report 
Section 

Report 
Property 

Description 

 Display All 
Questions  

Sets whether to include both graded/tabulated 
and non-graded/tabulated questions in the list 
of available questions for the report. This 
report is typically run with non-
graded/tabulated questions, such as comment 
areas on a survey. However, you may wish to 
also use graded or tabulated questions in the 
report. Setting this property to Yes shows all 
questions from the form template. 

 Respondent ID Sets whether to show questions identified as 
Analysis Respondent IDs in the report. Use of 
this feature links the response back to a 
respondent. If you use this feature but do not 
have any questions designated as Analysis 
Respondent IDs, each response is displayed 
with a sequential number. 

 Page Break Sets whether to insert a page break after each 
item. 

 Row Shading Sets whether to shade every other row in the 
chart. 

 Image Quality Sets the quality of the images displayed for 
each item: Low, Medium or High. Note that 
displaying in high quality may add significantly 
to the amount of time it takes to run the 
report. Note that displaying in high quality may 
add significantly to the amount of time it takes 
to run the report but yields the clearest results. 
Images in printed reports may clearer than on-
screen. (Applies to Remark Office OMR only.) 

 Respondent 
Identifier Label 

Sets the text to be used to identify each 
respondent on the report (e.g., Respondent: 
John Doe). 

 Data Font Size Sets of the size of the font used in the report. 

 Page Size Sets the page size to A4, US Letter or US 
Legal. 

 Orientation Sets the overall report orientation: Landscape 
or Portrait. 

 Font Sets the font type used in the report. 

 Report Color Sets the overall report color. This color affects 
the header title, lines and borders used in the 
report. 

Report Footer Left  Sets the footer text at the bottom left of the 
report. 
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Report 
Section 

Report 
Property 

Description 

 Center Sets the footer text at the bottom center of the 
report. 

 Right Sets the footer text at the bottom right of the 
report. 

 

To run a Response Report by Respondent 
1 In the Remark Quick Stats Task Pane, 

select the link for Response Report by 
Respondent. 

2 In the Response Report Question 
Selection window, select the question(s) 
you wish to include in the report. Double 

click questions or use the Add button , 
to move the questions to the selected 
window. 

Note: You may select multiple 
questions by holding down the Ctrl key 
and clicking the questions or you may 
choose a range of questions by selecting the first question, then holding 
down the Shift key and selecting the last question. 

3 Click the OK button to run the report. Responses for the selected questions appear, 
grouped by respondent. 
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Preferences and Properties 
Chapter 4 

Remark Quick Stats allows you to customize the look and feel of the reports. The 
previous two chapters described each report and the properties associated with those 
reports. This chapter covers: 

• General reporting preferences (Section 4.1) 

• Custom report headers (Section 4.2) 

• Graph properties (Section 4.3) 

4.1 General Reporting Preferences 

Remark Quick Stats has a set of general preferences to help customize how you use the 
software. You can make running reports quicker and easier by setting up the general 
preferences to your liking.  

 

To access the preferences 
1 From within Remark Quick Stats, select the Tools menu and then click 

Preferences.  
2 Use the Task Pane in the left side of the Preferences window to access each 

preference category and make adjustments. 
3 Click the OK button to accept your changes. 

Continue to the next sections to understand each of the reporting preferences. 

4.1.1 General Preferences 
The General Preferences allow you to set whether to include missing values and NA (not 
applicable) responses in your analysis.  

Missing values are data that are not 
considered valid. In other words, missing 
values are any data that does not match 
what you defined in the form template. 
Examples of missing values include blank 
(BLANK) or multiple (MULT/ALL) responses, 
as well as text entries that do not match 
the labels defined in the form template 
(e.g., entering “very good” in the data 
when the label is defined as “Very Good”). 
If you include missing values in your 
reports, you see a separate line item that 
indicates how many missing values were 
encountered. If you do not include missing 
values in your reports, those responses are 
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not factored into the reports at all. If you do not wish to include the missing values, 
mark the checkbox for Exclude missing values from the item statistics.  

In the Remark Quick Stats preferences you can choose whether to include or exclude the 
NA responses. If a question on your form has a “Not Applicable” answer choice and you 
do not want the NA responses to be included in the Remark Quick Stats statistics (e.g., 
means), you have the option to choose the appropriate label from a NA Label drop-down 
list in the Survey Wizard. Then set the preference of whether to include or exclude the 
NA responses from the analysis. NA answers appear on select reports in a gray, italicized 
font (customizable in the report properties). When you choose the option for Report the 
number of NA choices bit do not include them in the statistics, you still see how 
many NA responses were chosen, but those answers are not factored into the statistics. 
If you do not mark the preference for Report the number of NA choices bit do not 
include them in the statistics, the NA answer choice is factored into the statistics.  

4.1.2 Report Display Preferences 
The Report Display Preferences allow you to customize the on-screen look of the reports. 
The following options are available: 

 

 

 

 

 

 

 

 

 

 

 

Option Description 

Background color Sets the background color for each report. This color 
is for display purposes only. 

Zoom Sets the zoom level for each report. 

Display ruler Sets whether to display a ruler across the top of each 
report. The ruler is for display purposes only. 

Display table of contents Sets whether to view a table of contents to assist with 
navigating the report. 
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Option Description 

Delimiter between multiple 
respondent IDs 

Sets the delimiter to use when you have designated 
multiple analysis respondent IDs for your reports. An 
analysis respondent ID is applied on a region basis in 
order to use the data from that region to identify the 
reports. Analysis respondent IDs can be set up in the 
form template or the Grade/Survey Wizard. The item 
selected here appears in between each analysis 
respondent ID (e.g., if using a comma as the delimiter 
and you have Last Name and First Name designated 
as analysis respondent IDs, it would look like: Doe, 
John). 

4.1.3 Default Report Preferences 
The Default Report Preferences allow you to set a default report to run when tabulating 
or grading. You may still run other reports, but whenever you launch Remark Quick 
Stats, the selected report displays automatically. The following options are available: 

 

 

 

 

 

 

 

 

 

 

 

Option Description 

Base reports directory Sets a directory in which the default reports are 
stored. In most cases, you want to leave this set to 
the location selected during the software’s installation. 

Survey Sets a default report to display when performing a 
survey operation. Use the drop-down list to select a 
report. If you wish to select a saved Report Batch 
Wizard configuration file, click the ellipsis (…) to locate 
it. 

Grade Sets a default report to display when performing a 
grade operation. Use the drop-down list to select a 
report. If you wish to select a saved Report Batch 
Wizard configuration file, click the ellipsis (…) to locate 
it. 
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4.1.4 Default Grading Benchmarks 
The Default Grading Benchmarks preference allows you to set default values for 
benchmarks when grading tests. Benchmarks 
indicate the minimum score required in order 
to be considered proficient (or to have 
mastered a topic). If you do not use 
benchmarks, or they change frequently, you 
should turn off the default settings. If you do 
want to standardize on default benchmark 
settings, you can set a default for the overall 
test, individual questions on the test and 
learning objectives. If you make changes to 
these settings in the Grade Wizard at the time 
of test grading, the Grade Wizard settings 
override the default settings for that grade 
operation. However, by setting defaults, you 
can take advantage of benchmarks even when 
using Easy Grade. To set a default benchmark, enable the appropriate checkbox and 
then put the percentage desired as the default.  

4.1.5 Overall Grade Scale Preferences 
The Overall Grade Scale Preferences allow you to select or define a grade scale to use 
when grading tests. The grade scale set in the preferences is used whenever you 
perform an Easy Grade operation. You can also import and export grade scales, allowing 
you to share custom grade scales with other Remark Quick Stats users. 

 

To select a grade scale 
1 Use the Default scale drop-down list to select the desired scale. You will see the 

selected scale in the grid below.  
2 Click the OK button. 
 

To create a new grade scale 
1 Type a name in the Name box. 
2 Enter the appropriate values for Grade and 

Percent (Min) in the grid. 
3 Click the Save button. The new grade scale 

automatically becomes the default and is 
now available in the Default scale list. 

 

To delete a grade scale 
1 Select a scale from the Default scale drop-

down list. 
2 Click the Delete button. 
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To export a grade scale 
1 Select a grade scale from the Default scale 

drop-down list. 
2 Click the Export… button. 
3 Enter a file name for the scale and choose a 

location in which to save it. The file type is 
Grade Scale (.rgsx). The default location 
is the Analysis Definitions folder in your 
Remark Classic OMR 4 installation folder. 
However, you may choose any location, 
including network and external locations. 

4 Click the Save button. You may now import 
the grade scale into another instance of 
Remark Quick Stats. 

 

To import a grade scale 
1 From the Overall grade scales link of the 

Remark Quick Stats Preferences, click the 
Import… button. 

2 Choose the scale you wish to import. The 
default location is the Analysis Definitions 
folder in your Remark Classic OMR 4 
installation folder. However, you may 
choose any location, including network and 
external locations. 

3 Click the Open button. If the grade scale 
does not already exist, it is imported. If the 
grade scale already exists on your system, 
you are prompted to overwrite the existing grade scale. 

Once the grade scale is imported, you can access it from the Remark Quick Stats 
Preferences and the Grade Wizard. 

4.1.6 Learning Objectives Grade Scale Preferences 
The Learning Objectives Grade Scale Preferences allow you to select or define a grade 
scale to use for the learning objectives when grading tests. Learning objectives 
represent a subset of questions that test a specific knowledge area. The learning 
objectives are graded in addition to the overall test. You may define one grade scale to 
be used for all defined learning objectives. You can also import and export learning 
objectives grade scales, allowing you to share custom grade scales with other Remark 
Quick Stats users. 

 

To select a grade scale 
1 Use the Default scale drop-down list to select the desired scale. You will see the 

selected scale in the grid below. 
2 Click the OK button. 
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To create a new grade scale 
1 Type a name in the Name box.  
2 Enter the appropriate values for Grade and 

Percent (Min) the grid. 
3 Click the Save button. The new grade scale 

automatically becomes the default and is 
now available in the Default scale list. 

 

To delete a grade scale 
1 Select a scale from the Default scale drop-

down list. 
2 Click the Delete button. 
 

To export a grade scale 
1 Select a grade scale from the Default scale 

drop-down list. 
2 Click the Export… button. 
3 Enter a file name for the scale and choose a 

location in which to save it. The file type is 
Grade Scale (.rgsx). The default location 
is the Analysis Definitions folder in your 
Remark Classic OMR 4 installation folder. 
However, you may choose any location, 
including network and external locations. 

4 Click the Save button. You may now import 
the grade scale into another instance of 
Remark Quick Stats. 

 

To import a grade scale 
1 From the Learning objectives grade 

scales link of the Remark Quick Stats 
Preferences, click the Import… button. 

2 Choose the scale you wish to import. The 
default location is the Analysis Definitions 
folder in your Remark Classic OMR 4 
installation folder. However, you may 
choose any location, including network and 
external locations. 

3 Click the Open button. If the grade scale 
does not already exist, it is imported. If the 
grade scale already exists on your system, 
you are prompted to overwrite the existing grade scale. 

Once the grade scale is imported, you can access it from the Remark Quick Stats 
Preferences and the Grade Wizard. 
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4.1.7 Overall Scaled Score and Learning Objectives Scaled Score 
A scaled score converts a student's score on a test to a common scale that allows for a 
numeric comparison among students. Scaled scores are considered an advanced feature 
targeted to specific use cases where a specific test grade is needed from an external 
grading system. A scaled score allows you to use a database to translate a student's 
score on a test from a standard raw or percent score into another scale, as defined in 
the translation file (database). To use a scaled score, you can look up the overall score, 
objective score, subjective score or defined learning objective scores. Two values can be 
selected to perform a two dimensional look up. The value taken from Remark is looked 
up in your translation (scaled score) table, and the appropriate scaled score is returned. 
When looking up the scaled score, it looks for a record in the table where the lookup 
value (percent score, total score or percentile) is contained within the defined range of 
values.  

The database file containing your scaled scores can be one of: Access, Excel, SQL 
Server, Oracle, Paradox, dBase or an ODBC connection. Within this database you define 
a minimum score field and maximum score field, which can be exact numbers or a range 
of scores. Each score in the database has a corresponding scaled score field, which is 
what is returned to Remark Quick Stats. You can optionally include a scaled grade field, 
which replaces the Remark-calculated grade on select reports. You can define the 
minimum and maximum fields to be the same field in the database, in which case the 
lookup value would have to exactly match the value in the field for the scaled score to 
be returned. If the scaled score cannot be found, then the reports display a dash (-). 

There is also a precision option that allows you to round the lookup score to a user 
defined number of decimal places before performing the database lookup. If rounding is 
used, Remark Quick Stats rounds up or down to whole numbers using traditional 
rounding methods. For example, if the score is 69.5, it is rounded to 70, which is the 
value looked up in the database. 

The following reports display the scaled scores: Student Statistics Report, Student Grade 
Report, Comparative Grade Report, Demographic Grade Report and Student Response 
Report. Each report has a property (Tools|Report Properties) that can be set as to 
whether or not to display a scaled score (the property is on by default). The heading for 
scaled score in the report is taken directly from the column header name in your lookup 
database. It is recommended that you keep this name short in order for the best 
appearance on the reports. 

Scaled scores can be defined in the Grade Wizard and set as defaults in the Remark 
Quick Stats Preferences so that they can be used with an Easy Grade operation. The 
following instructions can be used for both Overall Scaled Scores and Learning 
Objectives Scaled Scores. 

Note: When using the Grade Wizard, the scaled score only displays if the 
option is on AND the Scaled Score lookup is defined. When using Easy 
Grade, the default Scaled Score in the Remark Quick Stats Preferences is 
used as long as it applies to the active form template. If you do not want to 
use Scaled Scoring during Easy Grade operations, do not set a default 
Scaled Score in the Remark Quick Stats Preferences. 
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To export a scaled score 
1 From the Overall scaled score (or Learning objectives scaled score) link of the 

Remark Quick Stats Preferences, select 
a grade scale from the Default scale 
drop-down list. 

2 Click the Export… button. 
3 Enter a file name for the scale and 

choose a location in which to save it. 
The file type is Scaled Score (.rssx). 
The default location is the Analysis 
Definitions folder in your Remark 
Classic OMR 4 installation folder. 
However, you may choose any location, 
including network and external locations. 

4 Click the Save button. You may now 
import the scaled score into another 
instance of Remark Quick Stats. 

 

To import a scaled score 
1 From the Overall scaled score (or 

Learning objectives scaled score) 
link of the Remark Quick Stats 
Preferences, click the Import… button. 

2 Choose the scaled score file you wish to 
import. The default location is the 
Analysis Definitions folder in your 
Remark Classic OMR 4 installation 
folder. However, you may choose any 
location, including network and external 
locations. 

3 Click the Open button. If the scaled 
score does not already exist, it is 
imported. If the scaled score already 
exists on your system, you are prompted to overwrite the existing scaled score. 

Once the scaled score is imported, you can access it from the Remark Quick Stats 
Preferences and the Grade Wizard. 

 

To set up a scaled score 
1 From the Overall scaled score (or 

Learning objectives scaled score) 
link in the Preferences Task Pane, if you 
have created a scaled score previously, 
you may select it from the Default 
scaled score drop-down list.  

2 Optionally, you may create a new scaled 
score by typing a name in the Scaled 
score name box. 
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3 In the Scaled score based on area, choose the score type to look up: Total Score, 
Percent Score or Percentile. This score is the type of score that is used to look up 
a corresponding score in the external file. 

4 Optionally, if you wish to round the scores, mark the checkbox for Round to: and 
put in the number of decimal places desired. If this option is used, the lookup score 
is rounded first, then the lookup takes place based on the rounded score. 

5 Using the Primary Lookup criteria drop-down list, choose the specific score you 
wish to look up: Overall Score, Objective Score, Subjective Score or any 
learning objectives you have defined.  This property tells Remark Quick Stats the 
actual score or scores to look up when finding the scaled score. Note: If you are 
basing the look up on the Percentile, you may only look up the Overall Score and/or 
learning objective scores. 

6 [Optional] If you would like to create a two dimensional look up, choose a secondary 
look up criteria from the Secondary lookup criteria drop-down list. For example, 
you may want to look up both an objective and subjective score to generate an 
overall scaled score. 

7 Click the Database… button to choose (or modify) the connection to an external 
database file. 

8 In the Database Selection area, use the Type drop-down list to select the type of 
database to which you want to connect this region (e.g., Access, Excel, etc.). 

9 Click the Browse… button to locate and select the database file. 
10 Select a file and then click the Open button (or double click the file name). 

If using an ODBC connection, perform the Steps 11-13 (you need to obtain specific 
information from your database administrator to complete these steps). Otherwise, skip 
to Step 14. 

 

11 OPTIONAL: Select your database type from the DSN drop-down list. 
12 OPTIONAL: Select the appropriate checkbox to indicate whether your database is 

Directory or DSN based: Directory based or DSN based. 
13 OPTIONAL: If your database utilizes password protection, use the Username and 

Password boxes to enter your login information. If the database is not password 
protected, you may skip this step. 
 

14 In the Lookup & Return section, click the Connect to Database button to link the 
database to the region (note that Remark Quick Stats tries to establish the 
connection for you for non-password protected databases). 

15 Use the Scaled score table drop-down list to select the table in the database 
containing the fields with the scaled scores (note that Remark Quick Stats chooses 
the first table/sheet in the file by default). 

16 Then choose the Primary minimum score, Primary maximum score, Scaled 
score and optionally Scaled Score grade fields from the external database. The 
optional Scaled score grade field replaces Remark-generated grades with the 
scaled grade from the database on select reports that show a grade (e.g., A, B, C…). 
These fields contain the values to look up and replace. The items available depend on 
your choice of lookup items: Overall Score, Objective Score, Subjective Score, 
Objective and Subjective Score or Learning Objectives. 
Here are some guidelines you can using when selecting the lookup and replace 
fields: 
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• To look up a one dimensional overall, objective 
or subjective score where there is a one to one 
relationship (e.g., a score of 85 equals a scaled 
score of 95), choose the same field for the 
Primary minimum and Primary maximum 
score fields. 

• To look up a one dimensional overall, objective 
or subjective score that uses a range of scores 
(e.g., a score of 85 to 90 equals a scaled score 
of 95), select different fields for the Primary 
minimum and Primary maximum score 
fields. 

• To look up a two dimensional score of objective 
and subjective score where there is a one to 
one relationship (e.g., an objective score of 85 
and a subjective score of 10 equals a scaled 
score of 110), choose the same field for the Primary minimum and Primary 
maximum score fields. Then choose the same field for the Secondary 
minimum and Secondary maximum score fields (but different from the 
objective fields). For example, the Primary minimum and Primary maximum 
score fields would be your objective scores, and the Secondary minimum and 
Secondary maximum score fields would be your subjective scores. 

• To look up a two dimensional score of objective and subjective scores where 
there is a range of scores (e.g., an objective score of 85-90 and a subjective 
score of 5-10 equals a scaled score of 110), choose different Primary minimum 
and Primary maximum score fields. Then choose different Secondary 
minimum and Secondary maximum score fields. For example, the Primary 
minimum and Primary maximum score fields would be your range of objective 
scores, and the Secondary minimum and Secondary maximum score fields 
would be your range of subjective scores. 

17 Choose the field in the database that contains the corresponding scaled score using 
the Scaled score field drop-down list. 

18 [Optional] Choose the field in the data that contains the corresponding scaled score 
grade in using the Scaled score grade field drop-down list. On reports that show a 
grade, this value displays when scaled scoring is in use. You may use the Clear 
button to remove this option if you change your mind. 

19 Click the OK button to save the database settings. 
20 When you return to the overall scaled score window, you will see the details of your 

database connection listed. If you need to make modifications, click the Database… 
button. 

21 Click the OK button to save your changes. 

The new scaled score is now your default overall scaled score and is used for all Easy 
Grade operations going forward. It can also be selected in the Grade Wizard. If you do 
not wish to use a scaled score at a future point, change the Default scaled scores 
drop-down list to None. 
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4.1.8 Decimal Places 
The Decimal Places Preferences allow you to 
set the number of decimal places used to 
calculate statistics for various parts of the 
reports. The maximum number of decimal 
places that can be set is four. You may set the 
decimal places for the following reporting 
attributes: points awarded, grade scale, data 
export, benchmark and weight (i.e., analysis 
group weights). Please note that the maximum 
number of decimal places displayed on any 
report is 2; however, if you set the preferences 
to a higher number, the higher number is used 
in calculations, giving you more precise 
calculations. 

4.1.9 Data and Results Export 
When exporting numeric or textual data with results, the date file that Remark Quick 
Stats creates contains the raw data from the form as well as the statistics calculated for 
the test. In this section you can tell Remark Quick Stats which statistics to include in the 
file. The following options are available: 

 

• Data 

• Respondent ID 

• Deviation IQ 

• ETS Score 

• Grade 

• Number Correct 

• Number Incorrect 

• Number Missing  

• Objective Score 

• Percentile 

• Percent Score 

• Subjective Score 

• Total Score 

• T Score 

• Z Score 

• Scaled Score 
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4.1.10 Test Statistics 
The Test Statistics Preference allows you to 
choose between two accepted methods of 
calculating the variance statistic. This preference 
allows you to use N (actual number of tests), or 
(N-1) as the denominator of the calculation. 
Choose the desired value and then click OK to 
rerun the active report. 

4.1.11 Importing and Exporting 
Report Preferences 
Remark Quick Stats allows you to import and export reporting preferences from one 
installation of Remark Classic OMR to another. This feature allows you to share common 
settings so that the resulting reports maintain a consistent look and feel. Please note 
that grade scales are not part of this import/export process. They must be imported and 
exported separately, which is covered in sections 4.1.5 – 4.1.8. 

Important Note! You must have multiple licenses of the software to install 
it on multiple machines. The importing and exporting of reporting 
preferences for use on multiple systems should only be used when adequate 
licensing is in place. 

 

To export report preferences 
1 Select the Tools menu and then click Export 

Preferences.  
2 In the Export Preferences window, select a 

location in which to store the file using the 
Save in drop-down list. You may wish to 
select a location on your network where other 
users can access the file. 

3 Enter a name for the file in the File name 
box. The file is automatically stored with a .ini 
extension. 

4 Click the Save button to save the file. 
 

To import report preferences 
1 Select the Tools menu and then click Import 

Preferences. 
2 In the Import Preferences window, select 

the location in which the file containing the 
preferences you wish to import is located 
using the Look in drop-down list. 

3 Select the .ini file containing the preferences. 
4 Click the Open button to open the file. 

Once the file is imported, the Preferences settings 
are updated with those from the imported file. 
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4.2 Report Header Properties 

Each report has a report header that can be customized. Chapters 2 and 3 described the 
report properties that allow you to customize the report title. In addition to the title, you 
may add up to nine custom fields to each report. These fields can include text, graphics 
or additional statistics (depending on the report). The header is customized via each 
report's properties. 

Note: Report headers can also be defined using the Grade Wizard and 
Survey Wizard. You create the report headers as described below. However, 
they are attached to the Grade Wizard or Survey Wizard file that you save 
so that they are applied every time you use that Grade Wizard answer key 
or Survey Wizard survey definition file. Report headers defined using the 
Grade or Survey Wizards override individually defined report headers. 

 

To access the custom report header 
1 Run the report you wish to customize.  

2 Select the Tools menu and then click Report Properties, or click . 

Note: Optionally, you may go right to the report properties and select a 
report to customize without first running a report. 

3 In the Report Header Options section, click in the box for Header Layout. 
4 An ellipsis (…) appears in the right corner of the box. Click the ellipsis to access the 

Report Header Layout window. 

When the Report Header Layout window appears, you will see a representation of the 
report. There are nine fields that can be customized. The active field is highlighted in 
yellow. Click in a field to select and customize it. You can use the Page Width setting 
on the report to zoom in and out for better viewing. 
 

To customize fields 
1 Choose the number of columns for your report header under the Columns section: 

One, Two or Three. The number of columns determines how many fields you can 
customize (between three and nine). 

2 Click one of the fields to customize.  
3 Determine whether you want to insert text or an image in your first field. Choose the 

radio button for Text or Image. 
4 If inserting text, enter a label for the field in the Label box. This label is free text. 
5 If desired, move to the Value drop-down list and select a value to insert. The default 

choices are Image, Date, 
Date/Time and Page Number. In 
addition, you may select a region 
from the form template that you used 
to generate this report. This feature is 
designed for reports that generate 
individual pages per respondent (e.g., 
Student Grade Report, Response 
Report by Respondent). The data 
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from the selected region appear in the report header that you define.  
6 In the Alignment section, choose an alignment for your item: Left, Center or 

Right. The inserted item is aligned accordingly within the space allotted on the 
report. 

7 If inserting an image, click the Browse… to locate an image to include on the report 
(e.g. a company logo). The following 
image types are supported: .bmp 
(Bitmap), .gif (GIF), .jpg (JPEG), .wmf 
(Windows Meta File), .ico (Icon), .cur 
(Cursor).  

Tip: If you need to align your 
image left, center or right, choose 
the appropriate field in the desired 
position before inserting the image. 

8 Repeat the steps above to insert any 
additional custom header information. 

Tip: If you need to reset the entire 
custom header back to its original state, click the Reset button. If you want 
remove an image, click in its field and click the Clear button. If you want to 
remove a text field, click in its field, delete the Label and change the Value 
to the first blank entry in the drop-down list. 

9 Once your header is complete, click the OK button to return to the report properties 
window. 

10 Click the OK button to close the report properties window.  

Depending on the report, you may need to re-run the report to see the new header. The 
customized report header remains in place until you change it or override it with one 
created in the Grade or Survey Wizard. 

4.3 Graph Properties 

The following reports include graphs: Class Frequency Distribution, Detailed Item 
Analysis and Item Analysis Graph Report. The graphs on these reports can be 
customized on a per-report basis. 

 

To access graph properties 
1 Run the report you wish to customize.  
2 Select the Tools menu and then click Report 

Properties, or click . 

Note: Optionally, you may go right to the report 
properties and select a report to customize 
without first running a report. 

3 In the Report Graph Options section, click in the 
box for Graph Properties. 

4 An ellipsis (…) appears in the right corner of the box. 
Click the ellipsis to access the Graph Properties 
window. 



Remark Quick Stats User's Guide 

124 
 

5 Make the desired changes (see below) and then click the OK button. 

The Graph Properties window has three sections that can be configured: Titles, 
Appearance and Axes. The final section is Preview, where you can preview your 
graph settings. To view or modify an item, click its name. The following sections 
describe each of the options in greater detail. 

4.3.1 Titles  
The Titles section allows you to customize graph titles. The following options are 
available: 

 

 

 

 

 

 

 

Property Description  

Graph title Sets a title to display for the overall graph. This title appears at the 
top of the graph. 

Bottom title Sets a title to display beneath the graph. You could use this title to 
name your X axis. 

Left title Sets a title to display to the left side of the graph. You could use this 
title to name your Y axis. You can choose an orientation from the 
Orientation drop-down list. 

Right title Sets a title to display to the right of the graph. You can choose an 
orientation from the Orientation drop-down list. 
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4.3.2 Appearance 
The Appearance section allows you to customize the appearance of the graph, including 
graph type, style, colors, etc. The following options are available: 

 

 

 

 

 

 

 

 

Section Property Description  

Style Graph type Sets the type of graph to be used: Pie, Bar, Line, Area, 
Scatter, Polar, Tape, Log (there are various types of each). 

Style Graph style Sets the style for the graph, based on the graph type. 

Colors Colors Sets all of the colors and styles to be used in the graph, 
including titles, background, foreground, axes, lines, etc. 
The options vary based on the type of graph being 
displayed. 

Fonts Fonts Sets the font attributes for the Graph Title, Other Titles, 
Labels and Legend portions of the graph. You may set the 
font name, size, scale and style. 

3D 3D 
Graphing 

Sets whether to display the graph in 3D mode and then 
allows you to set the corresponding attributes. 
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4.3.3 Axes 
The Axes section allows you to customize the X, Y and Z-axes of the graph. The 
following options are available: 

 

 

 

 

 

 

 

 

Section Property Description  

X-Axis, 
Y-Axis 

Various Sets various properties pertaining to the X and Y-axes of 
the graph, including Position, Grid style, Scale, Tick Marks 
and Labels. 

Z-Axis Various Sets the Scale and Label properties for the Z-axis of the 
graph. 

4.3.4 Preview 
The Preview section allows you to preview the modifications you have made to your 
graph. Note that the graphs in the preview window may be smaller or larger than they 
appear on the actual report. 
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4.3.5 Value Bar Layout  
Reports that display a value bar (horizontal bar chart) can have the value bar modified. 

 

To access graph properties 
1 Run the report you wish to customize.  
2 Select the Tools menu and then click Report 

Properties, or click . 

Note: Optionally, you may go right to the report 
properties and select a report to customize 
without first running a report. 

3 In the Report Format Options section, click in 
the box for Value Bar Layout. 

4 An ellipsis (…) appears in the right corner of the 
box. Click the ellipsis to access the Value Bar 
Properties window. 

5 Make the desired changes (see below) and then 
click the OK button.  

 

The following properties may be set in the Value 
Bar Properties window (note that some properties 
only apply to grading OR survey tabulation, but not 
both): 

 

Property Description  

Display Value Bar  Mark the Display Value Bar checkbox to show the value bar 
on the report.  

Scale  Select whether you want the scale to appear on the inside or 
outside of the value bar. Then select the unit of measure for 
the scale (e.g., percent). If you do not wish to show the 
scale, mark "None."  

Line Color  Select a color to use for the vertical line on the value bar that 
displays benchmark scores.  

Background Color  Select the background color (frame) for the value bar.  

Fill Pattern  For each of the benchmark options (Benchmark Value Met, 
Benchmark Value Not Met, No Benchmark), choose a fill 
pattern for the value bar.  

Color  For each of the benchmark options (Benchmark Value Met, 
Benchmark Value Not Met, No Benchmark), choose a color for 
the value bar.  
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Working with Your Report Data 
Chapter 5 

Remark Quick Stats allows several options for working with your report data to create 
more customized and detailed reports. The following topics are covered in this chapter: 

• Sorting data (Section 5.1) 

• Filtering data (Section 5.2) 

• Printing reports (Section 5.3) 

• Saving and exporting reports and report data (Sections 5.4/5.5) 

• Emailing reports (Section 5.6) 

• Report Batch Wizard (Section 5.7) 

• Opening reports (Section 5.8) 

• Screen captures (Section 5.9) 

5.1 Sorting Data 

When viewing textual data in the Data portion of Remark Quick Stats, you can sort the 
data to gain better understanding of the data. You may only sort data when you are 
viewing it as textual data. Note that when you run the reports, the way the data is 
sorted in the data grid is not reflected in the reports. The sorted data is for viewing 
purposes and is exported in the sorted order should you choose to export your data. 

 

To sort data using the menus 
1 Ensure that you are in the Data view of 

Remark Quick Stats by clicking the Data tab 
of the Task Pane. 

2 Select the Edit menu and then click Sort. 
3 In the Sort by box, use the drop-down list to 

choose a question on which to base the sort 
operation.  

4 Mark the checkbox for Descending if you want 
the data to be sorted in descending order. Leave 
this checkbox blank to sort the data in ascending 
order. 

5 If you want to sort the data by more than one 
criterion, select the appropriate questions on 
which to sort in the And then by boxes.    

6 When finished selecting questions, click the OK button. 
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To sort data using the toolbar 
1 Ensure that you are in the Data view of Remark Quick Stats by clicking the Data 

tab of the Task Pane. 
2 Select the column in the data grid you wish to use to sort the data. 
3 Click the Sort Ascending toolbar button to sort the data in ascending order based 

on the column selected: . Or, click the Sort Descending toolbar button to sort 

the data in descending order based on the column selected: . 

The entire data set is sorted according to your selection(s). 

5.2 Filtering Data 

Filters can be applied to a data set in order to examine the data more closely. A filter 
allows you to perform selective analysis by including or excluding respondents based 
upon their answers to particular questions. For example, if you have a gender question 
on a survey, you can use a filter to run a report based on only male responses.  

Note: This section discusses filtering using the Filter window, where you can 
create complex filters in order to get a closer look at your data. However, if 
you wish to use the auto filter feature that automatically generates reports 
based on when a value changes in a region, please see Section 5.7, The 
Report Batch Wizard. 

The following table summarizes the filter options: 

 

Option Meaning 

Records 
Remaining 

Shows the number of respondents from the data set that fit into the 
filter you are building. This number updates dynamically as you 
build your filter.  

Fields Allows you to choose fields from which the comparison is drawn. 

Operators Allows you to choose the operators that apply to the comparison 
(e.g., equal to, not equal to, greater than, etc.). 

Value Allows you to choose the answer value to which the Operator 
applies. 

And Allows you to add a filter to an existing filter to narrow the lookup. 
Choosing And before adding a parameter to your filter indicates 
that both cases must be true in order for the data to be included in 
the filter. 

Or Allows you to add a filter to an existing filter to narrow the lookup. 
Choosing Or before adding a parameter to your filter indicates that 
either case must be true in order for the data to be included in the 
filter. 

Clear Resets the current filter to blank values. 
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Option Meaning 

Group Allows you to group parameters together to enhance the logic of 
the filter. The parameters for grouped questions are looked at 
together before moving on to the next parameter defined. Select 
the rows corresponding to the parameters you wish to group 
together. 

Un-group Allows you to un-group any parameters that you have previously 
grouped together. Select the rows corresponding to the parameters 
you want to un-group. 

Filter Displays the contents of the entire filter. Clicking the Advanced 
checkbox enables the Filter box, allowing you to modify the filter in 
this box. 

Save  Allows you to save the current filter for repeated use. 

Load  Opens a previously saved filter. 

Execute Executes the current filter. 

Cancel Cancels the current filter. 
 

To run a filter 
1 Grade a test or tabulate a survey. 
2 In the Remark Quick Stats window, 

select the Edit menu and then click Filter. 
From the Data view, you may also click the 

Filter toolbar button: .  
3 Enter the parameters for the filter, 

including the Fields, Operators and 
Values as described in the table above. 

4 If desired, save the filter for reuse by 
clicking the Save button. 

5 Click the Execute button to run the filter.  

Once you execute the filter, if you had 
previously run a report, it displays again 
automatically based on the filter. Any reports you run additionally are also be based on 
the filter. The filter criteria are visible at the top of the report. 
 

To restore your original data 

If you wish to restore your original data set with no filters applied, you may do so from 
the Data view in Remark Quick Stats. 

 
1 Click the Data tab in the Remark Quick Stats Task Pane. 
2 Locate the Filter drop-down list in the upper right hand corner of the data grid. 
3 Drop down the list and choose Primary. 
4 The data is restored to match your original data set. 
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5.3 Printing Reports and Data 

Reports can be printed to any printer available from your computer. You may also print 
the data from the Data view of Remark Quick Stats. You may wish to try both PCL and 
Postscript print drivers for your printer (if available) to see which yields the best results 
when printing reports. 

Note: This section discusses printing reports one at a time. However, if you 
wish to print multiple reports at once, please see Section 5.7, The Report 
Batch Wizard. 

 

To print reports 
1 Select the Reports tab. 
2 Choose a report to display. 
3 Once the report is on the screen, select the File 

menu and then click Print, or click . 
4 In the Print window, select a printer where you 

would like the report printed. You may also use 
the options in this window to further customize 
the print job based on your printer (e.g., printer 
preferences). 

5 Click the Print button to print the report. 
 

To print data 
1 Select the Data tab. 

2 Select the File menu and then click Print or click . 
3 In the Print window, select a printer where you would like the report printed. You 

may also use the options in this window to further customize the print job based on 
your printer (e.g., printer preferences). 

4 Click the Print button to print the data. 

5.4 Saving Reports 

Saving a report allows you to reopen it within Remark Quick Stats. You can use this 
format to share reports with other Remark Classic OMR users, or save a report and 
print, view or manipulate it later. Saving a report saves the report and the data used to 
generate the report. This file can be viewed or printed, and you may run additional 
reports because the data is contained in the file. 

 

To save a report 
1 After running a report, select the File menu and then click Save or Save As. 

Clicking Save overwrites the current report (if one was opened) and clicking Save 
As allows you to save the report with new parameters (e.g., a new name, new 
location, etc.).  
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2 In the Save Report Data window, use the 
Save in drop-down list to find a location in 
which to save the report. 

3 Enter a name for the report in the File name 
box. The file has a .rqs extension. 

4 Click the Save button to save the report. 

5.5 Exporting Reports 

Reports can be exported to other formats so that 
they may be modified or viewed by others who do not use Remark Quick Stats. You can 
export the report or the data that is used to create the report. 

Note: This section discusses exporting reports one at a time. However, if 
you wish to export multiple reports at once, please see Section 5.7, The 
Report Batch Wizard. 

The following options are available: 

 

Option Description 

Report Exports a report to one of several standard report formats: 
Portable Document Format (PDF), Hypertext Markup Language 
(HTML), Tagged Image Format (TIF), Excel (XLS), Text (TXT) or 
Rich Text Format (RTF). 

Gradebook Exports report/grade information to one of several gradebook 
packages, which are used to manage students' grades: 
Blackboard, InteGrade Pro, MyGradebook, Pearson Inform, Grade 
Busters, Grade Quick, Perception, ParSCORE and a custom 
format.  

Test Item Data Exports a text (TXT) report displaying correct and incorrect 
responses. Correct responses are designated with a 1 and 
incorrect responses are designated with a 0. 

Numeric Data Exports the numeric values for the data. Each piece of textual 
data has a numeric equivalent, as defined in the form template. 
You may choose from several file formats, such as Access, Excel, 
Text, etc. 

Numeric Data 
and Results 

Exports the numeric data, along with the grade, percent and total 
score for each student. If learning objectives are defined, they are 
exported with each student’s record. You may choose from 
several file formats, such as Access, Excel, Text, etc. (Applies to 
test grading only.) 

Numeric Data 
and Row Based 
Learning 
Objectives 

Exports the numeric data, along with the grade, percent and total 
score for each student. If learning objectives are defined, each 
learning objective is listed as a separate data record in the 
exported file. (Applies to test grading only.) 

Textual Data Exports the textual data used to generate the report. You may 
choose from several file formats, such as Access, Excel, Text, etc. 
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Option Description 

Textual Data 
and Results 

Exports the textual data, along with the grade, percent and total 
score for each student. You may choose from several file formats, 
such as Access, Excel, Text, etc. (Applies to test grading only.) 

Textual Data 
and Row Based 
Learning 
Objectives 

Exports the textual data, along with the grade, percent and total 
score for each student. If learning objectives are defined, each 
learning objective is listed as a separate data record in the 
exported file. (Applies to test grading only.) 

 

To export a report 
Exporting a report allows you to save the report in one of several formats so that others 
can read it. 

 

1 After running a report, from the Reports view, select the File menu, click Export 

and then click Report, or click .  
2 Choose the desired format from the list. 

Please view the following sections for more detailed information about each export 
option. 

5.5.1 Exporting Reports to the PDF Format 
Remark Quick Stats allows you to export a report to a PDF (Portable Document Format) 
file, making it easier to transport your results. PDF files are easily emailed to others or 
posted on web sites.  

 

To export a report to the PDF format 
1 In the Remark Quick Stats window, run the report you wish to export. 
2 Select the File menu, then click Export and 

then click Report, or click . 
3 In the Export Report window, select PDF 

from the Export format drop-down list. 
4 In the Page Range area, select which pages of 

the report to export: All, Current page or 
Pages (specify which pages or a page range). 

5 If the report you are exporting includes, 
graphs, select the Image Quality to use for 
the graph images: Low, Medium, High or 
Maximum. The higher the image quality, the 
larger the file. 

6 Click the Export button to select a file name 
and location. 

7 In the Save As window, choose a location for the file using the Save in drop-down 
list or file storage options in the left side of the window. 

8 Enter a name for the file in the File name box. 
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9 You may not change the Save as type (it is preset to PDF).  
10 Click the Save button to export the PDF file. 

5.5.2 Exporting Reports to the HTML Format 
Remark Quick Stats allows you to export a report to the HTML format, making it easy to 
post your results on the Internet or a local intranet. If your report includes graphs, the 
graphs are exported as images. Be sure to post these images with your HTML file. 

 

To export a report to the HTML format 
1 In the Remark Quick Stats window, run the report you wish to export. 

2 Select the File menu, then click Export and then click Reports, or click 
. 

3 In the Export Report window, select HTML from the Export format drop-down list. 
4 In the Page Range area, select which pages of the report to export: All, Current 

page or Pages (specify which pages or a page range). 
5 Click the ellipsis (…) next to Images folder to select a folder for storing any related 

images, such as graphs. You need to post these images along with the HTML file on 
your website. 

6 Enter a title for the HTML file in the Title box, if 
desired. The title is displayed on the title bar of 
the HTML file when opened in a web browser. 

7 Select the HTML format from the HTML format 
box: HTML 3.2 (conforms to the W3C HTML 
3.2 recommendation) or Dynamic HTML (uses 
inline styles for CSS1 compliant browsers). 

8 Select a table of contents format from the 
Table of contents format box: None, Simple 
HTML, Dynamic HTML or XML. The table of 
contents format determines if and how the 
table of contents with be exported. 

9 If desired, mark any of the remaining 
checkboxes to include those options in  your 
report:  

10 Create cascading style sheet: file includes cascading style sheets 
11 Create frames: file includes frames 
12 Create MIME archive: determines whether file is exported as a MHT archive 
13 Single page output: creates a one page HTML file 
14 Click the Export button to select a file name and location. 
15 In the Save As window, choose a location for the file using the Save in drop-down 

list or file storage options in the left side of the window. 
16 Enter a name for the file in the File name box. 
17 You may not change the Save as type (it is preset to HTM).  
18 Click the Save button to export the HTML file. 
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5.5.3 Exporting Reports to the RTF or TIF Formats 
Remark Quick Stats allows you to export a report to the RTF and TIF formats, making it 
easier to transport your results. RTF (Rich Text Format) files can be viewed or edited in 
Microsoft Word. Note that when saving to the RTF format, graphs are not supported. TIF 
(Tagged Image Format) files are graphics files that can be embedded into other 
documents and presentations or viewed in many image viewers. 

 

To export a report to the RTF or TIF formats 
1 In the Remark Quick Stats window, run the report you wish to export. 

2 Select the File menu, then click Export and then click Reports, or click 
.  

3 In the Export Report window, select Rich Text Format (RTF) or Tagged Image 
Format (TIF) from the Export format drop-
down list.  

4 In the Page Range area, select which pages 
of the report to export: All, Current page or 
Pages (specify which pages or a page range). 

5 Click the Export button to select a file name 
and location. 

6 In the Save As window, choose a location for 
the file using the Save in drop-down list or 
file storage options in the left side of the 
window. 

7 Enter a name for the file in the File name 
box. 

8 You may not change the Save as type (it is 
preset to RTF or TIF, depending on your original selection).  

9 Click the Save button to export the RTF or TIF file. 

5.5.4 Exporting Reports to the Excel Format 
Remark Quick Stats allows you to export a report to the Excel format, where you can 
further manipulate the information or pass the report along to an Excel user. 

  

To export a report to the Excel format 
1 In the Remark Quick Stats window, run the report you wish to export. 

2 Select the File menu, then click Export and then click Reports, or click 
.  

3 In the Export Report window, select Microsoft Excel Worksheet from the Export 
format drop-down list. 

4 In the Page Range area, select which pages of the report to export: All, Current 
page or Pages (specify which pages or a page range). 

5 In the File name box, click the ellipsis (…) to enter or choose a file name and 
location.  

6 Click the Save button to save the file name and location. 
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7 When you return to the Export Report window, 
select an Excel version to use for compatibility: 
8.x, 7.x or 5.x. The file you create will be 
compatible with the version selected here. 

8 Select the Border space, Minimum column 
width and Minimum row height for the 
formatting of the spreadsheet. These sizes are 
calculated in Twips, which is short for twentieth 
of a point, a typographical measurement (1 twip 
≈ 1/1440 inch ≈ 1.763 889 · 10-5 meter). 

9 If desired, mark any of the remaining 
checkboxes to include those options in  your 
report:  

• Auto row height: the height of each 
row will be automatically determined. 

• Show margin space: Specifies whether the space between the report 
elements and the margin will display.  

• rim empty space: Determines whether the exported 
report eliminates vertical empty spaces between elements. 

• Double boundaries: If right aligned elements replace left aligned elements 
in the same column, mark this checkbox. Otherwise, do not mark this 
checkbox for fewer columns.  
Value Description:  
Mark checkbox: Use to prevent right-aligned elements from replacing left-
aligned elements in the same column.   
Do not mark checkbox: Right-aligned elements may replace left-aligned 
elements in the same column in some reports.   

• Generate page breaks: Determines whether the export method will 
generate page breaks automatically in the exported file. 

• Generate multiple sheets: Determines whether the report will be generated 
as a single Excel sheet, or as a multiple sheet workbook. If this checkbox is 
marked, each page in the report will be placed on its own Excel sheet.  

10 Click the Export button to export the Excel file. 

Note: The Excel format is utilizes a third party component and results may 
vary. If the output is not what you desire, please consider copying the 
report pages to Excel using the Edit menu or taking screen captures of the 
pages and then pasting them in Excel. 

5.5.5 Exporting Reports to the Text Format 
Remark Quick Stats can export a report to a text (TXT) format to be used in other 
applications. 

 

1 In the Remark Quick Stats window, run the report you wish to export. 

2 Select the File menu, then click Export and then click Reports, or click 
.  

3 In the Export Report window, select Text from the Export format drop-down list.  
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4 In the Page Range area, select which pages 
of the report to export: All, Current page 
or Pages (specify which pages or a page 
range).  

5 In the Text delimiter drop-down list, select 
the delimiter you would like to use to 
separate fields in the file: Comma, Tab or 
Space. 

6 If desired, click mark the checkbox for 
Suppress empty lines to eliminate any 
empty lines in the file. 

7 If desired, mark the checkbox for Unicode 
to include Unicode encoding in the text file. 
This setting specifies whether the text output is in Unicode format or ASCII format. 
Unicode is a standard for representing characters as integers. Unlike ASCII, which 
uses seven bits for each character, Unicode uses 16 bits, which means that it can 
represent more than 65,000 unique characters. 

8 Click the Export button to select a file name and location. 
9 In the Save As window, choose a location for the file using the Save in drop-down 

list or file storage options in the left side of the window. 
10 Enter a name for the file in the File name box. 
11 You may not change the Save as type (it is preset to TXT).  
12 Click the Save button to export the TXT file. 

5.5.6 Exporting Grade Results to Gradebook Programs  
The data portion of the grade results can be saved to several gradebook programs. 
Gradebook programs can be used to maintain student information and track progress. 

 

To save the grade results in a gradebook format 
1 In the Remark Quick Stats window, select the File menu, click Export, and then 

click Gradebook, or click . 
2 Select the gradebook package to which you want to save the data. 
3 A window appears for each gradebook type. Enter the appropriate parameters for the 

selected gradebook (see the following sections for gradebook-specific information). 
4 Click the Export button. 
5 Choose a location for the file and enter a file name in the box titled File name. 
6 Click the Save button to export the file. 

The available gradebook formats include: 

 
Gradebook Format Extension 

InteGrade Pro GBK 

MyGradebook MGB 

Pearson Inform TXT 
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Gradebook Format Extension 

Grade Busters TXT 

Grade Quick TXT 

Perception CSV 

ParSCORE SCO 

Blackboard RBBX 

Custom TXT, CSV 
 

The following sections provide further details on each of the individual gradebook 
formats. 

5.5.6.a InteGrade Pro 
The InteGrade Pro format creates a GBK file for importing into Pearson's InteGrade Pro 
gradebook system. The following options must be set when exporting to this format:  

 
Option Function 

Task Name An item on which a student is scored (e.g., a test). 

Task Date The date in which the task is assigned. 

Import Grade From InteGrade Pro imports raw scores only. 

 

Note: See your InteGrade Pro User’s Guide for further information regarding 
these options. 

5.5.6.b MyGradebook 
The MyGradebook format creates an MGB file for importing into the MyGradebook 
gradebook system. The following options must be set when exporting to this format:  

 

Option Function 

Teacher ID The teacher's identification number. 

Class Name The name of the class. 

Test Name The name of the test. 

Test Date The date of the test. 

Import Grade From MyGradebook imports raw scores only. 

 

Note: See your MyGradebook User’s Guide for further information regarding 
these options. 

 

 



 Working with Your Report Data  

139 
 

5.5.6.c Pearson Inform 
The Pearson Inform format creates a testdata.txt file for importing into Pearson's Inform 
gradebook system. The following options must be set when saving to this format: 

 

Option Function 

District ID The district's identification number. You may enter a value 
or choose a field containing the number from the drop-
down list. 

School ID The school's identification number. You may enter a value 
or choose a field containing the number from the drop-
down list. 

Teacher ID The teacher's identification number. You may enter a value 
or choose a field containing the number from the drop-
down list. You may enter a number or choose a field 
containing the number from the drop-down list. 

Test ID The test's identification number. You may enter a value or 
choose a field containing the number from the drop-down 
list. 

Test Session The test session's identification. You may enter a value or 
choose a field containing the number from the drop-down 
list. 

Test Name The name of the test. You may enter a number or choose a 
field containing the number from the drop-down list. 

Test Date The date of the test. 

Include Learning 
Objectives 

Mark this checkbox to include graded information from 
learning objectives that were setup in the Grade Wizard. 

Import Grade From Pearson Inform imports percent scores only. 

5.5.6.d Grade Busters Format 
The Grade Busters format creates a text (.txt) file for importing into Jay Klein 
Productions' Grade Busters: Making the Grade gradebook program. The following options 
must be set for the Grade Busters format: 

 
Option Function 

Roster Position This position comes from the gradebook package. Enter this 
field in Remark Quick Stats as the student ID Field when 
grading a test. 

Raw Score The raw score must be included in this format. 

Total Assignment 
Points 

This value is handled internally in Remark Quick Stats and 
automatically entered into the saved gradebook file. 
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Note: See your Grade Busters User’s Guide for further information 
regarding these options. 

5.5.6.e Grade Quick Format 
The Grade Quick format creates a text (.txt) file for importing into Jackson Software’s 
Grade Quick gradebook program. The following options must be set when exporting to 
this format:  

 
Option Function 

Positioning 
Information: Scores 
start line, ID's start 
column, Maximum ID 
length, Scores start 
column 

Use these settings to specify score and id field information 
for the text file. The default information should not need to 
be changed. A position file is automatically created with 
this information when the results are saved. 

Import Grade From Use this setting to choose which grade statistic to import 
(percent, letter or raw). 

 
Note: See your Grade Quick User’s Guide for further information regarding 
these options. 

5.5.6.f Perception Format 
The Perception format creates a CSV file for importing into Pearson's Perception 
gradebook software. Perception accepts the Raw Score; there are no other options to 
set.  

Note: See your Perception User’s Guide for further information regarding 
the Perception software. 

5.5.6.g ParSCORE Format 
The ParSCORE format creates a SCO file for importing into Pearson’s ParSCORE 
software. ParSCORE accepts the Raw Score; there are no other options to set.  

Note: See your ParSCORE User’s Guide for further information regarding the 
ParSCORE software. 

5.5.6.h Blackboard Format 
The Blackboard format creates an RBBX file for importing into Blackboard. The raw score 
is exported from Remark Quick Stats. When the scores are imported into Blackboard, 
students can be matched to their scores based on Student ID or name. Note that using 
the Blackboard format requires you to have the Remark Grade Import Building Block in 
Blackboard. Please contact Gravic Sales if you are interested in this building block. 

 

Installing the Remark Grade Import Building Block 
1 Log into Blackboard with the administrator account. 
2 Click on the System Admin tab. 
3 Under the Building Blocks section, click on the Building Blocks link. 
4 Click Installed Tools. 
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5 Click Upload Building Blocks. 
6 Browse to the RemarkGradeImport.war file and then select Submit. 
7 Change the Availability drop-down list selection next to the Remark Grade 

Import name from Unavailable to Available. 
8 Click Approve to approve activating the building block. 
9 If you wish to make it available to all courses by default, change the Course/Org 

Default drop-down list selection from Unavailable to Available. If not, the tool will 
have to be made available on a course by course basis. 

 

Using the Remark Grade Import 
1 After using Remark Classic OMR 4 to scan the assessments, grade them using either 

Easy Grade or the Grade Wizard. 
2 Once graded, select the File menu, click Export and then click Gradebook. 
3 In the Format drop-down list, select Blackboard.  
4 Select Export. Save the file somewhere you can access it while importing into 

Blackboard. 
5 Log into Blackboard. 
6 Navigate to the course for which you are an instructor and into which you wish to 

import the grades. 
7 Under Course Tools, select Remark Grade Import. 
8 Select whether you want to import the grades into an existing assessment or create 

a new assessment into which to import the grades. If you are importing into an 
existing assessment, select the assessment into which you want to import. If you are 
creating a new assessment, enter a name for the assessment. 

9 Browse to the .rbbx file saved when exporting the gradebook from Remark. Click 
Submit. 

10 The next page presents any duplicate student IDs or names in the file or IDs that 
were not matched to a student enrolled in the course. If there are any unmatched 
IDs, use the drop-down list next to them to choose either a student to match them 
with or to ignore that grade. 

11 Confirm the grades that were matched, and select Submit. 
12 The grades are imported into the class. 

Note: See your Blackboard documentation for further information regarding 
Blackboard. 

5.5.6.i Custom Format 
If you are exporting to a gradebook that is not directly supported, you may use the 
Custom format. The Custom format allows you to export a text (TXT or CSV) file that 
you can setup to match your gradebook program. Check the requirements of your 
gradebook program before proceeding. 

 
 
 
 
 



Remark Quick Stats User's Guide 

142 
 

To use the Custom gradebook format 
1 In the Gradebook Export window, enter the number of decimal places you wish to 

include in the file. 
2 If desired, mark the checkbox for Include Answer Key as First Row. 
3 Click the Export button to continue. 
4 In the Custom Gradebook Export window, choose a location in which to save the 

file. 
5 Enter a file name in the box titled File name. 
6 Click the Save button to continue. The wizard now starts. 
7 Click the Next>> button to begin configuring the 

file.  

Note: if you have saved a configuration file 
previously, click the Browse button to open it 
and apply it to the current export operation.  

8 For the File Type, select Fixed width (fields are 
aligned at fixed character positions) or Delimited 
(fields are separated by delimiters, such as 
commas or tabs). 

9 If desired, mark the checkbox for Automatically 
format questions that allow multiple 
responses. This feature places each answer 
choice in a separate field in the text file. 

10 In the Start Export at Row box, enter the row 
number of the results in which to begin the file 
(this is usually 1). 

11 Click the Next>> button to continue.  
12 The next step depends on the type of file you 

selected in the previous step.  
1. If you chose a delimited file, select the Column 
Delimiter to be used to separate fields: Comma, 
Tab, Semi-colon, Space, Other (delimiter of 
your choice). Optionally, select a Text Qualifier 
(the item used to define the text field): None, ' 
(single quote), " (double quote).  
2. If you chose a fixed width file, choose the Field 
Width and Padding options for the columns. You 
may set the Field Size, Pad Width and Pad On 
(right or left) settings for each field that are 
exported.   

13 Click the Next>> button to continue. 
14 In the next step, select a Record Delimiter (an 

item to designate the next record): Carriage 
Return/Line Feed, Carriage Return, Line 
Feed, Other (record delimiter of your choice). 

15 Click the Next>> button to continue. 
16 In the final step of the export wizard, select the 
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statistics you wish to exclude in the export. By 
default all statistics are exported unless you mark 
the Exclude checkbox. You may also optionally 
move the fields up or down to further format their 
position in the export file.  

17 Optionally, set record breaks after specific fields. 
Place a checkmark in the Break After checkbox to 
insert a record break after that field. 

18 Optionally, choose a field to include in every record 
that is created. For example, suppose you have 
captured the test name in your data and want each 
student's record to include this test name. You can 
mark the checkbox for Every Record to include that test name in each record that is 
created.  

19 Click the Finish button to complete the wizard. 
20 If desired, click Yes to save the wizard configuration for future use. Select a location 

and file name for the configuration file. If the configuration is saved, you can open it 
up at the beginning of the wizard the next time you run it so that you don't have to 
perform every step. If you click No, the configuration is not saved, but you will have 
a custom gradebook file for this report. 

5.5.7 Exporting Grades as Test Item Data 
Remark Quick Stats can create a tab or comma delimited text file that shows the status 
of each question for each student. Correct answers are represented by a 1 and incorrect 
answers are represented by a 0. This type of file can be exported to grading programs 
that are used to calculate right and wrong answers. 

 

To export test item data 
1 Run Easy Grade or the Grade Wizard to grade your data.  
2 In the Remark Quick Stats window, select the File menu, click Export and then 

click Test Item Data. 
3 In the File name box, click the ellipsis (…) to enter or choose a file name and 

location. 
4 In the Save as type box, choose Comma Delimited or Tab Delimited.  
5 Click the Save button to save the text file.  
6 In the Export Options area, choose a value to indicate correct questions and 

incorrect questions in the exported file (1 and 0 are the default values). 
7 Mark the checkboxes to include optional information in the file: Include respondent 

identifier(s), Include percent score, Include test score or Include grade. 
8 Click the Export button to export the file. 
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5.5.8 Exporting Numeric Data and Results 
Remark Quick Stats can export grades to one of several formats (Excel, Access, etc.) 
while including the associated numeric values defined in the form template along with 
the report results. You have three options when exporting numeric data: 

• Exporting the numeric version of the data only (values) 

• Exporting the numeric version of the data and the grade results, which includes 
any defined learning objectives (multiple learning objectives in one data record)  

• Exporting the numeric data, results and learning objectives (if defined), where 
each learning objective occupies its own record in the data set on a per student 
basis. 

 

To export numeric data  
1 Run Easy Grade or the Grade Wizard to grade your data. 
2 In the Remark Quick Stats window, select 

the File menu, click Export and then click 
Numeric Data. 

3 In the Save Data window, select a location for 
the file and enter a file name in the box titled 
File name. 

4 In the Save as type box, choose the file 
format in which you wish to save the data. 

Note: Depending on the file format 
selected, you may have additional options. 
Please see your Remark Classic OMR user's 
guide for detailed information about each of 
the available file formats.  

 

To export numeric data with results/numeric data with results and row based 
learning objectives 
1 Run Easy Grade or the Grade Wizard to 

grade your data.  
2 In the Remark Quick Stats window, select 

the File menu, click Export and then click 
Numeric Data and Results or Numeric 
Data and Row Based Learning Objectives. 

3 In the Save Data window, select a location for 
the file and enter a file name in the box titled 
File name. 

4 In the Save as type box, choose the file 
format in which you wish to save the data. 

5 Click the Save button to save the text file. The 
resulting file displays the values associated 
with your data file and the grade information. 

Tip: Clicking the Advanced… button allows you to select which statistics to 
include in the save operation. You can set up default statistics for exporting 
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in the Remark Quick Stats Preferences (Tools|Preferences|Data and 
Results Export). 

5.5.9 Exporting Textual Data and Results 
Remark Quick Stats can export grades to one of several formats (Excel, Access, etc.) 
while including the textual data captured along with the report results. You have three 
options when exporting textual data: 

• Exporting the textual version of the data only  

• Exporting the textual version of the data and the grade results, which includes 
any defined learning objectives (multiple learning objectives in one data record)  

• Exporting the textual data, results and learning objectives (if defined), where 
each learning objective occupies its own record in the data set on a per student 
basis. 

 

To export textual data  
1 Run Easy Grade or the Grade Wizard to 

grade your data. 
2 In the Remark Quick Stats window, select 

the File menu, click Export and then click 
Textual Data. 

3 In the Save Data window, select a location 
for the file and enter a file name in the box 
titled File name. 

4 In the Save as type box, choose the file 
format in which you wish to save the data. 

Note: Depending on the file format 
selected, you may have additional options. 
Please see your Remark Classic OMR user's 
guide for detailed information about each of the available file formats.  

 

To export textual data with results/textual data with results and row based 
learning objectives 
1 Run Easy Grade or the Grade Wizard to 

grade your data. 
2 In the Remark Quick Stats window, select 

the File menu, click Export and then click 
Textual Data and Results or Textual Data 
and Row Based Learning Objectives. 

3 In the Save Data window, select a location 
for the file and enter a file name in the box 
titled File name.  

4 In the Save as type box, choose the file 
format in which you wish to save the data. 

5 Click the Save button to save the text file. 
The resulting file displays the textual data file 
and the grade information.  



Remark Quick Stats User's Guide 

146 
 

Tip: Clicking the Advanced… button allows you to select which statistics to 
include in the save operation. You can set up default statistics for exporting 
in the Remark Quick Stats Preferences (Tools|Preferences|Data and 
Results Export). 

5.6 Emailing Reports 

Reports can be emailed using Microsoft Outlook 2007/2010 or a built-in email client that 
uses your SMTP mail server. A single report can be emailed at one time. Reports can be 
emailed in one of the following formats:  

• Reports (as attachments) 

o PDF 

o Text 

o HTML 

o TIF 

o RTF 

• Data and Results 

o Textual Data (and Grade Results if grading) as attachment 

o Textual Data (and Grade Results if grading) as zip file 

o Numeric Data (and Grade Results if grading) as attachment 

o Numeric Data (and Grade Results if grading) as zip file 

• Remark Quick Stats (.rqs) (as attachment) 

Note: When emailing reports, a local copy of the report is not saved. If you 
need to save a report file, make sure you take that step in addition to using 
the email function. Saving reports is covered in Sections 5.4 and 5.5. 

The above formats are described in detail in the previous sections of this user’s guide. 
This section focuses on how to email the reports; please read the previous sections to 
understand what is included in each report type and the properties associated with each 
report type. If a particular format has properties associated with it, the software default 
settings are applied when generating the file for email. You should determine the file 
type you wish to email before using the email feature. 

You choose whether to use Outlook or the built-in email client in the Remark Classic 
OMR Preferences. Once you have set up your preference, you can simply click the Email 
Report toolbar button to initiate the email process. 

5.6.1 Email Set Up 
When emailing reports, you have a choice of using Microsoft Outlook 2007 or 2010 or 
your own SMTP server to send the emails. We will cover both methods here.  
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Using an SMTP Server:  

If you use your own SMTP server, you must have a 
valid SMTP server set up independently of Remark 
Classic OMR. SMTP stands for Simple Mail Transfer 
Protocol and is the Internet standard for transmitting 
email across networks. It is likely your organization 
has a running SMTP server already set up. You just 
need to find out general information about the 
server. You will likely need to consult with your 
network/email administrator to obtain information 
about your SMTP server. SMTP settings are set up in 
the Remark Classic OMR Preferences. Please use the 
following table as a guide to have your administrator provide the proper settings: 

 

Option Description 

SMTP Server This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a 
secured 
(SSL) 
connection 

If desired, use a secure connection by marking the checkbox for 
Enable a secured (SSL) connection. SSL encrypts data as it is 
transmitted. Your SMTP server must be configured to use SSL in order 
for this feature to work. 

Use the 
default 
credentials of 
the currently 
logged in 
user 

If you need to use authentication for your SMTP server, you can enter 
credentials or use those of the user logged in to the computer. Mark 
the Use the default credentials of the currently logged in user 
checkbox to utilize the user’s credentials (e.g., the person logged in 
when sending the emails from Remark Classic OMR). Otherwise, 
continue to the next step to enter specific credentials. 

Username 
and 
Password 

If authentication is required, and you are not using the credentials of 
the currently logged in user, enter the Username and Password, as 
supplied by your network/email administrator. 

Throttle rate The throttle rate adds a delay while sending emails. The default 
setting is 500ms, meaning that one email is sent every 500 ms (in 
other words, two emails are sent per second). Throttling emails keeps 
the SMTP server from being overloaded when sending large numbers 
of emails. Unless you plan on sending hundreds of emails at one time, 
the default setting of 500 is likely fine. 

 

Microsoft Outlook: 

If you plan to use Microsoft Outlook 2007 or 2010, you do not need to set up anything 
outside of telling the software to use Outlook. When you choose an email function in 
Remark Quick Stats, an Outlook email message automatically opens (you must have 
Microsoft Outlook 2007 or 2010 installed on the computer). 
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To choose Microsoft Outlook or your own SMTP server in Remark Classic OMR: 
1 In the Remark Classic OMR Data Center, click Tools|Preferences. 
2 Click the Email link on the left. 
3 Under Email client, choose Default to use 

your own SMTP server. Choose Outlook to 
use Microsoft Outlook 2007 or 2010. If you 
are using Outlook, simply click OK. If you 
are using the Default email client, continue 
to the next step. 

4 If you have chosen the Default client, click 
the SMTP Server button. 

5 Fill in the settings as described in the 
previous table. You will need your 
network/email administrator to provide this 
information to you. 

6 Click the OK button. 

5.6.2 Using Email to Send Report Files 
Once you have set up your email preferences (see previous section), you are ready to 
start emailing report files. 

 

To email report files using Microsoft Outlook 
1 In Remark Quick Stats, run the desired report. Alternatively use the Report Batch 

Wizard to run multiple reports.  
2 Select the File menu, choose Email and then choose the type of report you wish to 

export: Report, Textual/Numeric Data or the Remark Quick Stats file. If you 
want to export the report (PDF, Text, HTML, XLS, TIF, RTF) you can simply click the 
Email button from the toolbar (this option only shows the Report formats). If you 
choose Textual/Numeric Data you can decide whether you want to email the file in 
its native format or as a ZIP file. 

Note: Your organization, or the recipient’s organization, may have 
restrictions on the types of files that can be sent via email. If the file is 
restricted and you do not zip it, the email may never reach the intended 
recipient. If you are unsure whether the selected file type is restricted, use 
the ZIP option. The recipient must have a Zip program to unzip the file and 
view it. 

3 The next set of steps depends on your selection in Step 2. 
• For Report files, enter a name for the report in the File name box. Then choose 

the desired format from the Save as type box: PDF, Text, HTML, XLS, TIF or 
RTF. 

• For Textual or Numeric Data (and Grade Results if grading), enter a name in 
the File name box. Then choose the desired format for the data in the Save as 
type box. These formats are covered in Sections 5.5.7 and 5.5.8, as well as the 
main Remark Classic OMR user’s guide. The Textual or Numeric Data options 
allow you to send attachments in their native formats or as ZIP attachments.  

• For Remark Quick Stats files, enter the name in the File name box. You may 
not change the file type for the Remark Quick Stats attachment. 
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4 Click the OK button. 

Outlook automatically opens a new email message with your file attached. You may now 
enter recipients and a message and send your file. Note if you chose one of the zip 
attachment options, the file appears with a .zip extension. The file is only saved as an 
email attachment; there is no permanent copy of the file saved on your computer when 
using the email functionality. 

 

To email data files using your SMTP server 
1 In Remark Quick Stats, run the desired report. Alternatively use the Report Batch 

Wizard to run multiple reports.  
2 Select the File menu, choose Email and then choose the type of report you wish to 

export: Report, Textual/Numeric Data or the Remark Quick Stats file. If you want to 
export the report (PDF, Text, HTML, XLS, TIF, RTF) you can simply click the Email 
button from the toolbar (this option only shows the Report formats). If you choose 
Textual/Numeric Data you can decide whether you want to email the file in its 
native format or as a ZIP file. 

Note: Your organization, or the recipient’s organization, may have 
restrictions on the types of files that can be sent via email. If the file is 
restricted and you do not zip it, the email may never reach the intended 
recipient. If you are unsure whether the selected file type is restricted, use 
the ZIP option. The recipient must have a Zip program to unzip the file and 
view it. 

3 The next set of steps depends on your selection in Step 2. 
• For Report files, enter a name for the report in the File name box. Then choose 

the desired format from the Save as type box: PDF, Text, HTML, XLS, TIF or 
RTF. 

• For Textual or Numeric Data (and Grade Results if grading), enter a name in 
the File name box. Then choose the desired format for the data in the Save as 
type box. These formats are covered in Sections 5.5.8 and 5.5.9, as well as the 
main Remark Classic OMR user’s guide. The Textual or Numeric Data options 
allow you to send attachments in their native formats or as ZIP attachments.  

• For Remark Quick Stats files, enter the name in the File name box. You may 
not change the file type for the Remark Quick Stats attachment. 

4 Click the OK button. 
5 The Email Message window appears. 
6 Enter the recipient(s)’ email address in the To 

box. Separate multiple recipients with a semi 
colon (;). 

7 Enter your return email address in the From 
box.  

8 Accept the default subject, which is the file 
name, or enter a new one in the Subject box. 

9 In the rich text box, type your message to the 
recipient(s). You may use the toolbar to format 
your message as desired.  

10 If you have already configured your SMTP 
settings in Remark Classic OMR, as described in 
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section 5.6.1, you do not need to click the SMTP Settings tab. However, if you have 
not entered your SMTP settings or need to modify them, click the SMTP Settings 
tab to enter the SMTP server information. You will need to obtain this information 
from your network/email administrator. 

11 Click Send when you are ready to send your message. 

Your email message is automatically sent. The file is only saved as an email attachment; 
there is no permanent copy of the file saved on your computer when using the email 
functionality. If delivery problems occur, delivery reports are routed to the address listed 
in the From box of the email message (this may depend on how your SMTP server is 
configured to handle message failures).  

5.7 The Report Batch Wizard 

Remark Quick Stats includes a Report Batch Wizard that allows you to auto filter data 
based on regions from the form template, as well as display, print and export multiple 
reports at one time. 

Note: The previous sections describe the types of reports that can be 
exported. The Report Batch Wizard allows you to export PDF, HTML, Excel, 
TIF, Text and RTF reports only. 

Auto filtering of data allows you to select up to three regions from your template (data 
set) on which to base the filter. Any time the data in the specified region(s) changes, a 
new report is generated. For example, if you are processing a course evaluation survey 
that rate a college course, you may have an instructor’s name on each evaluation. If you 
wanted to review the results based on each instructor, you could auto filter on the 
instructor region, in which case a new report is generated for each instructor. If you are 
analyzing multiple data sets and have entered Data Group information to identify each 
data set, the groups are available for filtering in the Report Batch Wizard. 

 

To use the Report Batch Wizard for auto filtering 
1 Run Easy Grade, the Grade Wizard, Easy Survey or the Survey Wizard to open 

Remark Quick Stats. 
2 In the Remark Quick Stats window, select the Tools menu and then click Report 

Batch Wizard. Alternatively, in the Task Pane, select Build Report Batch. 

Note: If you have already created a report 
batch file, you can select Open Report Batch 
from the Task Pane. 

3 Mark the checkbox for Auto Filter Reports. 
4 In the Filter by drop-down list, choose the region 

from your form template (data set) to use for the 
filter. Any time a new value in this region is 
encountered a new report is generated. 

Note: The data is sorted behind the scenes so 
that data that logically belongs together is 
displayed on one report. 

5 If desired, choose up to two more regions on 
which to filter the data. 

6 Click the Next>> button to continue. 



 Working with Your Report Data  

151 
 

7 Choose the reports you wish to run for each 
filter. Double click a report to select it, or use the 
Add button to move it to the Selected Reports 
box.  

Note: If you choose a report that requires 
user input (e.g., a respondent report where 
you have to tell the software which field to 
use for the report), you are prompted to 
choose the report criteria during report 
generation. These selections can be saved to 
the Report Batch Wizard configuration file if 
you plan to reuse your settings. 

8 Click the Next>> button to continue. 
9 If you wish to print the reports, mark the Print 

Reports checkbox. Choose an available printer 
from the drop-down list. You may also choose 
the number of copies to print, how to handle 
two-sided printing and whether to display 
print setup dialog before printing each 
report (e.g., if you want to turn duplex printing 
on for some reports but not others). 

10 Click the Next>> button to continue. 
11 If you wish to display the reports in Remark 

Quick Stats, mark the checkbox for Display 
reports. 

12 If you wish to export the reports to the PDF, 
HTML, TIF, XLS, Text or RTF format, mark the 
checkbox for Export Reports.  

13 In the Export format drop-down list, choose the 
desired format. The available options for each 
export format are detailed in the previous 
sections on export formats and are displayed 
here as appropriate. Click the ellipsis (…) button 
to choose a file name and folder in which to store 
the reports. 

14 If desired, mark the checkbox for Merge all 
selected reports. If the reports are merged, 
one file is created with the separate reports. If 
the files are not merged, each report is created 
in a separate folder designated by the filter or 
report name (if not filtering). For example, if you 
are processing course evaluations as described previously and do not merge the 
reports, each instructor has a folder named after them and their reports are saved in 
that folder. 

15 If desired, select Place all reports in a single folder. When this option is selected, 
all files are saved to the same folder rather than saved to separate folders for each 
filter. The filter is then part of the file name. 

16 Click the Finish button to run the reports. You may optionally click the down arrow 
on the Finish button and choose Execute to only execute the batch without saving 
it, or Save to save the batch file without running it. 
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17 If you click the Finish button and have not yet saved the configuration, you are 
asked if you would like to save the Report Batch Wizard configuration for future use. 
Click Yes to save the file if desired. 

18 Provide a location and file name for the file and then click the Save button. 

The actions selected in the Report Batch Wizard begin to run. You receive a message 
when all actions are completed. 

 

To use the Report Batch Wizard to print and export multiple reports  
1 Run Easy Grade, the Grade Wizard, Easy Survey or the Survey Wizard to open 

Remark Quick Stats. 
2 In the Remark Quick Stats window, select the Tools menu and then click Report 

Batch Wizard. Alternatively, in the Task Pane, select Build Report Batch. 

Note: If you have already created a report batch file, you can select Open 
Report Batch from the Task Pane. 

3 If you would like to auto filter the data, mark the checkbox for Auto Filter Reports. 
This topic is covered earlier in this section. 

4 Click the Next>> button to continue. 
5 Choose the reports you wish to run. Double click 

a report to select it, or use the Add button to 
move it to the Selected Reports box. 

Note: If you choose a report that requires 
user input (e.g., a respondent report where 
you have to tell the software which field to 
use for the report), you are prompted to 
choose the report criteria during report 
generation. These selections can be saved to 
the Report Batch Wizard configuration file if 
you plan to reuse your settings. 

6 Click the Next>> button to continue.  
7 If you wish to print the reports, mark the Print 

Report checkbox. Choose and configure your 
printer using the Properties button. You may 
also choose the number of copies to print and 
whether to display the printer setup dialog 
before each separate report (e.g., if you want to 
turn duplex printing on for some reports but not 
others). 

8 Click the Next>> button to continue. 
9 If you wish to export the reports to the PDF, 

HTML, TIF, Text or RTF format, mark the 
checkbox for Export Reports.  

10 In the Export format drop-down list, choose the 
desired format. The available options for each 
export format are detailed in the previous sections. 

11 If desired, mark the checkbox for Merge all selected reports. If the reports are 
merged, one file is created with the separate reports. If the files are not merged, 
each report is created in a separate folder designated by the region name. For 
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example, if you are processing course evaluations 
as described previously and did not merge the 
reports, each instructor would have a folder 
named after them and their reports would be 
saved in that folder. 

12 If desired, select Place all reports in a single 
folder. When this option is selected, all files are 
saved to the same folder rather than saved to 
separate folders for each filter. The filter is then 
part of the file name. 

13 Click the Finish button to run the reports.  
14 If you click the Finish button and have not yet 

saved the configuration, you are asked if you 
would like to save the Report Batch Wizard configuration for future use. Click Yes to 
save the file. 

15 Provide a location and file name for the file and then click the Save button. 

The actions selected in the Report Batch Wizard begin to run. You receive a message 
when all actions are completed. 

5.8 Opening Reports 

Saved report files can be opened in Remark Quick Stats for further viewing, printing, 
exporting and manipulation. Saving reports is covered in detail in Section 5.4 Saving 
Reports. When reports are saved to the RQS format, the report and the data used to 
generate the report are saved. This file can be viewed or printed, and you may run 
additional reports because the data is contained in the file. 

 

To open a Remark Quick Stats report file 
1 From Remark Quick Stats, select the File menu and then click Open…, or click 

.  
2 Locate the .rqs file you wish to open and then click the Open button. 

The report is displayed on the screen. This file contains the report and the data used to 
generate the report; therefore you may run additional reports based on this information. 

5.9 Screen Captures 

Any portion of a report can be acquired as a screen capture and sent to the Windows 
clipboard. You can then paste the screen capture into another application. This feature 
provides an easy way to transfer charts and graphs to other applications. For example, if 
you are putting together a Microsoft PowerPoint presentation of your results, you can 
capture the graphs out of Remark Quick Stats and insert them into your PowerPoint 
presentation. Screen captures can only be taken when you are in the Reports view of 
Remark Quick Stats. 
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To take screen captures 
1 With the desired report on-screen, go to the Tools menu and then select Screen 

Capture, click  or click Ctrl+T on the keyboard. 

The mouse turns into a crosshair. 

2 Hold down the left mouse button and drag the mouse around the area you wish to 
capture. You will see a box expand around the area: anything within the box is part 
of your screen capture. You can capture any part of the report page, including the 
entire page. You may need to zoom or scroll to the desired area before taking the 
screen capture. 

Tip: To capture more of the page, use the zoom options on the toolbar to 
zoom out on the report. 

3 When you are finished dragging the mouse around the desired area, release the 
mouse button.  

A message appears letting you know the 
screen capture was successful. 

4 The screen capture is now on the 
Windows clipboard. Open the desired 
application, select an insertion point 
and then paste the image into the 
application (Ctrl+V or use the 
application’s paste function). 
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